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Preface

How to Use This Guide

Purpose of This
Guide

Audience

Assumptions

Text Conventions

User Attention
Words

The Applied Biosystems 3130/3130xl Genetic Analyzers Getting Started Guide provides
step-by-step instructions for preparing and analyzing a sample. It is designed to help you
quickly learn how to use the Applied Biosystems 3130/3130x/ Genetic Analyzers.

This manual is written for principle investigators and laboratory staff who are planning
to operate and maintain the Applied Biosystems 3130/3130x/ Genetic Analyzers.

This guide assumes you have the following background:

Familiarity with Microsoft® Windows® XP operating system.

Knowledge of general techniques for handling DNA samples and preparing them
for electrophoresis.

A general understanding of hard drives, data storage, file transfers, and copying and
pasting.

If you want to integrate the 3130/3130x/ Genetic Analyzers into your existing laboratory
data flow system, you need networking experience.

This guide uses the following conventions:

Bold indicates user action. For example:
Type 0, then press Enter for each of the remaining fields.

Italic text indicates new or important words and is also used for emphasis. For
example:

Before analyzing, always prepare fresh matrix.

A right arrow bracket (>) separates successive commands you select from a drop-
down or shortcut menu. For example:

Select File > Open > Spot Set.
Right-click the sample row, then select View Filter > View All Runs.

Two user attention words appear in Applied Biosystems user documentation. Each word
implies a particular level of observation or action as described below:

Note — Provides information that may be of interest or help but is not critical to the
use of the product.

IMPORTANT! - Provides information that is necessary for proper instrument
operation, accurate chemistry kit use, or safe use of a chemical.

Applied Biosystems 3130/3130xI Genetic Analyzers Getting Started Guide iX



Preface
How to Obtain More Information

Safety Alert
Words

Examples of the user attention words appear below:

Note: The size of the column affects the run time.

IMPORTANT! To verify your client connection to the database, you need a valid Oracle
user ID and password.

Safety alert words also appear in user documentation. For more information, see “Safety
Alert Words” on page Xiv.

How to Obtain More Information

Related The following related document is shipped with the system:

Documentation

Send Us Your

* Applied Biosystems 3130/3130xl Genetic Analyzers Maintenance, Troubleshooting,

and Reference Guide (P/N 4352716) - Contains information on maintaining the
instrument and computer system, troubleshooting tables to diagnose performance
failures and advance reference content.

* Applied Biosystems 3130/3130xl Genetic Analyzers Site Preparation Guide

(P/N 4352717) - Contains the space, environmental, and electrical requirements to
support the 3130/3130xI Genetic Analyzer system.

* Applied Biosystems 3730/3730xI DNA Analyzers and Applied Biosystems

3130/3130xl Genetic Analyzers AB Navigator Software Administrator Guide
(P/N 4359472) - Contains information and procedures for the administrator

maintaining the computer system and software files of the Applied Biosystems
3130/3130x!/ Genetic Analyzers.

* Applied Biosystems 3130/3130x] Genetic Analyzers Quick Reference Card

(P/N 4362825) - Contains a flowchart on how to run your samples and instrument, a
table of maintenance tasks, and a Data Collection software reference guide.

Note: For additional documentation, see “How to Obtain Support” on page xi.

Applied Biosystems welcomes your comments and suggestions for improving its user

Comments documents. You can e-mail your comments to:

techpubs@appliedbiosystems.com
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Preface
How to Obtain Support

How to Obtain Support

For the latest services and support information for all locations, go to
http://www.appliedbiosystems.com, then click the link for Support.

At the Support page, you can:

Search through frequently asked questions (FAQs)
Submit a question directly to Technical Support

Order Applied Biosystems user documents, MSDSs, certificates of analysis, and
other related documents

Download PDF documents
Obtain information about customer training

Download software updates and patches

In addition, the Support page provides access to worldwide telephone and fax numbers
to contact Applied Biosystems Technical Support and Sales facilities.

Applied Biosystems 3130/3130xI Genetic Analyzers Getting Started Guide Xi
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This safety section describes the following:

Safety Conventions Used in This Document................................ Xiv
Symbols on InStruments ... ... ....... ...t e XV
Safety Labels on Instruments . ............. ... ., XVi
General Instrument Safety . ........ ... ... xvii
Chemical Safety .. ... .. ... XViii
Chemical Waste Safety ........... .. e XX
Electrical Safety. . ... XXi
Physical Hazard Safety . ........... . . i i XXi
Laser Safety . ... ..o XXi
Workstation Safety. . ... .. XXii
Safety and Electromagnetic Compatibility (EMC) Standards. ................. XXiii
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Safety

Safety Conventions Used in This Document

Safety Conventions Used in This Document

Xiv

Safety Alert
Words

Four safety alert words appear in Applied Biosystems user documentation at points in
the document where you need to be aware of relevant hazards. Each alert
word—-IMPORTANT, CAUTION, WARNING, DANGER-implies a particular level of
observation or action, as defined below:

Definitions

IMPORTANT! - Indicates information that is necessary for proper instrument operation,
accurate chemistry kit use, or safe use of a chemical.

A (o7 UII[o] - Indicates a potentially hazardous situation that, if not avoided, may

result in minor or moderate injury. It may also be used to alert against unsafe practices.

AWARNING — Indicates a potentially hazardous situation that, if not avoided,

could result in death or serious injury.

A pr\N(el35] — Indicates an imminently hazardous situation that, if not avoided,

will result in death or serious injury. This signal word is to be limited to the most extreme
situations.

Except for IMPORTANTS, each safety alert word in an Applied Biosystems document
appears with an open triangle figure that contains a hazard symbol. These hazard
symbols are identical to the hazard icons that are affixed to Applied Biosystems
instruments (see “Safety Symbols” on page xvi).

Applied Biosystems 3130/3130x/ Genetic Analyzers Getting Started Guide



Safety
Symbols on Instruments

Examples

The following examples show the use of safety alert words:

IMPORTANT! You must create a separate a Sample Entry Spreadsheet for each 96-well
microtiter plate.

A (O UII[o)\] The lamp is extremely hot. Do not touch the lamp until it has cooled

to room temperature.

AWARNING CHEMICAL HAZARD. Formamide. Exposure causes eye, skin,

and respiratory tract irritation. It is a possible developmental and birth defect hazard.
Read the MSDS, and follow the handling instructions. Wear appropriate protective
eyewear, clothing, and gloves.

A PL[e]133 ELECTRICAL HAZARD. Failure to ground the instrument

properly can lead to an electrical shock. Ground the instrument according to the provided
instructions.

Symbols on Instruments

Electrical
Symbols on
Instruments

The following table describes the electrical symbols that may be displayed on
Applied Biosystems instruments.

Symbol Description

I Indicates the On position of the main power switch.

Indicates the Off position of the main power switch.

Indicates the On/Off position of a push-push main power switch.

Indicates a terminal that may be connected to the signal ground reference of
another instrument. This is not a protected ground terminal.

Indicates a protective grounding terminal that must be connected to earth
ground before any other electrical connections are made to the instrument.

Indicates a terminal that can receive or supply alternating current or voltage.

Indicates a terminal that can receive or supply alternating or direct current or
voltage.

N1+ 0
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Safety
Safety Labels on Instruments

Safety Symbols The following table describes the safety symbols that may be displayed on
Applied Biosystems instruments. Each symbol may appear by itself or in combination
with text that explains the relevant hazard (see “Safety Labels on Instruments” on
page xvi). These safety symbols may also appear next to DANGERS, WARNINGS, and
CAUTIONS that occur in the text of this and other product-support documents.

Symbol Description

Indicates that you should consult the manual for further information and to
proceed with appropriate caution.

Indicates the presence of an electrical shock hazard and to proceed with
appropriate caution.

Indicates the presence of a hot surface or other high-temperature hazard and to
proceed with appropriate caution.

Indicates the presence of a laser inside the instrument and to proceed with
appropriate caution.

Indicates the presence of moving parts and to proceed with appropriate caution.

P B>

Safety Labels on Instruments

The following CAUTION, WARNING, and DANGER statements may be displayed on
Applied Biosystems instruments in combination with the safety symbols described in the
preceding section.

English Francais
CAUTION Hazardous chemicals. Read the ATTENTION Produits chimiques dangeureux.
Material Safety Data Sheets (MSDSs) before Lire les fiches techniques de sireté de
handling. matériels avant la manipulation des produits.
CAUTION Hazardous waste. Read the waste | ATTENTION Déchets dangereux. Lire les
profile (if any) in the site preparation guide for | renseignements sur les déchets avant de les
this instrument before handling or disposal. manipuler ou de les éliminer.
CAUTION Hazardous waste. Refer to ATTENTION Déchets dangereux. Lire les
MSDS(s) and local regulations for handling fiches techniques de sireté de matériels et la
and disposal. régulation locale associées a la manipulation
et I'élimination des déchets.
WARNING Hot lamp. AVERTISSEMENT Lampe brilante.
WARNING Hot. Replace lamp with an AVERTISSEMENT Composants brllants.
Applied Biosystems lamp. Remplacer la lampe par une lampe
Applied Biosystems.
CAUTION Hot surface. ATTENTION Surface brdlante.
DANGER High voltage. DANGER Haute tension.

XVi Applied Biosystems 3130/3130x/ Genetic Analyzers Getting Started Guide



Safety

General Instrument Safety

English

WARNING To reduce the chance of electrical
shock, do not remove covers that require tool
access. No user-serviceable parts are inside.
Refer servicing to Applied Biosystems
qualified service personnel.

Francais

AVERTISSEMENT Pour éviter les risques
d'électrocution, ne pas retirer les capots dont
I'ouverture nécessite I'utilisation d'outils.
L’instrument ne contient aucune piéce
réparable par I’ utilisateur. Toute intervention
doit étre effectuée par le personnel de service
qualifié de Applied Biosystems.

DANGER Class 3B laser radiation present
when open and interlock defeated. Avoid
direct exposure to laser beam.

DANGER Class 3B rayonnement laser en cas
d’ouverture et d’une neutralisation des
dispositifs de sécurité. Eviter toute exposition
directe avec le faisceau.

DANGER Class 3B laser radiation when
open. Avoid direct exposure to laser beam.

DANGER Class 3B rayonnement laser en cas
d’ouverture. Eviter toute exposition directe
avec le faisceau.

DANGER Class 2(ll) laser radiation present
when open and interlock defeated. Do not
stare directly into the beam

DANGER Class 2(ll) laser radiation present
when open. Do not stare directly into the
beam.

DANGER de Class 2(Il) rayonnement laser en
cas d'ouverture et d'une neutralisation des
dispositifs de securite. Eviter toute exposition
directe avec le faisceau.

DANGER de Class 2(Il) rayonnement laser en
cas d'ouverture. Eviter toute exposition
directe avec le faisceau.

DANGER Class 2(ll) LED when open and
interlock defeated. Do not stare directly into
the beam.

DANGER de Class 2(ll) LED en cas
d'ouverture et d'une neutralisation des
dispositifs de securite. Eviter toute exposition
directe avec le faisceau.

DANGER Class 2(ll) LED when open. Do not
stare directly into the beam.

DANGER de Class 2(ll) LED en cas
d'ouverture. Eviter toute exposition directe
avec le faisceau.

CAUTION Moving parts.

ATTENTION Parties mobiles.

General Instrument Safety

AWARNING PHYSICAL INJURY HAZARD. Use this product only as

specified in this document. Using this instrument in a manner not specified by
Applied Biosystems may result in personal injury or damage to the instrument.

Moving and A (7.\1{e]f] PHYSICAL INJURY HAZARD. The instrument is to be moved

and positioned only by the personnel or vendor specified in the applicable site

Lifting the

preparation guide. If you decide to lift or move the instrument after it has been installed,
do not attempt to lift or move the instrument without the assistance of others, the use of
appropriate moving equipment, and proper lifting techniques. Improper lifting can cause
painful and permanent back injury. Depending on the weight, moving or lifting an
instrument may require two or more persons.

Instrument

Applied Biosystems 3130/3130x/ Genetic Analyzers Getting Started Guide Xvii



Safety
Chemical Safety

Moving and
Lifting Stand-

Alone Computers

and Monitors

Operating the
Instrument

AWARNING Do not attempt to lift or move the computer or the monitor without

the assistance of others. Depending on the weight of the computer and/or the monitor,
moving them may require two or more people.

Things to consider before lifting the computer and/or the monitor:
» Make sure that you have a secure, comfortable grip on the computer or the monitor
when lifting.

* Make sure that the path from where the object is to where it is being moved is clear
of obstructions.

* Do not lift an object and twist your torso at the same time.

» Keep your spine in a good neutral position while lifting with your legs.

* Participants should coordinate lift and move intentions with each other before
lifting and carrying.

* Instead of lifting the object from the packing box, carefully tilt the box on its side
and hold it stationary while someone slides the contents out of the box.

Ensure that anyone who operates the instrument has:

* Received instructions in both general safety practices for laboratories and specific
safety practices for the instrument.

* Read and understood all applicable Material Safety Data Sheets (MSDSs). See
“About MSDSs” on page xviii.

Chemical Safety

Chemical Hazard AWARNING CHEMICAL HAZARD. Before handling any chemicals, refer to

Xviii

Warning

About MSDSs

the Material Safety Data Sheet (MSDS) provided by the manufacturer, and observe all
relevant precautions.

A WLGWNe] CHEMICAL HAZARD. All chemicals in the instrument, including

liquid in the lines, are potentially hazardous. Always determine what chemicals have
been used in the instrument before changing reagents or instrument components. Wear
appropriate eyewear, protective clothing, and gloves when working on the instrument.

Chemical manufacturers supply current Material Safety Data Sheets (MSDSs) with
shipments of hazardous chemicals to new customers. They also provide MSDSs with the
first shipment of a hazardous chemical to a customer after an MSDS has been updated.
MSDSs provide the safety information you need to store, handle, transport, and dispose
of the chemicals safely.

Each time you receive a new MSDS packaged with a hazardous chemical, be sure to
replace the appropriate MSDS in your files.

Applied Biosystems 3130/3130x/ Genetic Analyzers Getting Started Guide
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Chemical Safety

Obtaining MSDSs  You can obtain from Applied Biosystems the MSDS for any chemical supplied by
Applied Biosystems. This service is free and available 24 hours a day.

To obtain MSDSs:
1. Go to https://docs.appliedbiosystems.com/msdssearch.html

2. In the Search field, type in the chemical name, part number, or other information
that appears in the MSDS of interest. Select the language of your choice, then click
Search.

3. Find the document of interest, right-click the document title, then select any of the
following:

* Open - To view the document
* Print Target — To print the document

* Save Target As — To download a PDF version of the document to a destination
that you choose

4. To have a copy of a document sent by fax or e-mail, select Fax or Email to the left
of the document title in the Search Results page, then click RETRIEVE
DOCUMENTS at the end of the document list.

5. After you enter the required information, click View/Deliver Selected Documents
Now.

Chemical Safety  To minimize the hazards of chemicals:

Guidelines * Read and understand the Material Safety Data Sheets (MSDS) provided by the

chemical manufacturer before you store, handle, or work with any chemicals or
hazardous materials. (See “About MSDSs” on page xviii.)

* Minimize contact with chemicals. Wear appropriate personal protective equipment
when handling chemicals (for example, safety glasses, gloves, or protective
clothing). For additional safety guidelines, consult the MSDS.

* Minimize the inhalation of chemicals. Do not leave chemical containers open. Use
only with adequate ventilation (for example, fume hood). For additional safety
guidelines, consult the MSDS.

* Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the
manufacturer’s cleanup procedures as recommended on the MSDS.

* Comply with all local, state/provincial, or national laws and regulations related to
chemical storage, handling, and disposal.

Applied Biosystems 3130/3130x/ Genetic Analyzers Getting Started Guide Xix
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Safety
Chemical Waste Safety

Chemical Waste Safety

Chemical Waste ACAUTION HAZARDOUS WASTE. Refer to Material Safety Data Sheets and
Hazard local regulations for handling and disposal.

AWARNING CHEMICAL WASTE HAZARD. Wastes produced by Applied

Biosystems instruments are potentially hazardous and can cause injury, illness, or death.

Chemical Waste To minimize the hazards of chemical waste:

Safety Guidelines

* Read and understand the Material Safety Data Sheets (MSDSs) provided by the

manufacturers of the chemicals in the waste container before you store, handle, or
dispose of chemical waste.

Provide primary and secondary waste containers. (A primary waste container holds
the immediate waste. A secondary container contains spills or leaks from the
primary container. Both containers must be compatible with the waste material and
meet federal, state, and local requirements for container storage.)

Minimize contact with chemicals. Wear appropriate personal protective equipment
when handling chemicals (for example, safety glasses, gloves, or protective
clothing). For additional safety guidelines, consult the MSDS.

Minimize the inhalation of chemicals. Do not leave chemical containers open. Use
only with adequate ventilation (for example, fume hood). For additional safety
guidelines, consult the MSDS.

Handle chemical wastes in a fume hood.
After emptying the waste container, seal it with the cap provided.

Dispose of the contents of the waste tray and waste bottle in accordance with good
laboratory practices and local, state/provincial, or national environmental and health
regulations.

Waste Disposal If potentially hazardous waste is generated when you operate the instrument, you must:

Characterize (by analysis if necessary) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.

Ensure the health and safety of all personnel in your laboratory.

Ensure that the instrument waste is stored, transferred, transported, and disposed of
according to all local, state/provincial, and/or national regulations.

IMPORTANT! Radioactive or biohazardous materials may require special handling, and
disposal limitations may apply.

XX
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Electrical Safety

Electrical Safety

A p):\\[e]d3] ELECTRICAL SHOCK HAZARD. Severe electrical shock can

result from operating the Applied Biosystems 3130/3130x/ Genetic Analyzers without
its instrument panels in place. Do not remove instrument panels. High-voltage contacts
are exposed when instrument panels are removed from the instrument.

Power A PN (el35] ELECTRICAL HAZARD. Grounding circuit continuity is vital for

the safe operation of equipment. Never operate equipment with the grounding conductor
disconnected.

A pr\Nel35] ELECTRICAL HAZARD. Use properly configured and approved

line cords for the voltage supply in your facility.

A prN(el35] ELECTRICAL HAZARD. Plug the system into a properly
grounded receptacle with adequate current capacity.

Overvoltage The Applied Biosystems 3130/3130x/ Genetic Analyzers have an installation
Rating (overvoltage) category of II, and is classified as portable equipment.

Physical Hazard Safety

v

Moving Parts /= PHYSICAL INJURY HAZARD. Moving parts can crush and cut.
Keep hands clear of moving parts while operating the instrument. Disconnect power
before servicing the instrument.

Laser Safety

Laser The Applied Biosystems 3130/3130x/ Genetic Analyzers use an Argon laser. Under
Classification normal operating conditions, the instrument laser is categorized as a Class I laser. When
safety interlocks are disabled during certain servicing procedures, the laser can cause
permanent eye damage, and, therefore, is classified under those conditions as a Class 3B
laser.

The Applied Biosystems 3130/3130x/ Genetic Analyzers has been tested to and
complies with 21 CFR, 1040.10 and 1040.11, as applicable.”

The Applied Biosystems 3130/3130x/ Genetic Analyzers have been tested to and
complies with standard EN60825-1, “Radiation Safety of Laser Products, Equipment
Classification, Requirements, and User’s Guide.”

Applied Biosystems 3130/3130x/ Genetic Analyzers Getting Started Guide XXi
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Workstation Safety

Laser Safety
Requirements

Additional Laser

Safety
Information

To ensure safe laser operation:

* The system must be installed and maintained by an Applied Biosystems Technical
Representative.

* All instrument panels must be in place on the instrument while the instrument is
operating. When all panels are installed, there is no detectable radiation present. If
any panel is removed when the laser is operating (during service with safety
interlocks disabled), you may be exposed to laser emissions in excess of the Class
3B rating.

* Do not remove safety labels or disable safety interlocks.

Refer to the user documentation provided with the laser for additional information on
government and industry safety regulations.

m LASER HAZARD. Lasers can burn the retina causing permanent

blind spots. Never look directly into the laser beam. Remove jewelry and other items that
can reflect the beam into your eyes. Do not remove the instrument top or front panels.
Wear proper eye protection and post a laser warning sign at the entrance to the laboratory
if the top or front panels are removed for service.

m LASER BURN HAZARD. An overheated laser can cause severe

burns if it comes in contact with the skin. DO NOT operate the laser when it cannot be
cooled by its cooling fan. Always wear appropriate laser safety goggles.

Workstation Safety

XXii

Correct ergonomic configuration of your workstation can reduce or prevent effects such
as fatigue, pain, and strain. Minimize or eliminate these effects by configuring your
workstation to promote neutral or relaxed working positions.

ACAUTION MUSCULOSKELETAL AND REPETITIVE MOTION

HAZARD. These hazards are caused by potential risk factors that include but are not
limited to repetitive motion, awkward posture, forceful exertion, holding static unhealthy
positions, contact pressure, and other workstation environmental factors.

To minimize musculoskeletal and repetitive motion risks:

» Use equipment that comfortably supports you in neutral working positions and
allows adequate accessibility to the keyboard, monitor, and mouse.

* Position the keyboard, mouse, and monitor to promote relaxed body and head
postures.

Applied Biosystems 3130/3130x/ Genetic Analyzers Getting Started Guide



Safety
Safety and Electromagnetic Compatibility (EMC) Standards

Safety and Electromagnetic Compatibility (EMC) Standards

U.S. and
Canadian Safety
Standards

c(UL)us

Canadian EMC
Standard

European Safety
and EMC
Standards

C€

Australian EMC
Standards

C

Applied Biosystems 3130/3130x/ Genetic Analyzers Getting Started Guide

This section provides information on:

* U.S. and Canadian Safety Standards
* Canadian EMC Standard

* European Safety and EMC Standards
* Australian EMC Standards

This instrument has been tested to and complies with standard UL 3101-1, “Safety
Requirements for Electrical Equipment for Laboratory Use, Part 1: General
Requirements.”

This instrument has been tested to and complies with standard CSA 1010.1, “Safety
Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use,
Part 1: General Requirements.”

This instrument has been tested to and complies with ICES-001, Issue 3: Industrial,
Scientific, and Medical Radio Frequency Generators.

Safety

This instrument meets European requirements for safety (Low Voltage Directive
73/23/EEC). This instrument has been tested to and complies with standards EN 61010-
1:2001, “Safety Requirements for Electrical Equipment for Measurement, Control and
Laboratory Use, Part 1: General Requirements” and EN 61010-2-010, “Particular
Requirements for Laboratory Equipment for the Heating of Materials.”

EMC

This instrument meets European requirements for emission and immunity (EMC
Directive 89/336/EEC). This instrument has been tested to and complies with standard
EN 61326 (Class B), “Electrical Equipment for Measurement, Control and Laboratory
Use — EMC Requirements.”

This instrument has been tested to and complies with standard AS/NZS 2064, “Limits
and Methods Measurement of Electromagnetic Disturbance Characteristics of Industrial,
Scientific, and Medical (ISM) Radio-frequency Equipment.”

XXiii
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Start the
system See page 7
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ee page 9
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and
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| and
| Fragment Analysis
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4

Running the
Instrument

Notes

Applied Biosystems 3130/3130x/ Genetic Analyzers Getting Started Guide



Chapter 1 Preparing the Instrument
Instrument Description

Instrument Description

Instrument Layout A typical laboratory layout is shown below.

Monitor CPU 3130/3130xl

Genetic Analyzer

Keyboard %

GR2462

Notes

2 Applied Biosystems 3130/3130x/ Genetic Analyzers Getting Started Guide



Chapter 1 Preparing the Instrument
Application Summary Tables

Application Summary Tables

Sequencing Decide what combination of capillary array and polymer from the table below matches
Resolution  your resolution and performance specifications.
Performance and
Specifications

24 hr Throughput
(number of
Capillary Polymer Run samples) KB
Type of Run = Length Module Time Basecaller
(cm) Type (min) 3130 3130x/ | QV,,LOR?P

Genetic | Genetic

Analyzer | Analyzer
Ultra rapid 36 POP-4™ UltraSeq36_POP4 40 144 576 400
POP-7™ UltraSeq36_POP7 35 164 656 500
Rapid 36 POP-6™ | RapidSeq36_POP6 60 96 384 500
POP-7 RapidSeq36_POP7 96 384 600
Fast 50 POP-7 FastSeg50_POP7 60 96 384 700
Standard 50 POP-4 StdSeq50_POP4 100 56 224 600
POP-6 StdSeq50_POP6 150 36 144 600
POP-7 StdSeq50_POP7 120 48 192 850
Long read 80 POP-4 LongSeq80_POP4 210 24 96 700
POP-7 LongSeq80_POP7 170 32 128 950

a Length of Read (LOR) is the usable range of high-quality or high-accuracy bases determined by Quality Values (QV) generated
by KB " Basecaller v1.2. The LOR is determined by using a sliding window of 20 bases, which has an average QV > 20.
b 98.5% basecalling accuracy, less than 2% Ns.

Applied Biosystems 3130/3130x/ Genetic Analyzers Getting Started Guide 3



Chapter 1 Preparing the Instrument
Application Summary Tables

Fragment Decide what combination of capillary array and polymer from the table below matches
Analysis your resolution and performance specifications. See “Fragment Analysis Kits and Run
Resolution  Modules” on page 5 for information on capillary, polymer, and run module.
Performance and
Specifications

: 24 hr Throughput (GT?)
CLap“Ia':y Polymer Bun Resolution SPecification
Run Modules engt Time b
Type (min) 3130 3130x/ (bp) (SD)
(cm) Analyzer Analyzer

High Throughput, Small Size Fragment Analysis

FragmentAnalysis22 22 POP-4 20 5,760 23,040 250 0.15
_POP4
SNP22_POP4 22 20 5,760 23,040 120 0.50

Standard Fragment Analysis

FragmentAnalysis36 36 POP-4 45 2,560 10,240 500 0.15
_POP4

HIDFragmentAnalysis 45 2,560 10,240 500 0.15
36_POP4

SNP36_POP4 30 3,840 15,360 120 0.50
FragmentAnalysis36 POP-7 35 3,290 13,170 500 0.15
_POP7

FragmentAnalysis50 50 POP-4 65 1,760 7,040 500 0.15
_POP4

FragmentAnalysis50 POP-6 90 1,200 4,800 500 0.15
_POP6

FragmentAnalysis50 POP-7 50 2,300 9,220 500 0.15
_POP7

a 20 GT (Genotypes)/capillary/injection.
b 1bp resolution at 99.99% accuracy.
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Chapter 1 Preparing the Instrument
Application Summary Tables

Fragment The table below lists the Applied Biosystem kit types, with the available run module(s)
Analysis Kits and  and dye sets.
Run Modules

Module
<
< < ~ < © ~ o
o o o o o o o
o [ O o [ O a
iy & % & - & - 3
a o o N 3 3 3 3 3 2
O ) a ° @ o @2 @ i 23
[a o | [ [ n [ [ [ =
I | © = = = = = = o
o . N © o 5 ] ] [ < ] g
Application/Kit & e > g g g g g g 2
s % e § § § &5 &5 5§ &
I S S S 1S S S 2
(o)) (@) (@] (o)) (@) (@] e
o © o o o o L
I (I - [ I - o
I
SNaPshot® Multiplex System E5 E5
Custom oligos D, F D,F D, F D,F D,F D,F,
G5 G5 Gb G5 G5 Gb
Linkage Mapping Set (human) D,G5 D,G5 | D,G5 D,G5  D,G5 | D,G5
v2.5
ABI PRisM® Mouse Mapping Set D,G5 | D,G5 | D,G5 | D,G5 | D,G5 | D, G5
v1.0
4-Dye Stockmarks® kits (bovine F
and canine)
5-Dye Stockmarks® kit (equine) G5
AFLP® kits F
4-Dye AmpF(STR® kits F
5-Dye AmpF{STR kits G5
AmpF(STR Kit Table
. HIDFragmentAnalysis
Kits 36_POP4
AmpF(STR COfiler® Kit F

AmpF{STR Profiler Plus® Kit
AmpFLSTR Profiler Plus ID Kit
AmpF(STR SGM Plus® Kit
Other 4-Dye AmpF(STR Kits
AmpF(STR SEfiler™ Kit G5
AmpF(STR Identifiler® Kit
AmpF(STR Yfiler™ Kit

Other 5-Dye AmpF(STR Kits

Applied Biosystems 3130/3130x/ Genetic Analyzers Getting Started Guide 5



Chapter 1 Preparing the Instrument
Barcode Readers

Barcode Readers

A pJi\\[e133] ELECTRICAL HAZARD. Power off the instrument and the

computer before connecting an external barcode reader to the instrument.

External Barcode KEYENCE BL-80VE
Readers

An external barcode reader can be used with the 3130/3130x!/ instrument. With the
KEYENCE BL-80VE (see photo above), which connects to the instrument computer

keyboard, you can scan barcodes into any text box in the Data Collection software. The
KEYENCE BL-80VE barcode reader uses an LED as a light source.

Notes

Applied Biosystems 3130/3130x/ Genetic Analyzers Getting Started Guide



Chapter 1 Preparing the Instrument
Starting the 3130/3130xI Genetic Analyzer System

Starting the 3130/3130x/ Genetic Analyzer System

Starting the Computer Workstation

IMPORTANT! You must start the computer
workstation before starting the instrument.

1. Power on the monitor.

2. Power on the computer.

3. In the Log On to Windows dialog box:

a. Enter the user name.

b. If applicable, enter a password.

Note: If the computer is connected to a
network, you do not need to log on to the
network before starting the instrument.

c. Click ok |

Notes

Log On to Windows

1 Microsoft*

Windows

‘ Professional

Copyright € 1985-2001
Microsoft Corporation

User name: | Administrator

Password: I

|
|

Cancel

Applied Biosystems 3130/3130x/ Genetic Analyzers Getting Started Guide




Chapter 1 Preparing the Instrument
Starting the 3130/3130xI Genetic Analyzer System

Starting the 3130/3130x/ Genetic Analyzer

1. Ensure that the:
¢ Oven door is closed and locked

¢ Instrument doors are closed

Note: If the doors are open during power on, the
yellow light will continue to flash until you close
the doors.

2. Ensure that the computer is powered on.

Note: The computer must be on and running to
allow the instrument to copy the firmware from
the computer.

3. Power on the instrument by pressing the on/off )
button on the front of the instrument.

Note: While the instrument is booting up and
performing self-checks, the yellow status light
blinks.

4. Ensure the green status light is on and not
flashing before proceeding.

Note: If the green status light does not come on,
start the Data Collection software and view the
log. The pathway to the log is:
E:\AppliedBiosystems\UDC\DataCollection\ =

Log\Instrument Name Q=0

GR1770

L— Status lights

Press the on/off button to start the instrument

8 Applied Biosystems 3130/3130x/ Genetic Analyzers Getting Started Guide



Chapter 1 Preparing the Instrument
Data Collection Software

Data Collection Software

IMPORTANT! Do not rename the computer. The
instrument computer was assigned a unique name
before the 3130/3130x/ genetic analyzer Data
Collection software was installed. Do not rename the
computer once the Data Collection software has been
installed. Doing so may cause the Data Collection
software to malfunction.

Starting the 3130/3130x/ Data Collection

Software
1. Select Start > All Programs > Applied REE
Biosystems > Data Collection > Run 3130
Data Collection v3.0 or Run 3130x/ Data sz Sz
Collection v3.0 to display the Service Console.
By default, all applications are off, indicated by Dt Service E on
the red circles. They launch automatically with
the 3130/3130x/ Data Collection software. _ [
Viewsr ———— Activating
‘ saton | resarnen |[FEma ]

As each application activates, the red circles (off)
change to yellow triangles (activating), and then
to green squares (on) when they are fully
functional.

When all the applications are running (displaying 1o 5
all green squares—this could take several
minutes), the Foundation Data Collection
window displays.

Messaging Service

Data Service

Instrument Service

Viewer

MMM

‘ | Restart Al I Stop Al |

Applied Biosystems 3130/3130x/ Genetic Analyzers Getting Started Guide 9



2.

3.

Chapter 1 Preparing the Instrument
Data Collection Software

Click + to expand subfolders in the left tree pane.
All application folders are now visible.

Select items from this tree pane to open manager,
viewer, and other program windows.

Click + to expand subfolders in the left tree pane.
All application folders are now visible.

Select items from this tree pane to open manager,
viewer, and other program windows.

Notes

Foundation Data Collection Version 3.0 - No User is logged in

AR
3130x/

Genetic Analyzer

Data Collection
Software v3.0

Foundation Data Collection Version 3.0

File  “iew Help

iR
™

= M G nstruments
ﬂ] Results Group
= Database fanager
= B gaztam
[ Plate Wlanager
%I Praotocol Manager
%Mﬂdule fanager
= SR History
EYEPT Yiewer
Event Log
% Inztrument Protocol
Bl =patial Calibration Yiewer
=Capillary “ienver
-Capmrray “iewer
uSpectral Calibration “iewwer
@Reex‘tradion
= [CPmyinstrumert
Elnstrumer‘rt Status
ESpaﬂal Run Scheduler
B Run Scheduler
=Capillaries “ienver
-Capmrray “iewer
uSpectral “iewer
ﬁManual Coritral
Service Log

10
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Preparing the Instrument

Instrument Doors
and Interior

Pump block

Chapter 1 Preparing the Instrument
Preparing the Instrument

Polymer delivery pump (PDP)

Oven

Detection cell block
%g % Capillary array
== Buffer and water
I reservoirs
[ =)
0z % g
g Autosampler
L ]
L— Lower polymer block
L Anode buffer reservoir

Part Function

Anode buffer reservoir

Buffer and water
reservoirs (four)

Contains 16 mL of 1X running buffer.

Each contain 16 mL of 1X running buffer or water.

Autosampler

Holds the sample plates and reservoirs and moves to align
the samples, water, or buffer with the capillaries.

Capillary array

Detection cell block and
heater

Enables the separation of the fluorescent-labeled DNA
fragments by electrophoresis. It is a replaceable unit
composed of 4 or 16 silica capillaries.

Holds the capillaries in place for laser detection.

Lower polymer block

Contains the buffer valve, anode electrode, and anode
buffer reservoir.

Oven

Polymer delivery pump
(PDP)

Maintains uniform capillary array temperature.

Pumps polymer into the array and performs maintenance
procedures.

Pump block

Includes the displacement pump chamber, piston water
seal, array attachment point (array port), and connection to
the lower polymer block through the interconnect tube.

Applied Biosystems 3130/3130x/ Genetic Analyzers Getting Started Guide
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Chapter 1 Preparing the Instrument
Preparing the Instrument

Inspecting the Instrument
1. Open the instrument doors.

2. Perform the daily maintenance tasks -see
Chapter 1 in the Applied Biosystems 3130/3130xl
Genetic Analyzers Maintenance,
Troubleshooting and Reference Guide.

3. Install clean drip trays.

Polymer Delivery Pump

Mounting pin

PDP motor

|
I
Syringe fitting : : PDP motor cover
I
I
' :

Capillary array tip

Water seal —
Waste fitting :[I:h @

Water trap

—— Capillary array

Mounting pin
Piston Capillary array knob
Pump chamber
Pump block
Check valve Double-tapered ferrule
Array port
Interconnect tube
Polymer supply tube
Buffer valve pin
Mounting Lower polymer block
Polymer supply pin | Mounti ]
bottle cap with O O ounting pin
hol : %
e O-ring I Overflow hole
‘ Buffer fill-line
Polymer /

supply bottle Anode buffer reservoir

(16 mL anode reservoir)

Electrode GR2459
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Chapter 1 Preparing the Instrument
Preparing the Instrument

Inspecting the Instrument

1. Open the instrument doors.

2. Perform the daily maintenance tasks -see the
Applied Biosystems 3130/3130xl Genetic
Analyzers Maintenance, Troubleshooting and
Reference Guide for more detail on maintenance.

3. Install clean drip trays.

Installing or Replacing the Capillary Array

IMPORTANT! The capillary array length defined in
the wizard must match the array length you are using
for correct autoanalysis results.

IMPORTANT! Wear gloves while ¢
handling polymer, the capillary array,
septa, or buffer reservoirs. i "o

ACAUTION CHEMICAL HAZARD. POP

polymer may cause eye, skin, and respiratory tract
irritation. Please read the MSDS, and follow the
handling instructions. Wear appropriate protective
eyewear, clothing, and gloves. Use for research and
development purposes only.

1. Install a capillary array by clicking <instrument Wizards R
name>, selecting Install Array Wizard and
following the prompts.

Inskall drray Wizard
hange Polvmer Twpe \Wizard

IMPORTANT! To install or replace an array that Replenish Polymer Wizard

is a different length than the one you were using, Bubble Remowve Wizard
reset the active spectral calibration (see page 47) WWater Wash Wizard

or create a new spectral calibration for your dye Instrument Shutdown Wizard

set and array length combination (see page 37). Aukosampler Calibration Wizard

Ilpdate Cap Array Info

2. Optional: Select Update Cap Array Info wizard
to correct any errors or update capillary array and
serial number information.

Applied Biosystems 3130/3130x/ Genetic Analyzers Getting Started Guide 13



Chapter 1 Preparing the Instrument
Preparing the Instrument

When to Replenish or Change Polymer

IMPORTANT! Always replace SUM TWThF S
polymer that has been on the
instrument longer than one week.

If polymer on the instrument... Then ...

has been on less than one week and is in sufficient quantity | Remove all bubbles, and then proceed with instrument
to complete your runs? preparation.

has been on less than one week, and insufficient in quantity | Add fresh polymer to the polymer supply by following the
to complete your runs Replenish Polymer Wizard.

has been on longer than one week

is the wrong type (a change between POP-4, POP-6, and/or | Replace the installed polymer type with a different type by
POP-7 polymers is required) following the Change Polymer Type Wizard.

a A 3130x/ genetic analyzer run uses 50 to 80 pL of polymer and a 3130 genetic analyzer run uses ~25 to 40pL of polymer.

Before Using the Polymer
1. Remove the polymer from 4 °C storage.

2. Loosen the cap and bring the polymer to room
temperature.

3. To dissolve deposits, tighten the cap and gently
swirl the polymer.

Replenishing the Polymer

IMPORTANT! Wear gloves while

handling polymer, the capillary array, =
: L o

septa, or buffer reservoirs. \

ACAUTION CHEMICAL HAZARD. POP

polymer may cause eye, skin, and respiratory tract
irritation. Please read the MSDS, and follow the
handling instructions. Wear appropriate protective
eyewear, clothing, and gloves. Use for research and
development purposes only.

1. Click < Instrument Name> in the tree pane.

14 Applied Biosystems 3130/3130x/ Genetic Analyzers Getting Started Guide



Chapter 1 Preparing the Instrument
Preparing the Instrument

2. Select Wizards > Replenish Polymer Wizard

. Wizards Mgl
to replenish polymer.
Inskall Arraw Wizard
IMPORTANT! The polymer type defined in the Change Polymer Type ‘Wizard
wizard must match the polymer type that you are Replenish Polymer Wizard
using. Bubble Remove Wizard
Weaker \Wash Wizard
Changing Polymer Type Instrurnent Shotdown Wizard
Autosampler Calibration \Wizard
IMPORTANT! Wear gloves while / Update Cap Array Info
handling polymer, the capillary array, =
septa, or buffer reservoirs. \ ’,’ /

ACAUTION CHEMICAL HAZARD. POP

polymer may cause eye, skin, and respiratory tract
irritation. Please read the MSDS, and follow the
handling instructions. Wear appropriate protective
eyewear, clothing, and gloves. Use for research and
development purposes only.

1. Click < Instrument Name> in the tree pane. Wizards RN

YWIZD

2. Select Wizards > Change Polymer Type Install Array Wizard

Wizard to change to a different polymer. Change Polymer Type Wizard

Replenish Palymer \Wizard
Bubble Remove Wizard

W ater Wash Wizard
Instrument Shutdown \Wizard
Autosampler Calibration Wizard
Ipdate Cap Atray Info

Applied Biosystems 3130/3130x/ Genetic Analyzers Getting Started Guide 15



Chapter 1 Preparing the Instrument
Preparing Buffer and Filling Reservoirs

Preparing Buffer and Filling Reservoirs

Required Materials

ACAUTION CHEMICAL HAZARD. 10X

Genetic Analyzer Buffer with EDTA may cause
eye, skin, and respiratory tract irritation. Read the
MSDS, and follow the handling instructions. Wear
appropriate protective eyewear, clothing, and gloves.

Required materials to prepare 1X running buffer:

* 10X Genetic Analyzer Buffer (P/N 402824)
¢ Purified (distilled or deionized) water
* 50 mL graduated cylinder
Preparing Buffer for a Single Run
1. Add 5 mL of 10X Genetic Analyzer buffer into a

A~
graduated cylinder. @
N
2. Add purified water to bring the total volume up =
to 50 mL. =
. 50mL =
3. Mix well. totg? = —— 45 mL DI H,0
) (@ ) — 5 mL 10X Genetic

Analyzer buffer

50 mL graduated cylinder

Storing Buffer

Buffer Storage Conditions
Store 1X running buffer at: '

Option A Option B
e 2to 8 °C for up to 1 month
* Room temperature for 1 week 2°Cto 20°C to
8°C 25°C

SuM TWThF S SuM TWThF S

v

1 month 7 days
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Replacing Buffer and Water

Replace the 1X running buffer in the anode and
cathode buffer reservoirs daily, or before each batch
of runs.

IMPORTANT! Failing to replace buffer may lead to
loss of resolution and data quality.

IMPORTANT! To clean and refill the reservoirs, the
autosampler is brought to the forward position,
thereby leaving the capillary tips exposed to the air.
Do not leave the autosampler in this position for an
extended time because the capillaries can dry out and
the array may be damaged.

Filling the Water and Cathode Buffer
Reservoirs

IMPORTANT! Wear gloves while »
performing the following procedure,
and any other time you handle the » o
capillary array, septa, or buffer

Ieservoirs.

ACAUTION CHEMICAL HAZARD. 1X

Genetic Analyzer Buffer with EDTA may cause eye,
skin, and respiratory tract irritation. Read the MSDS,
and follow the handling instructions. Wear
appropriate protective eyewear, clothing, and gloves.

1. Verify the oven and instrument doors are closed.

2. Press the Tray button on the outside of the
instrument to bring the autosampler to the
forward position

3. Wait until the autosampler stops at the forward
position, then open the instrument door.

Chapter 1 Preparing the Instrument
Preparing Buffer and Filling Reservoirs

- TRAY
=° O
-

GR1770

O
e

Tray button

Applied Biosystems 3130/3130x/ Genetic Analyzers Getting Started Guide
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Chapter 1 Preparing the Instrument
Preparing Buffer and Filling Reservoirs

Remove the cathode buffer and water reservoirs
from the instrument.

Dispose of remaining fluids and rinse out the
reservoirs with deionized water.

Note: Follow your company’s waste disposal
practices for appropriate disposal procedures.

Rinse the cathode reservoir with 1X running
buffer, and then fill to the line with 1X running
buffer (about 16 mL).

Fill the two water reservoirs to the line with
quality deionized water (about 16 mL).

A (o7 H[e]\] Be sure that the septa fit

securely and flush on the tops of the reservoirs to
prevent damaging the capillary tips.

Place a clean reservoir septa on each reservoir,
and dry the outside of the reservoirs using a
lint-free tissue wipe.

Place the reservoirs into position on the
autosampler as shown.

Close the instrument doors.

Note: Closing the doors returns the autosampler
to the last known position, placing the tips of the
capillaries in water or buffer.

Applied Biosystems 3130/3130 Genetic Analyzers Getting Started Guide
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Fill line

Water reservoir
(waste)

Cathode reservoir
(1X running buffer)
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(rinse)
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(unused)




Filling the Anode Buffer Reservoir
Change the anode buffer:

* Every 24 hours
e Before each run or batch of runs

* Every time you replenish the polymer or change
polymer type

Chapter 1 Preparing the Instrument
Preparing Buffer and Filling Reservoirs

Change the Anode Buffer

ACAUTION CHEMICAL HAZARD. 1X

Genetic Analyzer Buffer with EDTA may cause eye,
skin, and respiratory tract irritation. Read the MSDS,
and follow the handling instructions. Wear
appropriate protective eyewear, clothing, and gloves.

>

Every 24 hours Before each run
or batch of runs

1. Remove the anode buffer reservoir by firmly
pulling down and twisting slowly.

2. Discard the used buffer appropriately.

3. Clean and rinse the reservoir with deionized
water, and then rinse with buffer.

4. Fill the anode buffer reservoir to the fill line with
fresh 1X running buffer (about 16 mL).

Note: The meniscus should line up with the
fill line.

5. Put the anode buffer reservoir on the instrument.

6. If the reservoir fills with fluid, repeat this
procedure to discard and replace the running
buffer.

Note: The reservoir could fill during bubble
removal.

g Fill line

Applied Biosystems 3130/3130x/ Genetic Analyzers Getting Started Guide 19



Chapter 1 Preparing the Instrument
Preparing Buffer and Filling Reservoirs
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Chapter 2

Performing a Spatial Calibration

N Preparing the

SE—- Instrument

Performing a
Spatial Calibration

Start a spatial See page 22
e ——— calibration run
=={%‘g= Performing a
=’=E= Spectral Calibration
E.-!

A

Autoanalysis Evaluate spatial See page 23

and Sequencing . . .
Analysis calibration profile

~ Software

hd

Autoanalysis
and
SeqScape Software

i

Autoanalysis
and
Fragment Analysis

J

Running the
Instrument

Accept or reject

. G See page 24
spatial calibration

Notes
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Chapter 2 Performing a Spatial Calibration
Spatial Calibration

Spatial Calibration

The 3130/3130x!/ genetic analyzer Data Collection software uses images collected during
the spatial calibration to establish a relationship between the signal emitted by each
capillary and the position where that signal falls on and is detected by the CCD camera.

When to Perform  You are required to perform a spatial calibration when you:
the Calibration

Install or replace a capillary array
* Temporarily remove the capillary array from the detection block

¢ Move the instrument

Creating a Spatial Calibration File

1. In the tree pane of the Data Collection software, click
£ GA Instruments > | ga3130 or ga3130x/ > =0 instrument
name > [iill Spatial Run Scheduler.

. Foundation Data Collection Version 3.0 - Mo User is logged in

File WView Service Tools Wizards Help

2 &

= G Instrument; 4
A DQE;:E@SMF W GA Instruments > ga3130x] » Dev > Spatial Callsration Viswer

B=)Database Manager
Elgaa130x
EPiats Manager

@y Pratocal Manager

T Macule Manager 6000

# CHRuN History
= ioev

# [Edinstrument Status 4000

[E| 5 stial Fun Schedud

+ EIRUN Scheduler

8000

Spatial
= Capillaries Viewer 2000 :

B vy Viewsr profile
R spectral iewsr
EMManual Cortral a
[Eservice Log

-2000

a0 100 120 140 160 180 200 220 240 260
Intensity vs Pixel Number
18 Capillary Postions: Spatial Protocols
Capilary | Posttion (pizels) Left spacing | Right spacing Protocol 51 30SpstialFil_1 v
M 2 P Start, Accept
3 71 or Reject
4 Spatial profile
e . 5
Positions (pixel) 5
of each capillary—| 7
8
)
10
"
12
L 13 ~

< ¥
Siyster Status B [ The number of runs has changed o 0
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Chapter 2 Performing a Spatial Calibration
Evaluating a Spatial Calibration File

2. In the Spatial Protocols section, select one of the
following:

Spatial Protocols

Protocal: |31305patialFil_1 M
* If the capillaries contain fresh polymer, m pm" , — Select one
select Protocol > 3130SpatialNoFill_1 =
¢ Otherwise, select Protocol
> 3130SpatialFill 1
Note: You do not need to fill the capillaries each
time you perform a spatial calibration.
3. Click Start . Spatial Protocols
The calibration run lasts approximately: Protocel B
tart Start spatial calibration

* 2 min. without filling the capillaries

* 6 min. when filling the capillaries

Note: The spatial profile window turns black
when you start a spatial calibration.

Evaluating a Spatial Calibration File

1. Evaluate the spatial calibration profile using the Spatial calibration profile for 3130x/ system
following criteria: sou0
5000
Peak . 4000
Attribute Acceptable Criteria s
. : ; . 2000
Height Similar heights for all peaks. 1om0
Orange One orange cross marking the top v
crosses of every peak. No misplaced i 100 120 140 180 180 200
CI’OSSeS_ Intensity vs Pixel Mumber
Shape Single sharp peak for each
capillary. Spatial calibration profile for 3130 system

Small shoulders are acceptable.

Spacing The difference between adjacent
positions is 13 to 16 pixels.
Theoretical spacing between
capillaries is 15.

100 120 140 160 180 200

Intensity s Pixel Number
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Evaluating a Spatial Calibration File

2. Examine each row in the 16 or 4 Capillary 16 Capilary Postions
Positions table and verify that the values in both ol | Fesenhes) | eiemehe | e S
the Left spacing and Right spacing columns 10 A
. 2 25
range between 13 to 16 pixels. 5 “
To move the cross: : ?2
a. Type a new value in the Positions (pixels) ? 18;2
box for the capillary of interest. 8 17
9 132
b. Click outside of that box or press Enter. 1 148
11 163
12 178
13 194 w
4 Capilary Positions
Capillary Pozition (pixels) Left spacing Right =pacing
2
E|
4
Left spacingand 4‘—/
Right spacing
columns
Accepting or Rejecting a Spatial
Calibration
If the Calibration: Spatial Protocols
Protocol: [3100SpatialFil_1 =l

e Passed, click #ccept  to write the
calibration data to the database and .ini file. | |

 Failed, click _Fejeit |, then see the Applied jhceet Reect | | | Accept and

K . Reject buttons
Biosystems 3130/3130x] Genetic Analyzers
Maintenance, Troubleshooting and
Reference Guide.
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Examples of Spatial Profiles

Passing Profiles 3130 Genetic Analyzer

0 20 40 60 a0 100 120 140 160 180 200 220 240 260
Intensity vs Pixel Mumber

3130x/ Genetic Analyzer

0 20 40 60 a0 100 120 140 160 180 200 220 240 260
Intensity vs Pixel Mumber

Failing Profile  3130x/ Genetic Analyzer

6000

5000

4000

3000

2000

1000

0

-1000
0 20 40 &0 a0 100 120 140 160 180 200 220 240 260

Intensity vs Pixel Mumber
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Spectral Calibration
——

Spectral Calibration

A spectral calibration creates a matrix that is used during a run to reduce raw data from
the instrument to the 4-dye or 5-dye data stored in sample files. Performing a spectral
calibration is similar to performing a sample run except that calibration standards are run
in place of samples and a spectral calibration module is used in place of a run module.

When to Perform  Perform a spectral calibration:

the Calibration .
* When you use a new dye set on the instrument

* When you change capillary array length (or polymer type for fragment analysis)
» After the laser or CCD camera has been realigned/replaced by a service engineer

» If you begin to see a decrease in spectral separation (pull-up and/or pull-down
peaks) in the raw or analyzed data

What Happens? Run the spectral standards in all 16 or 4 capillaries. The Data Collection software then:

* Collects the data and stores it in 16 or 4 separate temporary files
* Analyzes the data and generates a matrix for each capillary
» Stores the spectral calibration data for the dye set run

Changing For each dye set, a unique spectral calibration is used for each different capillary array
Capillary Array length.

Lengths and

Polymer Type

» For every sequencing dye set, you must create a separate spectral calibration for
each capillary array length you use.

» For every fragment analysis dye set, you must create a separate spectral calibration
for each capillary array length and polymer type combination you use.

See “Activating a Spectral Calibration” on page 47, on how to switch calibrations once
calibrations are performed for each dye set on each capillary length.

Supported New basecaller, mobility files, and run modules will be developed for the 3130/3130x/
Sequencing series instruments solely in support of the ABI PRISM® BigDye® Terminator v1.1 and
Chemistries  v3.1chemistry kits. For more information, please contact Applied Biosystems Technical

Support.

ABI PrisM® BigDye® Terminator v1.0, v2.0 and v3.0 chemistry kits have been
discontinued.
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Spectral Calibration

Types of There are two types of spectral calibration standards:
Calibration

Standards ¢ Matrix standards for fragment analysis or sequencing - A tube that contains

four or five fragments each labeled with a different single dye.

* BigDye® v3.1 or BigDye® v1.1 Terminator Sequencing Standard - A tube of a standard
chemistry reaction that contains multiple labeled fragments in each of the four dyes

Dye Set Tables Determine the correct dye set and matrix standard set for the application you are using
by using the tables below.

Sequencing Chemistry Dye Sets, Calibration Standards, and Chemistry File

Sequencing Chemistry Dye Set Spectral Calibration Standard Chemistry File

¢ BigDye® Terminator v3.1 Cycle Z_BigDyeV3 | BigDye® v3.1 Matrix Standards Matrix Standard

Sequencm(;; Kit ] . BigDye® v3.1 Terminator Sequence Standard
e ABI PrisM® dGTP BigDye Sequencing Standard

Terminator v 3.0 Cycle Sequencing

Ready Reaction Kit?
e BigDye® Terminator v1.1 Cycle E_BigDyeV1 | DS-01 Matrix Standards Matrix Standard

Sequencing Kit BigDye® v1.1 Terminator Sequence Standard
¢ ABI PrisM® BigDye® Primer Cycle Sequencing Standard

Sequencing Kits

¢ ABI PRisM® dGTP BigDye®
Terminator Cycle Sequencing Ready
Reaction Kit?

ABI PrisM® dRhodamine Terminator dRhodamine Matrix Standards Kit | Matrix Standard
Cycle Sequencing Kit

a dGTP kits are not supported on capillary electrophoresis instruments due to compressions on certain sequence context regions; you can
run the kits if compression is not an issue.
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Spectral Calibration
——

Fragment Analysis Dye Sets, Calibration Standards, and Chemistry File

Fragment Analysis Chemistry Dye Set Spectral Calibration Standard Chemistry File
Custom oligos D DS-30 Matrix Standards Matrix Standard
¢ ABI PrisM® Mouse Mapping Set v1.0 D DS-31 Matrix Standards
e Custom oligos
e AFLP® kits F DS-32 Matrix Standards
¢ Stockmarks® Kits 4-dye (bovine and

canine)

* AmpF(STR® COfiler® Kit

¢ AmpF{STR® Profiler Plus® Kit

e AmpF{STR® Profiler Plus® ID Kit
e AmpF{STR® SGM Plus® Kit

¢ Other 4-Dye AmpF{STR Kits

ABI PRIsM® SNaPshot® Multiplex System E5 DS-02 Matrix Standards

e ABI PRISM® Linkage Mapping Set v2.5 G5 DS-33 Matrix Standards
¢ Stockmarks® Kit 5-dye (equine)
e Custom Oligos

o AmpF{(STR® |dentifiler® Kit

e AmpF(STR® SEfiler™ Kit

e AmpF(STR® Yfiler™ Kit

e Other 5-Dye AmpF{(STR Kits
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Preparing the Spectral Calibration Chemistry
P

Preparing the Spectral Calibration Chemistry

Preparing the Calibration Standard

1. Prepare one of the following:

AWARNING CHEMICAL HAZARD.

Formamide causes eye, skin, and respiratory
tract irritation. It is a possible reproductive and
birth defect hazard. Read the MSDS, and follow
the handling instructions. Wear appropriate
protective eyewear, clothing, and gloves.

* ABI PrisM BigDye Terminator v1.1 or v3.1
Sequencing Standard:
— Remove a tube of the Sequencing
Standard from the freezer.
— Add 170 pL of Hi-Di™ formamide to
resuspend the BigDye Terminator v1.1 or
v3.1 Sequencing Standard.

» Sequencing or fragment analysis matrix
standards:

— Remove a tube of the matrix standard
from the refrigerator.

— Mix thoroughly, then spin briefly in a
microcentrifuge.

— Follow the matrix standard insert for
matrix standard and Hi-Di formamide
ratios.

2. Vortex thoroughly.
Briefly centrifuge the mixture.

3. Heat the standard tube at 95 °C for 5 minutes to
denature the DNA.

4. Cool the tubes on ice for 2 minutes.
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Loading Samples

AWARNING CHEMICAL HAZARD. All

chemicals on the instrument, including liquid in the
lines, are potentially hazardous. Please read the
MSDS, and follow the handling instructions. Wear
appropriate eyewear, protective clothing, and gloves
when working on the instrument.

A \WLGIIINed Do notuse warped
or damaged plates.

Note: The efficient way to lay out samples in a plate
is illustrated here. See Appendix A, “Plate Mapping,”
for the relationship between sample position and
priority in scheduled injections.

To load samples:

1. Add the denatured samples to the wells of a 96-
or 384-well reaction plate:

» If using a 3130x/ genetic analyzer:
— 96-well plate — Add 10 uL of denatured
standard to wells A1 through H2.

— 384-well plate — Add 5 uL. of denatured
standard into alternating wells of the
plate:

Row 1: A1, C1, El, ...K1, M1, O1

Row 2: Empty

Row 3: A3, C3, E3, ...K3, M3, O3
e If using 3130 genetic analyzer:

— 96-well plate — Add 10 uL of denatured
standard to wells A1, B1, C1 and DI1.

— 384-well plate — Add 5 uL of denatured
standard into alternating wells of the
plate:

Row 1: Al, C1, El and G1

Prepared standard
(from step 4 on page 31)

3130x/
instrument
layout

3130
instrument
layout

384-Wel
Plat:

3130x/
instrument
layout

3130
instrument
layout

o

OOOOOOOOF
00000000
0000000 0-
00000000
0000000 0-
O0000000-
00000000+
0000000 0-
0000000 0-
00000000

00000000
0000000 0s

GR1315b

OO0O00O0O0O"
OO000O0O0-
0000000
OO000000-
O000000-
OO00O0O0OO~
OO000O0O0-
00000000
00000000
00000000
00000000

O
O
O
O
O
O
O
O

>

©

Add 10 pL prepared standard

GR1315¢

vozz - xc - Iommoowx
0000000000000
00000000000000
0000000000000
OUOO00U000000000
0000000000000000
0000000000000000-
0000000000000000~
0000000000000000=
0000000000000000-
0000000000000000s
0000000000000000=
0000000000000000%
0000000000000000a
0000000000000000=
0000000000000000=
00000000000000005
0000000000000000=
0000000000000000:
0000000000000000z
00000000000000003
0000000000000000™
0000000000000 000R
00000000000000008
0000000000000000

GR1316b

Toamoo o>

0000000Jdeoe oo o

0000000000000 O000
0000000000000 O000-
0000000000000 000
0000000000000 000-
0000000000000 000~
0000000000000 000=
0000000000000 0O0O0=
0000000000000 000
0000000000000 000
0000000000000 000
0000000000000 000
0000000000000000=
0000000000000 000a
0000000000000 000
0000000000000 O000I
0000000000000 00O0
0000000000000 000
000000000000 0000s
0000000000000 000
0000000000000 000K
0000000000000 000.
0000000000000 0O00R

ozzrxc
00000000

°
]

GR1316¢c

Add 5 pL prepared standard
into alternating wells
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2. Seal the plate:
a. Place the plate on a clean, level surface. Plate septa
b. Lay the septa flat on the plate.

c. Align the holes in the septa strip with the
wells of the plate, then firmly press
downward onto the plate.

Sample plate

IMPORTANT!: Do not heat plates that are
sealed with septa.

3. To prevent damage to the capillary array, inspect

the plate and septa to verify the septa fits snugly Septa and well

and flush on the plate. not aligned
Septa and well
not aligned
4. Briefly centrifuge the plate. P Prepared standard

=0

5. Remove the plate from the centrifuge and verify
that each sample is positioned correctly in the
bottom of its well.

If the reagents of any well contain bubbles or are
not located at the bottom of the well, repeat
steps 4 and 5.

Sample is at the
. . bottom of the well
6. Leave the plate on ice until you are ready to

prepare the plate assembly and place the
assembly on the autosampler.

Notes
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Loading Samples
_,/

7. Assemble the plate assembly:

Plate retainer

a. Place the sample plate into the plate base.

b. Snap the plate retainer onto the plate and
plate base.

— 6b

Plate base

Assembled
components

8. Verify that the holes of the plate retainer and the
septa strip are aligned. If not, re-assemble the Plate retainer
plate assembly (see step 7). - J; @ | holesand septa

holes are not
aligned

IMPORTANT! Damage to the array tips will
occur if the plate retainer and septa strip holes do
not align correctly.
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Creating a Spectral Instrument Protocol

Creating a Spectral Instrument Protocol

1. In the tree pane of the Data Collection software, e v
Click A GA Instruments > %'\_l ga3130xl OI‘ DRESMS Group B G nstruments = ga3130xl = Protocol Manager

k=) Database Managsr Instrument Protocols

ga3130 > & Protocol Manager to open the = Bl

[ZPlate Manager Find Protocol | |
:
Protocol Manager window. et s
= CHRun Histary
EHEPT wigwer
ElEvent Lag
& Instrumert Frotocel
BB Spatial Calibration Wiewer
= Capillary iewer
BB caprarray viswer
[ spectral Calibration Wiewer
FFReestraction
[El= [
= [EHnstrumert Status I3
QEPT Chart
ElEvent Log Vv Vo Ve
] Spatial Run Scheduler w Create analysis m M

= RN Scheduler

Man

Create instrument
protocols here

Pt View ways  protocols here
RN View

= capilaries Viewsr Find Protocel |

BB capiarray Viewsr

B|spectral viewer Harie Appiication
FManusl Control 3 7
S servics Lag

2. In the Instrument Protocols pane, click = rew..

The Protocol Editor dialog box opens. ..

<

D

Analysis Protocols

3. Complete the Protocol Editor dialog box. |
a. Type a name for the protocol. Neme:  [spectral_7_betrixStis —— 3a
b. Type a description for the protocol pesermen 3b
(optional).
Select Spectral in the Type drop-down list. 3c
Type  [sPECTRAL =1

d. Select the correc"f dye set for your run. See breset [Fagorevi 5 & 3d
“Dye Set Tables” on page 29.

Polymer: Ipop4 LI 3e

Array Length: I}ﬁ LI
Chermistry:  |atrix Stanclard =1 —— 3f
Run Module: ISpeC‘tB()_POP4_1 L.Li Sg
Edlit Param... O Cancel
‘ 3h
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Creating a Spectral Instrument Protocol
——

e. Select the Polymer and Array Length from Polymer, Array Length and Spectral Run Modules
the appropriate drop-down list. See table,
“Polymer, Array Length and Spectral Run Polymer Array Run Module
M Type Length (cm)
Modules.
. . . POP-4 22 122_POP4
f. Select your chemistry file in the Chemistry © Spect22_PO
drop-down list. Failure to select the correct 36 Spect36_POP4
chemistry file for your spectral calibration SpectSQ36_POP4
iarnples results 1,13 a failing spectral run. See 50 Spect50_POP4
Dye Set Tables” on page 29 for matching
chemistry files. 80 Spect80_POP4
POP-6 36 Spect36_POP6
Note: 'The chemistry file for fragmeqt 50 Spect50_POP6
analysis dye sets defaults to the Matrix
Standard. POP-7 36 Spect36_POP7
50 Spect50_POP7
g. In the Run Module drop-down list, select 80 Spect80_POP7

the run module. See the table “Polymer,
Array Length and Spectral Run Modules.”

Note: The modules list is filtered based on
the polymer type, then the array length you
selected in step e. You may have only one
run module option available.

h. Click ok |.
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Performing a Spectral Calibration
S

Performing a Spectral Calibration

Creating the Plate Record

1. In the tree pane of the Data Collection software, = A% Instruments
. [ Results Group
click # GA Instruments > [/ga3130x/ or = Database Manager
. = .’-;"_|r<='24 )

3130 > =3 instrument name > ' Plate CT—— Plate Manager
Manager. S FroToT AAGET

Iiﬁr‘\ﬂodule Manager

= CllRun Hiztory

2. Click  new.. | to open the New Plate dialog

box.
3. Complete the New Plate dialog box: IINew Plate Dialog x|
a. Enter a name for the plate. Neme: [spectral 2 Fun - 3a
. . . Description:
b. Optional: Enter a description for the plate
record. -—— 3b

c. In the Application drop-down list, select

S t l C l'b t' Application: ISpedraI Calibration L!__ 3C
ectral Calibration.
p Plate Type: IQB-WeII ;I 3d
d. In the Plate Type drop-down list, select 96- R o 36
Well or 384-Well
Operator Mame: Ibap IS 3f
e. Enter a name for the owner.
f. Enter a name for the operator. — 39
g. Click ok |. ok | cancel |
4. In the Spectral Calibration Plate Editor dialog 4a 4b 4c
box:
a. In the Sample Name column, enter a sample [Spectral Calibshtion PlateEditor | ||
name, then click the next cell. The value re
100 automatically displays in the Priority Fiat Name: [Spocticl_if2 Opercter. 1
COlumn. Platy| Sealing:  |Septs 'I DenEr: bagp
b. Optional: In the Comments COlumn, enter il Sam.ple Matne Comment Pricrity | Instrument Protocol 1
o K A0 | I_BigDye3_MS 100 - |
any additional comments or notations for ol
the sample at the corresponding position of oot e
{wn)) Eciit
the plate. ED1 G5_22cm_POP4
Spectral_Z_50
c. Inthe Instrument Protocol 1 column, select -
a protocol from the list or create a new Hnt

protocol (see step 2 on page 35)

5. Highlight the entire row.
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B

6. Select Edit > Fill Down Special.

Fill Cocwary Chrl+D

Based on your plate type (96- or 384-well) and

. . . Copy Chrl4C
capillary array (16 or 4 capillaries), the software Paste Chriay
automatically fills in the appropriate well Clearrow(s)  Shift+Delete
numbers for a single run. Fill Down Special Alt+D

Add Sample Run Alt+A

7. Click _ok_|.

You have successfully created the plate record
for the spectral calibration plate.
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Performing a Spectral Calibration
P

Placing the Plate Assembly into the
Instrument

1. Verify the oven and front doors are closed.

2. Press the Tray button and wait for the
autosampler to stop at the forward position.

3. Open the front doors.

4. Place the plate assembly on the autosampler in
position A or B for the 3130x/ genetic analyzer
and position B for the 3130 genetic analyzer.

Note: There is only one orientation for the plate,
with the notched end of the plate base away
from you.

3130 genetic analyzer

5. Ensure the plate assembly fits flat in the
autosampler. Failure to do so may allow the
capillary tips to lift the plate assembly off of the
autosampler.

6. Close the instrument doors.

Note: Closing the doors returns the autosampler
to the home position, placing the tips of the
capillaries in buffer.
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Running the Spectral Calibration Plate

1. In the tree pane of the Data Collection software,

2.

40

click & GA Instruments > | ga3130x/ or
3130 > &P instrument name > "# Run
Scheduler > = Plate View.

Search for your plate record. There are two
options:
» Select Barcode in the Type of Search drop-
down list.

— In the Scan or Type Plate ID text box,
type in the plate name and click Search
to find the plate.

— Or if you have a limited number of plates
in the database, click _ Fndan_|.

All plates in the database display in plate
record section.

* Perform an advanced search by selecting
Advanced in the Type of Search drop-down
list.

— Use the drop-down list to define search
conditions for a category or multiple
categories (Run Name, Results Group
Name, Plate Name, etc.)

Note: Your entry for Plate Name will also
be set as the Plate ID.

— For each category with a condition
selected, type a value (primary search
string) in the Value 1 column.

— Click | searcn|. All plates in the database
that match the search criteria display in
the plate record section.

= CllRun Hiztory
EHEPT wiewver
Event Log
@y Instrumert Protocal
Bl <patial Calibration ‘iewsr
aCapillary Wiewver
ECap.l’Array Wiewver
ﬂSpedral Calibration Wiewer
ﬁEIReextradion
= CHiDey
= ﬂlns{rumem Status
EHEPT Chart
Event Log
ESpaﬁal Run Scheduler
= EHIRun Scheduler
B Run Wisw
aCapillaries Wiewver

anager Find Plates Matching These Criteria

lahager Type of Search.  |Barcode ™

ol Manager

= Manager Scan or Type Plate D

story

srument Status .

yatial Run Scheduler Search | | Find Al ’

in Schedule
E Pla
BlRun view

Plate Matre Application Status

L N td_S0cm  Sequencir pending
ipillaries Viewet -
Wnitrray Viewer Seq_Flate SequencingAnalysis  pending
ectral Wiewwer Spectral_Z_Run  Spectral Calibration processed
anual Cortrol rmy_plate Spectral Calibration pending
wvice Log Seq SequencingAnalysis — pending-no samples defined

4
M GAInstruments » ga3130 = iDev » Run Scheduler = Plate Yiew

Finel Plates ototios Tence Criteria

Condition Walue 1 “alue 2
Run Name ]
Result Group Mame I:I
Plate IO
Plate Natne:
Type
Size
Stetin

4 | Bl

Seatch [ &ppend Resutts
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Performing a Spectral Calibration
_J

3. Link the plate.

2ppiication Status

3a

a. Select the plate record you want to run. Seqpam  Sesencramans  endng

Spectral_Z_Run  Spectral Calibration processed 3b
my_plate Spectral Calibration pending

b- Click the plate pOSition indicator that seq SeqguencingAnalysis  pending-no samples defined
matches the plate you want linked.

The plate map color will change from
yellow to green when it is successfully
linked.

Note: The 3130 genetic analyzer has only
one plate position (Bay B) to link a plate
record.

4. In the toolbar of the Data Collection software :
window, click ~ » | to begin the run. |® H = + U |

5. The Processing Plates dialog box opens. Click x|
oK.
@ ¥ou are about bo skark processing plates, .

Note: The instrument may pause before running i
the plate to raise the oven temperature. | cancel |

Spectral Calibration Approximate Run

Times
Capillz?r(n I).ength Run Type Rar(nn;:i:)ime Approﬁir:]aet((en;l;cr)‘t)al Run

22 Spec22_POP4 3 21

36 | Spec36_POP4 10 35

| SpecSQ36_POP4 10 48

Spec36_POP6 10 54

Spec36_POP7 5 30

50 Spec50_POP4 7.5 110
Spec50_POP6 10 95

" Spec50_POP7 7.5 52

80 | Spec80_POP4 10 140
Spec80_POP7 10 120
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Viewing the Pass/Fail Status After the Run

After the spectral calibration run, the pass or fail
status of each capillary is recorded in the Event Log
section of the Instrument Status window.

1. In the tree pane of the Data Collection software, Eptats Managsr

&y pratacal harager

click £ GA Instruments > 7| ga3130x/ or Uattoctule Manager

+- Cll Run History

ga3130 > @ instrument name > = Gibey

= instrument Status

=9 Instrument Status > E] Event Log. EAEPT Chart

Bl < atisl Fun Schedu
=+ B Fun Scheduler
= Capillaries Wiewneer

. . H| Coppinrray wieweer
2. In the Event Messages section of the window, Wi Viewer
. . hanual Cantrol
view the status of each capillary. Eservice Log

Note: The window below shows the dye set G5
status results.

Cap # Pass/fail status Q-value Condition Number
Event Messages
Type Date Tirre Publisher Crescriptic|n
LELT ) [n] LRI N R ) [ N e | ey FIa e =S aviy S e Al AT AT Watd
@ info 07myin: 15:41:30 iDew Saving spectral calibratign data ‘%
) Info 07wz 14:41:30 iDrew Capillant 16 successfulbl calibrated : g=0.9&8 c=9.1]2
) Info 07wz 14:41:30 iDrew Capillary 14 successfully calibrated . g=0.986 c=9.14
@ Info OFavimns 15:41:30 Run completed
@ Info OFavFins 15:41:30 iDey Capillary 14 successfully calibrated @ g=0.986 c¢=59.01
@ Info OFavFins 15:41:30 iDey Capillary 13 successfully calibrated © g=0.988 ©¢=8.99
@ Info OFavFins 15:41:29 iDey Capillary 12 successfully calibrated © 9=0.989 c=8.87
Each capillary should have a Q-value above 0.95 A bl
) : cceptable
and a Condition number range shown in the e
g Dye Set Condition Q-Value
table. Number Range

Note: If the entire spectral calibration failed, see Sequencing Analysis _ 0.95

the Applied Biosystems 3130/3130xl Genetic Z_BigDyeV3 3to5
Analyzers Maintenance, Troubleshooting and

. . E_BigDyeV1
Reference Guide for troubleshooting —guye
information. Fragment Analysis
D 4108.5
6to12
E5 25t04
G5 8.5t014.5
Any 4- or 5-Dye 11020 .~ 0.80
set
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Evaluating the Spectral Calibration Data

IMPORTANT! Evaluate the spectral calibration profile
for each capillary, even if the Spectral Calibration
Results box indicates that they passed.

Note: Pages 49 to 50 for examples of passing
sequencing spectral calibration profiles. See pages 51
to 52 for examples of passing fragment analysis
spectral calibration profiles.

Evaluating the Spectral Profile and Raw
Data

1. In the tree pane of the Data Collection software,
click & GA Instruments > ] ga3130x/ or
ga3130 > P instrument name > [l Spectral
Viewer.

. Foundation Data Collection Version 3.0

o User is logged in
File “iew Service Tooks

) S

Wizards  Help

=] '_GA Instruments
m Results Group M
= Databaze Manager
= Elgaatam
] Plate Manager
% Protocol Manager
E Mocule Manager
= CllRun History
EHERT “iewer
Event Log
By Instrument Protocol
ESpaﬂal Calibration Viewer
ﬂCapiHary Wienver

GA Instruments = ga3130:1 = 1584-007 = Spectral Viewer

160
Intensity vs Pixel Number

BB capiarray wiewer
ﬂSpedra\ Calibration Yiewe
ﬁElRee)dract\un
= EP1584-007
= [Enstrument Status
LEPT Chart
Evam Log
| pstisl Run Scheculer
= MIRun Scheduler
R pizte View
T Run iew
ﬂCapiHanes Vigwver

2000

G000
Intensity vs Scan Number

!Cﬁ IArPEY Yiewer Capillary Datac Mon Oct 11 21:02:58 PDT 2004

to verify the
spectral profile

and raw data
H12

T Foundation Dal

IMdanual Control [l
‘=]service Log Dye Set
Matrix used for Capillary 1 1
Plate diagram Condition: 7946425
Click each cell @ alue: 0.997972
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| Mon Oct 11 21:02:58 PDT 2004

List of Calibrations for Dye Set F

Mon Oct 11 21:02.58 POT 2004

Renarme

%) s1LPm

E—

— Spectral

profile

Raw data
(matrix
standards)

View, rename,
or set the

active

spectral
calibration for
the selected
dye set
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2. In the Dye Set drop-down list, select the dye set
you just created.

Chapter 3 Performing a Spectral Calibration
Evaluating the Spectral Calibration Data

Note: If the spectral calibration failed (no
spectral profiles are created), see the Applied
Biosystems 3130/3130xl Genetic Analyzers
Maintenance, Troubleshooting and Reference
Guide for more information.

3. In the plate diagram, select a well on the plate
diagram to view the capillary spectral results.

Note: A failing capillary is automatically
assigned the spectral profile of its nearest passing
capillary.

4. Evaluate the spectral profile and raw data for the
selected capillary:

a. Verify that the order of the peaks in the
spectral profile from left to right are:
— 4-dye: blue-green-yellow-red
— 5-dye: blue-green-yellow-red-orange

Do the peaks in
the profile appear
in the correct
order?

Then

Yes Go to step b.

No The calibration run
has failed. See the
Applied
Biosystems
3130/3130x!
Genetic Analyzers
Maintenance,
Troubleshooting,
and Reference
Guide.

A1

. = =
Drye Set: | Z-Biglye''3 Active Ct

Matrix uzed for Capillary 10: 9 Wyed Jur
Condition: 3Ea2025
@ Value: 0976264 List of Ce

Wed Jur
Cwverride Spectral
Rena
Save

H12

Well A1

v

Capillary status: e —

BPassed (dark green)
E]LPassed well elected (light green)

I:]LFaiIed (tan)

—Failed well selected (light tan)

H12

Blue Green Yellow Red

a0 100 150 200
Intensity vs Pixel Number

Example of a 4-dye spectral profile

Blue Green Yellow Red Orange

50 " RS 200
Intensity vs Pixel Mumber

Example of a 5-dye spectral calibration profile
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Evaluating the Spectral Calibration Data

b. Verify that the order of the peaks in the raw Red Yellow
data profile from left to right are:

Blue Green

Sequencing

— 4-dye: red-yellow-blue-green
Fragment Analysis

— 4-dye: red-yellow-green-blue

— 5-dye: orange-red-yellow-green-blue 2000 4000 BO0D 8000
Intensity ws Scan kumber
Are peaks in the Example of a 4-dye sequencing raw data profile
wrong order or
extraneous Then
peaks adversely Orange Red Yellow Green Blue
affecting the
spectral profile?
Yes The calibration run
has failed. See the
Applied
Biosystems
3130/3130x!
Genetic Analyzers 800 1000 1200 1400 1600 1800 2000 2200 2400 2600 2
Maintenance, Intensity vs Scan Mumber
Troubleshooting, Example of a 5-dye fragment analysis raw data profile
and Reference
Guide.
No Go to step c.
c. Verify that the peaks in the spectral profile Peaks are distinct, regular and in the proper order — pass

do not contain gross overlaps, dips, or other
irregularities (see “Magnifying the Spectral
Profile or Raw Data” on page 46).

Are the peaks
separate and Then
distinct?

Yes The capillary has -
passed. Go to 1 4 § T 3 11 13 1§ 17 19
step 5. Spectral Bin Number

No The calibration run
has failed. See the
Applied
Biosystems
3130/3130x!
Genetic Analyzers
Maintenance,
Troubleshooting,
and Reference
Guide.

Red peak is not distinct, regular or in the proper order — fail

o 5 7 1 1 13 15 17 19
Spectral Bin Humber
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Chapter 3 Performing a Spectral Calibration
Evaluating the Spectral Calibration Data

5. Repeat steps 3 and 4 for each capillary in the

6.

46

4.

array.

Optional: Rename the spectral run. The spectral

file default name is the day, date, and time of the

run.

a. Click FRename .

b. In the Rename Calibration dialog box, enter
a descriptive name for the spectral
calibration including the dye set, array

Drvye Set: Z-BinDye'3 ™
e Eetld Active Calibration for Dye Set. Z-BigDyev'3
Matrix uzed for Capillary 10: 9 |Wed Jun 04 14:28:16 PDT 2003
Condition: 3Ea2025
@ Walue: 0976264 List of Calibrations for Dye Set: Z-BigDyey'3

fitfed Jun D4 14:28:15 PDT 2003 =l
Cwverride Spectral
Save

. Rename Calibration

Il Mlame:

length and polymer type (optional).

c. Click ok |.

In the tree pane of the Data Collection
software, click

A GA Instruments > | ga3130x/ or
ga3130 > _J instrument

name > [I@ Spectral Viewer.

. In the spectral profile or raw data display,

click-drag the cursor to create a box
around the area of interest.

. Release the mouse button.

The Data Collection software displays the
selected region.

Press r to reset the view.

Magnifying the Spectral Profile or Raw Data
1.

200
Afensity vs Pixel Mumber

Selecting an area to magnify in a spectral profile

100

Inftansity vs Pixel Mumber
)

Magnified area of that spectral profile
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Activating a Spectral Calibration

Activating a Spectral Calibration

Setting an Active
Spectral
Calibration

IMPORTANT! A run cannot start unless a calibration file that matches the dye set and
capillary array length combination to be used for the run, is active.

IMPORTANT! While the software does not force you to recalibrate spectrally after
changing polymer types, it is strongly recommended that you perform a spectral
calibration after a polymer type change.

IMPORTANT! Whenever you install or replace an array or switch dye sets, you must
either set the active spectral calibration for that dye set and array length combination or
perform a new spectral calibration and then activate it.

IMPORTANT! Every new spectral calibration is automatically the active one for that dye
set.

You may activate a previously created spectral calibration for a run as long as the
calibration matches the dye set and array length combination (and, for fragment analysis,
the polymer type) that you wish to use. Use an active spectral calibration for:

* Sequencing analysis applications that require a separate spectral calibration (for the
same dye set) for different capillary array lengths and polymer type

» Fragment analysis applications that require a separate spectral calibration (for the
same dye set) for different capillary array lengths and polymer type

* Repeat spectral calibrations where the original calibration is better than the second
one

1. In the tree pane of the Data Collection software, click
A GA Instruments > £°| ga3130x/ or ga3130 > O instrument
name > @ Spectral Viewer.

IMPORTANT! If the Spectral Viewer window is blank and deactivated, then either:
—The spectral calibration for that dye set is not in the database

or,

—You changed the array length and you do not have a spectral calibration file
activated for that dye set and array length combination.

2. In the Dye Set drop-down list, select a dye set.
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77 Chapter 3 Performing a Spectral Calibration

/ Activating a Spectral Calibration

DEERE IZ'EHQDYEVS | Active Calioration for €
Matrix uzed for Capillary 10: 9 W
Condition: 3Ea2025

In the List of Calibrations for Dye Set drop-down
list, select the spectral calibration you want to
use. The spectral profile and raw data is
displayed.

If the spectral calibration is acceptable, then click

Set | Otherwise, run a new spectral calibration.

Applied Biosystems 3130/3130x/ Genetic Analyzers Getting Started Guide
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Examples of Passing Sequencing Spectral Calibrations

Examples of Passing Sequencing Spectral Calibrations

Dye Set Z Created
from Matrix
Standard
50 100 150 200 250 300
Intensity vs Pixel Mumber
3000 4000
Intensity vs Scan Mumhber
Dye Set Z Created
from a
Sequencing
Standard
50 100 150 200 250 300
Intensity vs Pixel Mumber
|
oA M
6000
Intensity vs Scan Mumhber
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Examples of Passing Sequencing Spectral Calibrations
v

Dye Set E Created
from Matrix
Standard Set
DS-01

50 100 150 200 250 300
Intensity vs Pixel Mumber

3000 4000
Intensity vs Scan Mumhber

Dye Set E Created
from a
Sequencing
Standard

50 100 150 200 250 300
Intensity vs Pixel Mumber

i \Y.'M,l_.,\ l H (AN

0 1000 2000 3000 4000 5000 6000 7000
Intensity vs Scan Mumhber
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Examples of Passing Fragment Analysis Spectral Calibrations

Examples of Passing Fragment Analysis Spectral

Calibrations
Dye Set G5
Created from
Matrix Standard
Set DS-33
1480
Intensity vs Pixel Mumber
3000 4000
Intensity vs Scan Mumhber
Dye Set F Created
from Matrix
Standard Set
DS-32

160
Intensity vs Pixel Mumber

3000 4000
Intensity vs Scan Mumhber
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Examples of Passing Fragment Analysis Spectral Calibrations
v

Dye Set D
Created from
Matrix Standard
Set DS-30

160
Intensity vs Pixel Mumber

0 1000 2000 3000 4000 5000 6000 7000
Intensity vs Scan Mumhber

Dye Set E5
Created from
Matrix Standard
Set DS-02

50 ' 100 150 200 250 300
Intensity vs Pixel Mumber

1000 2000 3000 4000 5000 6000 7000
Intensity vs Scan Mumhber
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Notes

Preparing the
E=—- Instrument

| |

)

Performing a
Spatial Calibration

A

N
Emwisswisy Performing a
HA—/=1 Spectral Calibration

Autoanalysis and

!

}

Autoanalysis

~ | and Sequencing
Analysis

—! Software

Create protocols
for automated
sequencing analysis

|

Autoanalysis
and
SeqgScape Software

Create a
Sequencing Analysis
Plate Record

!

i Autoanalysis
% and
E | Fragment Analysis

|

Running the
Instrument

See page 59

See page 77

Sequencing Analysis Software
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Sequencing Analysis Software

Sequencing Analysis Software

Autoanalysis

Manual Analysis

54

File-Naming
Convention

See the Applied Biosystems DNA Sequencing Analysis Software v5.1 User Guide
(P/N 4346366) for details on sequencing analysis or the Sequencing Analysis
Software v5.2 User Bulletin titled New Features (P/N 4358355) for an update on
Sequencing Analysis Software v5.2.

Analyze your sequencing samples automatically using autoanalysis or manually.

Perform autoanalysis of sequencing samples using features of the 3130/3130x/ genetic
analyzer Data Collection software and Sequencing Analysis Software v5.2 or higher.

The Sequencing Analysis Software must be installed and registered with the
3130/3130x/ genetic analyzer Data Collection software before you can create files
required for autoanalysis.

Autoanalysis can only be performed on the same computer that collected the sample
files. If you perform autoanalysis on samples, but wish to edit/review results on another
computer, transfer the analysis protocol to the Sequencing Analysis Software database.
To analyze samples on another computer, transfer the files to that location.

If the run is not set up for autoanalysis, see the Applied Biosystems DNA Sequencing
Analysis Software v5.1 User Guide and the Sequencing Analysis Software v5.2 User
Bulletin - New Features.

Some alphanumeric characters are not valid for user names or file names. Do not use the
characters below:
spaces

\ /%2 <>

IMPORTANT! An error message is displayed if you use any of these characters. You
must remove the invalid character to continue.
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About Plate Records and Sequencing Analysis .

About Plate Records and Sequencing Analysis

Overview Plate records are data tables in the instrument database that contain the following
information:
* Plate name, type, and owner
» Position of the sample on the plate (well number)
* Sample Name
* Mobility file (in Analysis Protocol)
* Comments about the plate and about individual samples

* Name of the run module and Dye set information (run modules specify the
conditions to run the samples)

* Name of the Analysis Protocol

Note: A plate record is similar to a sample sheet or an injection list that you may have
used with other ABI PRISM® instruments.

When to Create a Create a plate record for each plate of samples for the following types of runs:

Plate Record Spectral calibrations

* Sequencing Analysis Software
* SeqScape Software analysis
» GeneMapper® software

* Mixed (sequencing and fragment analysis samples - see the Applied Biosystems
3130/3130xl Genetic Analyzers Maintenance, Troubleshooting, and Reference
Guide for creating a mixed plate record)

For runs to begin, you must create a plate record for and link it to a plate loaded on the
instrument. However, you can create plate records for new plates while a run is in
progress.

About a The Plate Editor displays an empty plate record for the application selected in the New
Sequencing Plate dialog box. The data fields within a given plate record vary depending on the
Analysis Plate selected application. This section describes the sequencing analysis plate record’s data
Record fields.

The table below describes required plate editor fields:

Parameters Description See Page
Instrument Protocol Contains the run module and dye set needed to run the 59
instrument.
Analysis Protocol Contains everything needed to analyze sequencing 62
data.
Results Group Defines the file type, the file name, file save locations, 70
analysis software and autoanalysis.
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About Plate Records and Sequencing Analysis

Elements of a Sequencing Analysis Plate Record

Plate Manager

Plate Record

Results Group Instrument Protocol Analysis Protocol
Results Group || Instrument | Analysis Protocol
Name Protocol Name Name

Analysis software || Runtype || Basecaller and
and autoanalysis (Regular) DyeSet/Primer file

|__| File storage | Run module || Bases called
location (pure or mixed)
File and run folder || Dye set || Assigning Quality
name preferences Values (QVs)

Post processing
|| (clear range

trimming)

IMPORTANT! For data collection and autoanalysis to succeed, each run of samples must
have an Instrument Protocol, an Analysis Protocol, and a Results Group assigned within
a plate record.
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A Blank
Sequencing 1 2

Analysis Plate D e E—

Record File  Edit

About Plate Records and Sequencing Analysis

Plaje Marne: ISeq_PIa

3

x|
Operator: Ibap
Crnener: Ibap
Priotity | Results Group 1 Instrurment Protocal 1 Analysis Protocol 1

-

| v

Plaje Sealing: ISepta_‘]
el Sarmple Mame | Comrment
A01
(=10}
co1
(an)]

E01
Fo1
01
HO1
A02
BO2
coz
ooz
4
Description I

Ck | Cancel |

Default is one sample run, to add
additional runs see page 79

Columns inserted in a plate record for a sequencing analysis run

Number and
Column

Description

1. Sample Name

Name of the sample

2. Comment

Comments about the sample (optional)

3. Priority

4. Results Group

A default value of 100 to each sample. Changing the value to a
smaller number increases the priority of that set of 16 or 4 samples to
run before the others in the injection list.

Some options:

e New: Opens the Results Group Editor dialog box

e Edit: Opens the Results Group Editor dialog box for the Results
Group listed in the cell

¢ None: Sets the cell to have no selected Results Group
¢ Select one of the available Results groups from the list

Note: You must have a Results Group selected for each sample
entered in the Sample Name column.

See “Results Group for Sequencing Analysis” on page 70.
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About Plate Records and Sequencing Analysis

Number and

Column Description

5. Instrument e New: Opens the Protocol Editor dialog box.

Protocol  Edit: Opens the Protocol Editor dialog box for the Instrument
Protocol listed in the cell.

¢ None: Sets the cell to have no selected protocol.
e List of Instrument Protocols: In alpha-numeric order.

Note: You must have an Instrument Protocol selected for each
sample entered in the Sample Name column.

See “Instrument Protocol for Sequencing Analysis” on page 59.

6. Analysis Protocol ¢ New: Opens the Analysis Protocol Editor dialog box.

¢ Edit: Opens the Analysis Protocol Editor dialog box for the
Instrument Protocol listed in the cell.

¢ None: Sets the cell to have no selected protocol.
e List of Analysis Protocols: In alpha-numeric order

Note: You must have an Analysis Protocol selected for each sample
entered in the Sample Name column.

See “Analysis Protocol for Sequencing Analysis” on page 62.
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Creating Protocols for Automated Sequencing Analysis

Creating Protocols for Automated Sequencing Analysis

If the appropriate instrument protocol, analysis
protocol, and results group have been created, proceed
to “Filling Out a Sequencing Analysis Plate Record”
on page 77.

Instrument Protocol for Sequencing Analysis

An instrument protocol contains all the settings
necessary to run the instrument: the protocol name,
type of run, run module, and dye set.

A WG el Do not edit the instrument

protocol currently being used, while the instrument is
running.

Creating an Instrument Protocol

1. In the tree pane of the Data Collection software, I Foundation Data Colecton Version 3.0 - _ Adminstator user s logged n
click £ GA Instruments > | ga3130x/ or S
ga3130 > w Protocol Manager. o Ao (P ———————

Instrumert Protocols

Finei Pretocal

Dye Set  Description
S patialFill_pipDD_1 Created with populator
_pepOD_1 Create with populator

_pdpDD_1 31

Create instrument
protocols here

<

Analysis Protocols

er

A" hanusl Cortrol
Bservice Log Find Protocal

1 Bequencnga:aysis

G
SeqStape_AP1 SenStape
3120_SR_POPE_BDTvl_mixed_v2 SeqScape

Create analysis
protocols here
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Creating Protocols for Automated Sequencing Analysis

2. In the Instrument Protocol section, click

[ewy... (nstrument Protocals

Find Protogar |

GA& Instruments =oa 731 30= Protocol Manager

The Protocol Editor opens.

Run Module Dys Set | Descrigtion

30SpatialFill_pdpDD_1 31308 patialFil_1 Created with papulatar
3130SpatialMoFill_pdpDD_1 31305patialMoFill_1 Created with populatar

3. Complete the Protocol Editor:

X

a. Type a name for the protocol. Hare: | —— 3a
b. Type a description for the protocol peserwen

(optional). - 3b

c. Select Regular in the Type drop-down list. oo ST = 4

Run Module:  [Fragment naiysis22_POP_1 =i 3d

DyeSet [es = = T 3e

— 3f

d. Select the correct run module for your run.
See “Sequencing Resolution Performance
and Specifications” on page 3.

Note: To customize a run module, see the
Applied Biosystems 3130/3130xl Genetic

Analyzers Maintenance, Troubleshooting,

and Reference Guide.
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Creating Protocols for Automated Sequencing Analysis .

e. Select the correct Dye Set for your run by
using the table below.

POP-4 POP-6

Polymer Polymer POP-7 Polymer

Chemistry Dye Set

StdSeq50
N| RapidSeq36
StdSeq50
N| UltraSeq36
N| RapidSeq36
FastSeq50
StdSeq50
N LongSeq80

AN
AN

N UltraSeq36
AN

N LongSeq80

AN

BigDye® Terminator v3.1 Cycle Sequencing Kit | Z_BigDye
V3

ABI PRisM® dGTP BigDye® Terminator v3.0
Cycle Sequencing Ready Reaction Kit

AN
AN
AN
AN
AN

BigDye® Terminator v1.1 Cycle Sequencing Kit | E_BigDye | v v v v v

ABI PRIsM® dGTP BigDye® Terminator Cycle Vi — — — — — — — — — —
Sequencing Kit*

ABI PRismM® dRhodamine Dye Terminator v v v v v - - - - -
Cycle Sequencing Ready Reaction Kit

ABI Prism® BigDye® Primer Cycle Sequencing - - - v v - - - - -

Kits

*dGTP kits are not supported on capillary electrophoresis instruments due to compressions on certain sequence context regions; you can
run the kits if you do not care about the compression issues.

f. Click ok

Importing an Instrument Protocol

1. Click jpport  in the Instrument Protocols pane T————
of the Protocol Editor window to display the
standard File Import dialog box.

Find

Mame Run hMaodule Dye Set
2. Navigate to the location of the .xml file you want
to import.
3. Select the .xml file and click Open.
e, Edit... | Delete  ( Import ’ Export |

Exporting an Instrument Protocol

1. In the Instrument Protocols pane, highlight the
protocol you want to export.

2. Click Export  to display the standard File
Export dialog box.

3. Browse to the desired folder location.

4. Click =awe
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Analysis Protocol for Sequencing Analysis

An analysis protocol contains all the settings
necessary for analysis and post processing:

* Protocol name — The name, description of the
analysis protocol, and the sequence file formats
to be used

* Basecalling settings — The basecaller,
DyeSet/Primer file, and analysis stop point to be
used

* Mixed Bases (Optional) — When two bases are
found at the same position. Define the percent
value of the second highest to the highest peak

* Clear Range — The high quality sequence
remaining after trimming low quality sequences
typically found at the beginning and ends of the
sequence. The clear range can be based on base
positions, sample quality values, and/or number
of ambiguities (Ns) present

Note: If you created an appropriate analysis protocol
in the Sequencing Analysis software, you can use it in
Data Collection software.

IMPORTANT! Do not delete an analysis protocol
during a run while it is being used for that run.
Autoanalysis will not be performed if you do so.

GA Instruments =ga3130= Protocol Manager

Instrument Protocals

Find Protocol

Marme Rur Module DyeSet  Description

3130SpatialFill_pdpDD_1 31305 patialFill_1 Created with populator

Creating an Analysis Protocol 3130SpatialboFill_pdpDD_1  3130SpatialboFill_1 Created with populator

See the Applied Biosystems DNA Sequencing Analysis
Software v5.2 User Guide (P/N 4346366) for more

information on analysis protocols. ¢
(vew ] [a ] [ooee ] (oot | [ oo
1. In the Analysis Protocol section of the Protocol pere—
Manager, click = new.. . i Prctacl
If more than one analysis application is installed e
on the data collection computer, the Analysis SeqScans_AP1 T Sesseme

3130_SR_POPE_BDTw _mixed_v2 SegScape

Applications dialog box opens.

Note: When you name your analysis protocol,
assign a version name to help you distinguish :

your analysis protocols. v
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2. Select Sequencing Analysis, then click ok |
to open the Analysis Protocol Editor dialog box.

3. In the General tab:

a. Enter a unique name and description for the
new protocol.

b. Select the appropriate Sequence File
formats settings.

Analysis Protocol for Sequencing Analysis

Analysis Applications ﬂ

Select a registered analysis application:

Segs
SeguencingAnalysis

Cancel |'

Option Creates...
Write .Seq File | A .seq file for printing the
check box sequence as text file or for
use in other software.
e Use ABI format with
Applied Biosystems
software.
e Use FASTA format with
other software.
Write Standard | A .scf file to use with other
Chromatogram | software. When created,
Format file the .scf extension is not
(.scf) appended to the file name.
Write Phred A .phd.1 file to use with
(.phd.1) File other software if you used
the KB™ basecaller.

Sequence Analysis Protocol Editor

General | Basecaling | Mixed Bases | Clear Range

Analysis Protocol Description

Mlarie: ‘

Description:

Sequence File Formats
Wirite S File
Wite Clear Range in .Seq File
File Format for .Seq file
(=) 2B
() FASTA
D Witite Statdard Chromatogram Format [ sct)

‘bite: Phiredd  phid 1) File

3b

L OK ” Cancel

Notes
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Analysis Protocol for Sequencing Analysis

4. Select the Basecalling tab. e T e ®
a. See “3130/3130x1 Genetic Analyzer e e e e vl Do
Basecaller and DyeSet/Primer Files” on @ hrenam —]
page 66 to select your basecaller and — 3 || o} b e bases
DyeSet primer file. ot sPriner o "

kB _3130_POPE_EDTw3 Mok
KB a
IKE_3130_POPE_EDTw1 oy

Note: Sequencing Analysis Software and

3130/3130x! genetic analyzer Data b oo b o e
Collection software filter .mob file choices oo o s <o Basaoals wit 3 <
to match the chosen .bcp file.

|: After Bases

Quality Threshold —_

@ Do not assigh N's to Basecalls

Ok [ Cancel
b. In the Processed data pane, select True or
Flat Profile.
Option Used to display data as processed traces scaled...

Uniformly - the average height of peaks in the region of strongest signal is about
" True Profile equal to a fixed value. The profile of the processed traces will be very similar to
that of the raw traces.

Semi-locally - the average height of peaks in any region is about equal to a fixed
%" Flat Profile value. The profile of the processed traces will be flat on an intermediate scale (>
about 40 bases).

Note: This option is applied to data that is analyzed with the KB™ basecaller
only. If you use the ABI basecaller, the profile option reverts to True Profile.

c. If desired, select one or more stop points for
data analysis.

d. Select your Threshold Quality option.

Option Function

With the KB™ basecaller, use this setting to assign a base to every
% Call all bazes and assign QY position, as well as the QV.

_ _ With the KB basecaller, use this setting to assign Ns to base with
[+ Assign N for bases with GV < I1 5 QVs less than the set point. The QV is still displayed.
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5. Select the Mixed Bases tab.

Note: This function is active with the KB
Basecaller only.

a. For mixed bases only, select Use Mixed
Base Identification.

b. Use the default setting of 25% or change the
detection level by entering a new value or
dragging the % line up or down.

Note: Do not use less than 15% as your
detection limit.

6. Select the Clear Range tab.

Note: The clear range is the region of sequence
that remains after excluding the low-quality or
error prone sequence at both the 5" and 3” ends.

Select one or more Clear Range methods. If you
apply multiple methods, the smallest clear range
results.

7. Click _ok_| to save the protocol and close the
Sequence Analysis Protocol Editor dialog box.

Analysis Protocol for Sequencing Analysis

Sequence Analysis Protocol Editor |

Generall Basecaling Mixed Bases | Clear Rangel
Mixed Bases Settings
[ Use Mixed Base Idertification 5a

CallIUE if 2nd highest peak:
iz== |25 % ofthe highest peak 5b

Sequence Analysis Protocol Editor

Generall Basecal\ingl Mixed Bases Clear Range I

Clear Range Methods

Use with ABl and——————— 1 Use diear range minimum and masimum
KB Basecallers Firet Bage == |20 & End Bese 550
€ Basestotrmfrom 3end| |20

Use with ¥ Use qualtty valuss
KB Basecaller

Remave bases from the ends until

tewer than |4 basesoutol |20 have @Vs less than IZU

Use with ABland———
KB Basecallers

I Use identification of N calls FRemove bases from the ends

uritil there are fesyer than [4 Msoutof |20 hases

Muttiple clear range methods are spplied in order.

Srmallest clear range is the result.
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3130/3130xI Genetic Analyzer Basecaller and DyeSet/Primer Files

Basecaller and DyeSet/Primer Files Used with BigDye® Terminator Chemistry and KB Basecalling

DNA Sequencing KB Basecalling Run

Chemistry Polymer Module DyeSet/Primer Basecaller
BigDye® Terminator v1.1 POP-4™ UltraSeq36_POP4 KB_3130_POP4_BDTv1.mob KB.bcp
Cycle Sequencing Kit StdSeq50_POP4

LongSeq80_POP4

POP-6™ RapidSeq36_POP6 KB_3130_POP6_BDTv1.mob
StdSeq50_POP6

POP-7™ UltraSeq36_POP7 KB_3130_POP7_BDTv1.mob

RapidSeq36_POP7
FastSeq50_POP7
StdSeq50_POP7
LongSeq80_POP7
BigDye® Terminator v3.1 POP-4 UltraSeq36_POP4 KB_3130_POP4_BDTv3_.mob
Cycle Sequencing Kit StdSeq50_POP4

LongSeq80_POP4

POP-6 RapidSeq36_POP6 KB_3130_POP6_BDTv3.mob
StdSeq50_POP6
POP-7 UltraSeq36_POP7 KB_3130_POP7_BDTv3.mob

RapidSeq36_POP7
FastSeq50_POP7
StdSeq50_POP7
LongSeq80_POP7

Basecaller and DyeSet/Primer Files Used with BigDye® Terminator Chemistry and ABI Basecalling

DNA ABI Basecalling Run
Sequencing Polymer Module Basecaller DyeSet/Primer
Chemistry
BigDye® POP-4™ UltraSeq36_POP4 Basecaller- DT3130POP4LR{BD}v1.
Terminator v1.1 3130POP4UR.bcp mob
Kit
! LongSeq80_POP4 Basecaller-
3130POP4_80cmv3.bcp
POP-6™ RapidSeq36_POP6 Basecaller- DT3130POP6{BD}v2.mob
3130POP6RRv2.bcp
StdSeg50_POP6 Basecaller-
3130POP6SR.bcp
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Basecaller and DyeSet/Primer Files Used with BigDye® Terminator Chemistry and ABI Basecalling (continued)

BigDye POP-4 UltraSeq36_POP4 Basecaller- DT3130POP4{BDv3}vi.m
Terminator v3.1 3130POP4UR.bcp ob
Cycle
. . LongSeq80_POP4 Basecaller-
Sequencing Kit 3130POP4_80cmv3.bcp
POP-6 RapidSeq36_POP6 Basecaller- DT3130POP6{BDv3}vi.m
3130POP6RRv2.bcp ob
StdSeg50_POP6 Basecaller-
3130POP6SRv2.bcp
ABI Prism® POP-4 UltraSeq36_POP4 Basecaller- DT3130POP4{dRhod}v2.
dRhodamine 3130APOP4UR.bcp mob
gzigermmator LongSeq80_POP4 Basecaller-
Sequencing 3130POP4_80cmv3.bcp
Ready Reaction POP-6 RapidSeq36_POP6 Basecaller- DT3130POP6{dRhod}v2.
Kit 3130POP6RRv2.bcp mob
StdSeg50_POP6 Basecaller-
3130POP6SR.bcp
Dye Primer Chemistry
Basecaller and DyeSet/Primer Files Used for Dye Primer Chemistry
DNA .
Sequencing Polymer ABI Baai%ad::ig Run Basecaller DyeSet/Primer
Chemistry
ABI PRisM® POP-6 RapidSeq36_POP6 Basecaller- DP3130POP6{BD
BigDye® Primer 3130POP6RRv2.bcp -21M13}v1.mob
gé,c'jencin it StdSeq50_POP6 Basecaller- DP3130POP6{BD
q 9 3130POP6SR.bcp -21M13Rev}v1.mob
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Analysis Protocol for Sequencing Analysis

Editing and Deleting Analysis Protocols

Editing an Analysis Protocol

1. In the Analysis Protocols pane in the Analysis
Protocol Manager, highlight the protocol you
want to edit.

2. Click Edt....

3. Make changes in the General, Basecalling,
Mixed Bases and Clear Range tabs, if
appropriate.

4. Click ok | to save the protocol and close the
Analysis Protocol Editor dialog box.

Deleting an Analysis Protocol

IMPORTANT! Do not delete an analysis protocol
during a run while it is being used for that run.
Autoanalysis will not be performed if you do so. You
must first delete any plate records using the analysis
protocol before you can delete or modify the
analysis protocol for these plate records.

1. In the Analysis Protocols pane in the Analysis
Protocol Manager, highlight the protocol you
want to delete.

2. Click Delete to display the Deletion
Confirmation dialog box.

3. Click ‘es |

Analysis Protocols

Finef Protocal

Application

U ———
3130POPT_BDTv3-KE-Denova_v5.2  SequencingAnalysis

£

wew. |([ Eat. | ) oeete | [ mpot.. | [ Expor

Analysis Protocols

Find Protacal

Application

SequencingAnalysis

b —
3130POP7_BDTy3-K3-Denovo_v5.2

<

wew. | [ Ect [ oeete ) [ mport. | [ Export
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Exporting an Analysis Protocol

1. In the Analysis Protocols pane in the Analysis
Protocol Manager, highlight the protocol you
want to export.

2. Click Export to display the standard File
Export dialog box.

3. Browse to the desired folder location.

4. Click Save.

Importing an Analysis Protocol

1. Click |mpaort  to display the standard File
Import dialog box.

2. Browse for the .xml file to import and click
Open.

Note: For multiple applications, select the
appropriate application to associate with the
analysis protocol.

Analysis Protocol for Sequencing Analysis

Analysis Protocols

Find Protacal

Application

SequencingAnalysis

e
3130POP7_BDTv3-KB-Denova_v5.2
=

<

wew. | [ Eot. | [ peete | [ impon ]@

Analysis Protocols

Findl Protocol

MName Application

3130P0OP7_BDT¥3-KB-Denovo_v5.2  SeguencingAnalysis

¢

Mew. | [ edt. | [ peete ([ rmport. | |) Ewpert
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Results Group for Sequencing Analysis

A Results Group is a component within Data
Collection that organizes samples and certain user
settings under a single name. It is called a Results
Group because it is used to name, sort, and deliver
samples that result from a run.

Creating a Results Group

1. In the tree pane of the Data Collection software,
click £ GA Instruments > @ Results Group.

2. Click New.. to display the Results Group Editor
window.

GA Instruments = Results Group

Find Results Group

Marme Crwvner | Comment
Default_Results_Group
Gh_Results_Group

MJD_Results_Group

4

@ Edlit... | Delete | Duplicate | Impart... | Export... |

3. Complete the General tab: e T—

a. Type a unique Results Group Name. The Goretil lg:nivs el b sl bl AN
name can be used in grouping sample files.

b. Type a Results Group Owner (optional).
The owner name can be used in naming and

SOftlng Sample ﬁles' Results Group MNarme: SequencingAnalysis_Results_Group _ 3a

. Results Group Owher: SPT
c. Type a Results Group Comment (optional). Resulls Graup Comment. Sacand in series 3b
— 3¢
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Results Group for Sequencing Analysis

4. Select the Analysis tab, then: [ ——

General| #halysis | Destination| Maming

a. Select Sequencing Analysis from the
Analysis Type drop-down list.

b. In the Analysis Actions section, select Do A
Autoanalysis, if you want your data Sequencinganalysis — 4a
automatically analyzed after a run. T

Password

Analysis Actions I 4b

Do Autoanalysis

Note: Login ID and password are not
required for Sequencing Analysis software.

5. Select the Destination tab, then use the default
destination or define a new location for data General | Analysis Desgaﬂonl Naring |
storage.

To use ... Then ...

default location* Sk|p to Step 6. [~ Use Custom Location

Root Destination: |E:\AppliedBiosystemswdcidatacollectiontData
custom location complete steps a-b. Note: the: final destination folder is Root Destination + Run Folder Name Setting

ba

— 1
|

5b

a. Click Use Custom Location, then click —
Browse.. to navigate to a different save
location.

b. Click ' Test | to test the Location path

name connection: ok Cancel

Then a message box

Ifit... displays ...

Passes Test succeeded:
<“path”>.

Fails Test failed:<“path”>.

*Sample File Destinations
Locations where sample files are placed during extraction:

¢ Default Destination, default folder naming: E:\\AppliedBiosystemsUDC\DataCollection\data\<instrument type>\
<instrument name>\run folder

e Default Destination, custom folder naming: E:\\AppliedBiosystemsUDC\DataCollection\data\top custom folder\
subfolders, etc.

e Custom Destination, default folder naming: Destination\<instrument type>\<instrument name>\run folder
e Custom Destination, custom folder naming: Destination\top customer folder\subfolders, etc.
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Results Group for Sequencing Analysis

6. Select the Naming tab.

Use the Naming tab to customize sample file and
run folder names. You have two options:

¢ Use the default names for the folder and
sample file.

* Use custom names for the folder and sample
file. See “Optional: Completing Sample File
Name Format Pane” on page 73 for
elements of the Naming tab.

Note: Sample name, run folder name, and path
name, combined, can total no more than 250
characters.

E‘%Results Group Editor

Generall Analysisl Destination

—Sample File Mame Format

Example:

Prefix |

Mame Delimiter I_ 'l

Format
’7|<n0ne>

|

Suffix:

File Extension =Mone=

~Run Folder Mame Format
Example:

Prefix |

Mame Delimiter I_ 'l

Format
’7|<n0ne>

Cancel |

Sample
File Name
Format pane

Run Folder
Name
Format pane
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Optional: Completing Sample File Name
Format Pane

Note: The default sample file naming for sequencing

analysis is:
seq_<capillary number>_<wellposition>.ab1

1. Select the Naming tab.

2. Type a prefix for the file name in the Prefix box.

Your entry is shown in the Example line.

3. Select the symbol that separates the Format
elements in the file name from the Name
Delimiter drop-down list. Only one delimiter
symbol may be chosen.

4. Click the Format list and then select the
components that you want in the sample name.

Note: All the samples from a single run can be
placed in the same run or results folder, so the
name of every sample from a single run should
be different. Most of the Format options are not
different between samples, so select at least one
of the options that make the sample names
unique within a run.

Results Group for Sequencing Analysis

E‘%Results Group Editor

Generall Analysisl Destinatio
—Sample File Mame Format:

Example:

Prefix |

Mame Delimiter I_ 'l
Format
’7|<n0ne> =

Suffix |

File Extension =Mone=

“Zample File Mame Format

Example: WD _ &bl

Prefis: MJD

General | Analysis| Destination| Maming
~Sample File Mame Format

Example: MDJ_2002-04-21_007_mMr.Holmes. =ext=
vthran 26 characters

Prefix:

Capillary Humhber % | |Dwner Mame

—Sample File Marme Format
Exarmple: MJD_007 =kones=

Mumbir of characters:14 to

Prefi; |ru1..ID

Marme Delimiter |_ _ﬂ
Format ]

|:Capillar\,r Numb/:r =] |=none=
=none= -

SlResults Group Mame

Analysis Profocol Mame

Canillar Arvay Satial Number —
Capillary Mumber
Date
Instrument Mame

Crner Marme -
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If a unique identifier is not included in the name,

a warning message displays. Select from the

elements to make a unique sample file name. Sample File Mame Format
Examples are: Example: BasecallerProtocol.saz.ab

Warning message

INVALIDL\JAME: Filename does not have a unigue identifier in it.

— Well position Prefic | Ly

— Capillary number N?:::i’f”m“erlj

— Run sequence number ’]Analysis Protocol Marne =] |<none=
— Plate Quadrant Suffic

File Extension @h1

Note: some identifiers, such as well position,
capillary number and plate quadrant are not
unique in multiple sample instances. Plate
Quadrant is not a unique identifier for a 96-well
plate.

As you select the elements for the file name, they
are placed in the Example line. An additional
element drop-down menu displays allowing you
the option of selecting an additional element.

—Sample Fila Marma Farmgt

Example] MJD_007_2002-04-21_MrHolmes_Sampled.=Mone=

Wmhernfch%cters:zgm x ’\ '\

Prefix: IMJD
Mame D limiter I_ 'I

’rFurma: / \

QCapillar\,r Mu..) =|((Date ) =J((0wnerName ) =l({Sample Name )= Jxaone= =

Caplary Mumbe ]

Suffic | Diata
i iop =Mone=
File Extension Ve AT |
Plate Matme -
Palymer Mame
Run Mame -
The names of the Format elements eventually
truncate, but the Example field remains visible
(up to 72 characters).
—Sample File Mame Format
Example: WJD_007_ThePhiladelphiaProject_BasecallerProtocal.saz_DummyCapSertum-1234..
Note: Resize the Results Mumber of characters:53 to
Group window horizontally Prefi D
to view the element options. e pely B

Format
(lo.- i | o g o e o o | o |
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5. Type the suffix for the file name in the Suffix
box.

Note: The File Extension field displays the file
extension generated from the Analysis Type
specified on the Analysis tab (see page 71). For
example, Sequencing Analysis produces sample
files with an .ab1 extension.

Optional: Run Folder/Sub-Folder Name
Format Pane

Note: The default run folder naming for sequencing
analysis is Run_<Instrumentname>_<Dateand
TimeofRun>_<RunSeq#>.

Follow the same steps described for the Sample File
Name Format pane (see page 73) to change the sub-
folder name within the run folder. Make the sub-
folder name unique, such as using the Run Folder
name.

Saving a Results Group

Click ok | from any tab once all the elements
within the Results Group have been chosen.

Note: Even if you create a custom run folder location,
the system generates a separate default run folder that
contains the log file.

Importing and Exporting a Results Group

Results Groups can be imported from, or exported to,
XML files allowing sharing of identical Results
Groups between instruments.

Importing a Results Group

1. In the tree pane of the Data Collection software,

click £ GA Instruments > @ Results Group.

2. Click Import  to display the standard File
Import dialog box.

Results Group for Sequencing Analysis

u
N

Sample File Marme Farmat

Example: MJID_007_2002-04-21_MrHolmes_WRk.
Mumber of characters: 31 to

Prefix |h,|1JD

Marme Delimiter |_ «
Format

[Canillary Mumber ate =] |owme

Suffi

File Extension <NDnL\\;
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3. Navigate to the file you want to import.

Note: Import file type is .xml (XML file).
4. Click 0Open
Exporting a Results Group

1. In the tree pane of the Data Collection software,
click £ GA Instruments > @ Results Group.

2. Click the Results Group name to select it.

3. Click Export

A standard file export dialog box displays with
the chosen Results Group name.

4. Navigate to the location where you want to save
the exported file.

5. Click s=ave

Note: If there is a name conflict with a Results
Group that already exists at the save location,
then duplicate the Results group. Duplication
copies the settings into a similar Results Group
without the risk of user error when copying it
manually (see procedure below).

Duplicating a Results Group
1. Click the Results Group name.

2. Click Duplicate .

Note: When you duplicate a Results Group, you
are asked to type a name for the new Results
Group and for the analysis application type.
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Filling Out a Sequencing Analysis Plate Record

Creating a Sequencing Analysis Plate

Record
1. In the tree pane of the Data Collection software, - A GA Instrumerts
click £ GA Instruments > £ ga3130x/ or Dreescon
ga3130 > i Plate Manager. 433130

4B Plate Manager
%I Protocal Manager
: -%Module Manager
"'“Run Hiztory

- (CHDaw i9PTS

2. Click wew.. to display the New Plate Dialog
dialog box.

3. Complete the information in the New Plate
Dialog:

a. Type a name for the plate.

b. Type a description for the plate (optional). INew Plate Dialog 5 =

c. Select your sequencing application in the Rz |] | 3a
Application drop-down list. DESEIH

d. Select 96-well or 384-well in the Plate Type T %
drop-down list.

T f th d t Application: INone L,I—— 3C
e. € a name 10r the owner and operator.
YP p Plate Type:  [o5wiel = 3d
f. Click _ 9K | to open the Sequencing S— il PR
Analysis Plate Editor.
COperator Mame: I — 3f

,7
il Cancel |
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Completing a Sequencing Analysis Plate

Record
1. In the Sample Name column of a row, enter a 1 2 3 4
sample name, then click the next cell. The value
100 automatically diSplayS in the Priority Wil Sample Mame | Commert Priotity | Results Group 1
column. il
(=10}
co1
2. In the Comments column, enter any comments pot
or notations for the sample. E

F1

3. In the Priority column, change the priority value,
if desired. A lower number for each 4 or 16 set,
receives a higher run priority.

4. In the Results Group 1 column, select a group
from the drop-down list (see page 70) or create a
new Results Group.

5. In the Instrument Protocol 1 column, select a 5 6
protocol from the drop-down list (see page 59) or
create a new instrument prOtOCOl. Instrument Protocal 1 Analysiz Protocol 1

6. In the Analysis Protocol 1 column, select a
protocol from the drop-down list (see page 62) or
create a new analysis protocol.

7. Complete the plate record based on the samples
loaded in your plate:

» For the single runs that use the same
samples and protocols — Highlight the entire Fill Down 4D
row, then select Edit > Fill Down Special. Copy Chri+C
Paste Chrl4
Based on your plate type (96- or 384-well) oo rons) a4t
and capillary array (16 or 4 capillaries), the Fill Dawin Special Al+D

software automatically fills in the Add Sample Run - Al+A
appropriate well numbers for a single run
or
» For entire plates that use the same samples
and protocols — Highlight the entire row,
then select Edit > Fill Down to fill down
the entire plate editor.

* For plates with different samples and
protocols — complete the entries manually.
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8. To do more than one injection of the same
sample, select Edit > Add Sample Run. Fill Down k4D
. i Chrl4+C
Results Group, Instrument Protocol and Analysis P::ti Ct:l Ly
Protocol columns are added to the right end of Clear row(s)  Shift+Delete
the plate record. Fill Down Special  Alk+D

Add Sample Run Alt+4

9. Complete the columns for the additional runs.

10. Click _ok_|.

Note: After clicking OK in the Plate Editor, the
completed plate record is stored in the Plate
Manager database.The plate record can be
searched for, edited, duplicated, exported, or
deleted in the Plate Manager.
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v

Filling Out a Sequencing Analysis Plate Record
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Performing a
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—| Software
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Create a See page 101
SeqgScape Software pag
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See page 88

Running the
Instrument

Notes
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SeqScape Software

82

Autoanalysis

Required
Software
Packages

Analyzing your sequencing samples may be done by autoanalysis or manual analysis.

Use the ABI PRISM® SeqScape® software to automatically analyze Applied Biosystems
3130/3130x/ Genetic Analyzers sequencing data. Perform autoanalysis only on the same
instrument computer that collected the sample files. You can configure the software
packages to perform data collection and then data analysis without requiring user
interaction.

Install and register the SeqScape software with the 3130/3130x/ genetic analyzer Data
Collection software before creating required files for autoanalysis.

See Appendix B in the SeqgScape Software User Guide v2.5 (P/N 4359442), for more
details on setting up autoanalysis.

Autoanalysis requires three software packages:

3130/3130x/ genetic analyzer Data Collection software

The Data Collection software runs the instrument and collects fluorescent data from
samples. For autoanalysis to occur, the software must communicate with
downstream software.

Analysis parameters used for data collection as well as that created in SeqScape
software are accessible in Data Collection software.

* Autoanalysis Manager
The Autoanalysis Manager software is part of the integration between the data

collection, SeqScape, and GeneMapper® software. It can queue messages and track
their processing status. Each message is considered a batch job, whether it contains
a single sample, samples from a result group, or an entire run of samples.

Autoanalysis Manager is installed by Seqscape or GeneMapper software when
loaded on a system with Data Collection software.

» A version of SeqScape software without a user interface

This SeqScape software version is identical to the regular software version except
that there is no user interface. The Autoanalysis Manager opens and uses this
version of software to analyze the data in the projects.

The automated processing version and the standard version of SeqScape software
are installed from the SeqScape Software installation CD.

IMPORTANT! When installing SeqScape software on a computer that is connected to a
3130/3130x! genetic analyzer, the Data Collection software must be running. Otherwise,
the SeqScape software does not register with the Data Service. See Chapter 2 in the
SeqScape Software User Guide v2.5, for information on installing the software.
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About Plate Records and Seqgscape Software

Importing Reports  In the SeqScape Software v2.5, select Tools > Options tab.You can set the options to
and Projects After automatically import:
Autoanalysis

N

* Reports after autoanalysis

* Projects after autoanalysis
See the SeqScape Software User Guide v2.5 (P/N 4359442) for more details.
File-Naming Some alphanumeric characters are not valid for user names or file names. Do not use the
Convention invalid characters below:
spaces

\iE2 <> |

IMPORTANT! An error message is displayed if you use any of these characters. You
must remove the invalid character to continue.

Manual Analysis See the SeqScape Software User Guide v2.5 (P/N 4359442) for information on
performing manual analysis.

About Plate Records and Segscape Software

Requirements  Successful automatic analysis requires that:

» SeqScape software is installed properly

* SeqScape software is registered and the appropriate user IDs have been created
* Autoanalysis Manager software is running

* The 3130/3130x/ genetic analyzer is set up to run, and samples are prepared

* Files for a Data Collection software plate record are available:

— An instrument protocol

— An analysis protocol

— A results group assigned within a plate record

When to Create a Create a plate record for each plate of samples for the following types of runs:

Plate Record * Spectral calibrations

* Sequencing Analysis Software
* SeqScape Software analysis
» GeneMapper® software

* Mixed (sequencing and fragment analysis samples - see the Applied Biosystems
3130/3130xl Genetic Analyzers Maintenance, Troubleshooting and Reference
Guide for creating a mixed plate record)
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SeqScape
Software Plate
Record Overview

84

For runs to begin, you must create a plate record for and link it to a plate loaded on the
instrument. However, you can create plate records for new plates while a run is in

progress.

The Plate Editor displays an empty plate record for the application selected in the New
Plate dialog box. The data fields within a given plate record vary depending on the
application. This section describes the SeqScape Plate Record’s data fields.

IMPORTANT! For data collection and SeqScape software autoanalysis to succeed, each
run of samples must have an instrument protocol, an analysis protocol, and a results
group assigned within a plate record. You are also required to have a project, project
template, and specimen information.

The table below describes required plate editor fields.

assembled contigs from a biological source or PCR
product

Parameters Description See Page
Instrument Protocol | Contains the run module and dye set needed to run 88
the instrument.
Created in Data Collection software.
Analysis Protocol Contains everything needed to analyze sequencing 92
data.
Created in Data Collection software or SeqScape
software. If you prefer to use analysis protocols
created in SegScape software, then select “Always
use this protocol” - in the SeqScape software
analysis defaults settings.
Results Group Defines the file type, the file name, file save locations, 98
default analysis protocols linked to sample injections,
and user name and password.
Created in Data Collection software.
Project A group of related sequences that share the same See the
reference or for which there is no explicit reference. SeqScape
- . - Soft
Project Template Contains a reference data group (RDG), analysis ortware
default d disol ti User Guide
efaults, and display settings. v2.5 for more
Specimen The container that holds all the sample data as information
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Elements of a
SeqScape Plate Plate Manager
Record

Plate Record

Data Collection SeqScape software
software files: files:
| | || Project Template
Results Group ‘ ’ Instrument Protocol ‘ ’ Analysis Protocol* - Analysis Protocol*
- Analysis Defaults
- RDG
|| Results Group | | Instrument || Analysis Protocol - Display Settings
Name Protocol Name Name
Analysis software || Runtype __ | Basecaller and
| and autoanalysis (Regular) DyeSet/Primer file — Project
| | File storage | Run module __ | Bases called
location (pure or mixed) L— Specimen
File and run folder || Dye set | Assigning Quality
— name preferences Values (QVs)

Post processing
| | (clear range
trimming)

L Filter settings

*You can create Analysis Protocols in either
SeqScape or Data Colletion software
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SeqScape A Segscape software plate record displaying the columns and descriptions is shown
Software Plate  below.

Record

File  Edit

1 2 3 4 5 6 7 8 9
Plate: Mailie: Ibap =S Operator: Ioap
Plate Sesfling: IS_ep ] l CREr: I:Jap
arnple Mame | Comment | Priority | Project Project Template | Specimen Results Group 1 Instrurment Protocal 1 Analysis Protocol 1

il
A1
B
o)}
Do
EO1
F1
GO
HO1
A2
E02
coz
Doz
EO0Z2

=

4

Descriptionl Ok | Cancel |

Default is one sample run, to add runs
see page 103

Number and Column Description
1. Sample Name Name of the sample.
2. Comment Comments about the sample (optional).
3. Priority A default value of 100 to each sample. Changing the value to a smaller number
causes that set of 16 or 4 samples to run to before the others in the injection list.
4. Project Select one of the available Project from the list that was created in Data Collection or

SeqScape software.

5. Project Template

Completed automatically based on the Project selected.

6. Specimen

86

Select one of the available Specimen from the list that was created in Data
Collection or SeqScape software.
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Number and Column

7. Results Group

Description

Some options:

¢ New: Opens the Results Group Editor dialog box

e Edit: Opens the Results Group Editor dialog box for the Results Group listed in
the cell

¢ None: Sets the cell to have no selected Results Group
¢ Select one of the available Results groups from the list

Note: You must have a Results Group selected for each sample entered in the
Sample Name column.

See “Creating a Results Group” on page 98.

8. Instrument Protocol

e New: Opens the Protocol Editor dialog box.

¢ Edit: Opens the Protocol Editor dialog box for the Instrument Protocol listed in
the cell.

¢ None: Sets the cell to have no selected protocol.
e List of Instrument Protocols: In alpha-numeric order.

Note: You must have an Instrument Protocol selected for each sample entered in
the Sample Name column.

See “Creating an Instrument Protocol” on page 88.

9. Analysis Protocol

¢ New: Opens the Analysis Protocol Editor dialog box.

e Edit: Opens the Analysis Protocol Editor dialog box for the Instrument Protocol
listed in the cell.

¢ None: Sets the cell to have no selected protocol.
e List of Analysis Protocols: In alpha-numeric order

Note: You must have an Analysis Protocol selected for each sample entered in the
Sample Name column.

See “Creating an Analysis Protocol” on page 93.

Applied Biosystems 3130/3130x/ Genetic Analyzers Getting Started Guide 87




Chapter 5 Autoanalysis and SeqScape Software
Creating Protocols for Automated SeqScape Software Analysis

Creating Protocols for Automated SeqScape Software
Analysis

If the appropriate SeqScape software protocols and
results group have been created, proceed to “Filling
Out a SeqScape Software Plate Record” on page 101.

Instrument Protocol for SeqScape Software

An instrument protocol contains all the necessary
settings to run the instrument:

* Protocol name

e Type of run

* Run module

* Dye set

Creating an Instrument Protocol

1. In the tree pane of the Data Collection software, I Foundation e Callection ersin 30 o U g [
click £ GA Instruments > £ ga3130 or Sy
= Ao nstnmerts N G Instruments = ga3130x| = Protocol Manager
ga3130x/ > w Protocol Manager. I
o S
B ng e e tine_ Fun o 0ye e | Descrpion
Create
a instrument
= S e
Frapoocal [ |
Create analysis
protocols here
2. In the Instrument Protocols section, click = Aararaare § o ettt e
3 il Datbase Manager T | rument ProtocoR
Mew.. to open the Protocol Editor. | e o < —
—_— iPete aracer e
1l

Watocile Manager Mame: Fun Module Dye Set | Descrigtion
1= CllRun History

Sjent viewer 3 31 tialFill_1
Flevert Loy 31308patialMNoFill_1  3130S5patialNaFil_1 Created with po
Ty instrumert Protocol
BB spatial Calibration Viewer
B Capillary Viswer
BB capitrray Viewer
R spectral Calibration Viewesr
UEIReextraction

= CiDey

= [Elinstrument Status

£
EHePT Chart
HZ?Z:D;ME”MH (Crew. D[ st | [(oeste | [[mport. | [ ot

Created with pi
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3. Complete the Protocol Editor:

x|
a. Type a name for the protocol. ez ] ——3a
b. Type a description for the protocol peserten 4 3p
(optional).
c. Select Regular in the Type drop-down list.

Type: [REGULAR ~H—3c
Run Module:  [Fragmentnalysis22_POP4_1 i 3d
Dye Set: IES LI_E_— 3e
| 3f

OK | Cancel |

d. Select the correct run module for your run.
See “Sequencing Resolution Performance
and Specifications” on page 3 to see a list of
modules or the Applied Biosystems
3130/3130xl Genetic Analyzers
Maintenance, Troubleshooting and
Reference Guide to modify a default
module.
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e. Select the correct Dye Set for your run using

the table below.
POP-4 POP-6
Polymer Polymer POP-7 Polymer
© Q Q © Q o Q
2 8 8 ¢ 8 § T 85 8 &
. b (=3 O [} (=3 b [} ® (=3 O
Chemistry Dye Set n $ n n $ ] n ] $ n
s 3 2 235 &8 2 % T P2
= £ 5 & 2 E g 8§ 2 s
=) » - o » =) o w » -
BigDye® Terminator v3.1 Cycle Sequencing Kit | Z_BigDye | v v v v v v v v v v
ABI PrisM® dGTP BigDye® Terminator v3.0 v - - - - - - - - - -
Cycle Sequencing Ready Reaction Kit
BigDye® Terminator v1.1 Cycle Sequencing Kit | E_BigDye = v v v v v v v v v v
ABI PrisM® dGTP BigDye® Terminator Cycle Vi — — — — — — — — — —
Sequencing Kit*
ABI PrisM® dRhodamine Dye Terminator Cycle v v v v v - - - - -
Sequencing Ready Reaction Kit
ABI Prism® BigDye® Primer Cycle Sequencing - - - v v - - - - -
Kits

*dGTP kits are not supported on capillary electrophoresis instruments due to compressions on certain sequence context
regions; you can run the kits if you do not care about the compression issues.

f. Click ok |.
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Importing an Instrument Protocol

1. Click jmpart  in the Instrument Protocols pane
of the Protocol Editor window to display the
standard File Import dialog box.

Instrument Protocols

Find

Mame Run hMaodule Dye Set

e, Edit... | Delete  ( Import I Export |

2. Navigate to the location of the .xml file you want
to import.

3. Select the .xml file and click Open.

Exporting an Instrument Protocol

1. In the Instrument Protocols pane, highlight the
protocol you want to export.

2. Click Export to display the standard File
Export dialog box.

3. Browse to the desired folder location.

4. Click Save
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Analysis Protocol for SeqScape Software

92

About Analysis
Protocols

An analysis protocol contains all the settings necessary for analysis and post processing:

* Protocol name — The name, description of the analysis protocol, and the sequence
file formats to be used

* Basecalling settings — The basecaller, DyeSet/Primer file, and analysis stop point
to be used

* Mixed Bases — (Optional) — When two bases are found at the same position. Define
the percent value of the second highest to the highest peak

* Clear Range — The high quality sequence remaining after trimming low quality
sequences typically found at the beginning and ends of the sequence. The clear

range can be based on base positions, sample quality values, and/or number of
ambiguities (Ns) present

* Filter — The settings that define which samples will be used in the assembly

Note: If you created an appropriate analysis protocol in the SeqScape software, you can
use it in the Data Collection software. See Appendix B in the SeqScape Software User
Guide v2.5 (P/N 4359442) for more information on autoanalysis and analysis protocols.

IMPORTANT! Do not delete the current analysis protocol being used, during a run.
Autoanalysis will not be performed if you do so.

IMPORTANT! You are required to select the Always use this Analysis Protocol in
Analysis Defaults > Analysis Protocol in the Seqscape software if you want to use it for
SeqScape analysis. See the SeqScape Software User Guide v2.5 (P/N 4359442) for more
information.
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Creating an Analysis Protocol

IMPORTANT! If you created an appropriate analysis
protocol in SeqScape software, you can use it in the
Data Collection software. You can also create an
analysis protocol in the SeqScape software.

1. In the Analysis Protocol section of the Protocol
Manager, click ®ew... .

If more than one analysis application is installed
on the data collection computer, the Analysis
Applications dialog box opens.

2. Select SeqScape, then click ok | to open the
Analysis Protocol Editor dialog box.

3. In the General tab, enter a unique name and
description (optional) for the new protocol.

Chapter 5 Autoanalysis and SeqScape Software
Creating Protocols for Automated SeqgScape Software Analysis

Analysis Protocols

.Analysis Applications

Select a registered analysis application:

SegScape
SequencingAnalysis

Cancel |'

Analysis Protocol Editor
General | Basecaling | Mixed Bases | Clear Range | Fiter

Analysis Protocol Description

Mame:

Comments

[ cancet
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4. Select the Basecalling tab, then:

a. Select the appropriate basecaller and

c. If desired, select one or more stop points for

DyeSet primer based on the chemistry,
capillary array length and polymer type you
are using. The dye set primer files displayed
are based on the basecaller selected.

See “3130/3130x1 Genetic Analyzer
Basecaller and DyeSet/Primer Files” on
page 66 for a table on basecallers and
dyeset/primer files.

Analysis Protocol Editor

General | Basscaling | wized Bases | Clear Rangs | Fiter

Basecalling

Basecaller :

k& bcp

DyeSet { Primer

Processed Data

(%) True Profile

() Flat Profile

Note: SeqScape Software and the Data
Collection software filter .mob file choices
to match the chosen .bcp file.

In the Processed data pane, select True or
Flat Profile.

Ending Base
[ atPCR Stop

[ adter M= in

[ adter M=
[ adter Bases

Quality Threshold
() Do nat assign M's o Basecalls

() Assign N's to Basecalls with Qv <

bazes

[ cancel

Option

Function

¥ True Profile

* Flat Profile

data analysis.

d. Select your Threshold Quality option.

94

Displays data as processed traces scaled uniformly. The average peak height in
the region of strongest signal is about equal to a fixed value. The profile of the
processed traces is similar to that of the raw traces.

Displays data as processed traces scaled semi-locally. The average peak height in
any region is about equal to a fixed value. The profile of the processed traces is
flat on an intermediate scale (> about 40 bases).

Note: This option is applied to data analyzed with the KB™ basecaller only. If you
use the ABI basecaller, the profile option reverts to True Profile.

Option setting

Function using KB basecaller

' Call all bazes and assighn Y

Assigns a base to every position, as well as the QV.

g Aszign ™' for bases with G4 = |1 o

Assigns Ns to bases with QVs less than the set point. The QV will
still be displayed.
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5. Select and fill in the Mixed Bases tab:

Note: This function is active with the KB
basecaller only.

a. For mixed bases only, select Use Mixed
Base Identification.

b. Use the default setting of 25% or change the
detection level by entering a new value or
dragging the % line up or down.

Note: Do not use less than 15% as your
detection limit.

6. Select the Clear Range tab, then, if desired,
select one or more stop points for data analysis.
Select the recommended settings, which are the
default settings:

a. Use Quality values, fewer than 4 bases out
of 20 have QVs less than 20.

b. Use reference trimming.

Note: The clear range is the region of the
sequence that remains after excluding the low-
quality or error-prone sequence at both the 5” and
3" ends.

Analysis Protocol Editor

Generall Basecaling Mixed Bases | Clear Rangel Filterl

~Mixed Bases Settings

[V Use Mixed Base Idertification

Call IUE if 2nd highest peak
iz== |25

Z5%

% of the highest peak

Analysis Protocol Editor [
Generall Basecal\ingl Mixed Bases Clear Range I Filtarl
Clear Range
I Use clear Fange minimutn ahd maxinurm 5 T
cregmesfr | @ EEee = P
| Bases o trim fram 2'end . [20 First bp Last bp
W Use qualtty valuss Rermaove bases from the ends until Nbases Nbases
tewer than |4 bazezoutof |20 have Oz less than IZU Q\,-‘, w Q\,-‘, w
I Use identification of N calls FRemove bases fromthe ends:
_A -
urtil thereare fesver than |4 Meoutaf |20 kEses <¥ M'sper Zbases < W N'sper Z bases
w3 fod [
I hask M13 universal SEGUENCING primers '—
¥ Use reference trimtming Reierenc: |
- £
Muttiple: clear range methods are applied in order _
- -
Smallest clesr range is the result. e B8
| oK I Cancel
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7. Select the Filter tab, then, if desired, change one Analysis Protocol Editar =
or more of the settings.Select the recommended Gansrai| Basscaling | Wored Basss| clear Rangs| Fite
. . . Filter Settings
settings, which are the default settings:
Meimum Mized Bases (%) 200
a. Maximum Mixed Bases (%): 20 R -
b. Maximum Ns (%) 10.0 Minimum Clear Length (hg) - 50
¢. Minimum Clear Length (bp): 50 Ve S e e

[ skin fitering if sample-level HIM is detected

d. Minimum Sample Score: 20

[ cancel

8. Click ok | to save the protocol and close the
Analysis Protocol Editor dialog box.

Editing an Analysis Protocol

1. In the Analysis Protocols pane in the Analysis
Protocol Manager, highlight the protocol you
want to edit.

Analysis Protocols

Finef Protocal

Application

e ————
) 3130POP7_BDTv3-ko-Dehovo_v5.2  SequencingAnalysis

2. Click Edt...

3. Make changes in the General, Basecalling,
Mixed Bases and Clear Range tabs, as
appropriate.

wew. |([ Eat. ) oeete | [ mpot.. | [ Expor

4. Click ok | to save the protocol and close the
Analysis Protocol Editor dialog box.
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Deleting an Analysis Protocol

IMPORTANT! Do not delete an analysis protocol
during a run while it is being used for that run or
Autoanalysis will not be performed. Also, you must
first delete any plate records using the analysis
protocol before you can delete or modify the
analysis protocol for these plate records.

1. In the Analysis Protocols pane in the Analysis P—
Protocol Manager, highlight the protocol you Find Fratocol
want to delete.

Application

e —
( 3130POP7_BDTw3-k3-Deno
A

¥5.2  SequencingAnalysis

2. Click Delete
The Deletion Confirmation dialog box displays.

3. Click _es |.

<

mew . | [ Ean [(oekte ) [ mpor.. | [ Expon

Exporting an Analysis Protocol

1. In the Analysis Protocols pane in the Analysis
Protocol Manager, highlight the protocol you
want to export.

2. Click Export  to display the standard File
Export dialog box.

3. Browse to the desired folder location.

4. Click Save.

Importing an Analysis Protocol

1. Click |mpaort  to display the standard File
Import dialog box.

2. Browse to the .xml file to import and click Open.

Note: For multiple applications, select the
appropriate application to associate with the
analysis protocol.
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Results Group for SeqScape Software

A Results Group is a component within Data
Collection that organizes samples and certain user
settings under a single name. It is called a Results
Group because it is used to name, sort, and deliver
samples that result from a run.

Creating a Results Group

1. In the tree pane of the Data Collection software,

click £ GA Instruments > @ Results Group.

2. Click _ Mew.. .
The Results Group Editor window displays.

3. Complete the General tab:

a. Type a Results Group Name. The name can
be used in naming and sorting sample files.
It must be unique (see page for a list of
accepted characters).

b. Optional: Type a Results Group Owner. The
owner name can be used in naming and
sorting sample files.

c. Optional: Type a Results Group Comment.

4. Select the Analysis tab, then:

a. Select SeqScape_ computer name in the
Analysis Type drop-down list.

b. Select Do Autoanalysis in the Analysis
Actions section.

c. Type a valid SeqScape Software Login ID
and Password in the text boxes.

Note: Failure to use the proper login and
password causes your samples not to be
analyzed automatically.

GA Instruments = Results Group

Find Results Group

Marme Crwvner | Comment
Default_Results_Group
Gh_Results_Group

Kl
rits
Group 4’ ey hl Edlit... | Delete | Duplicate | In
E=)Databass Manager .
=18 lga3130
.Results Group Editor |

General] Analysis] Destination] Naming]

Results Group Mame: Untitied_Re

Rezults Group Owner: | — 3b

Results Group Comment: | — 3¢
. Results Group Editor

General| Analysis | Destination | Maming

Analysis Type

SegScape_IDEVRT —1 4a

Lagin IO DavidPRT
Password @@

Analysis Actions
Do Autoanalysis [ Results Group Entry Completed 4b
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.Results Group Editor % x|
destination or define a new location for data General| Analysis Destination | Naring |
storage.
To use ... Then ...
default location* skip to step 6 I Use Custom Location 5a
. Root Destination: |E:\AppliedBiosystemswdcidatacollectiontData
custom location complete steps a-c Note: the: final destination folder is Root Destination + Run Folder Name Setting
Brav/Ee.. I| ba
. . . |
a. Click Use Custom Location, then click — 5b
Browse... to navigate to a different save
location.
b. Click Test | to test the Location path
name connection: aK Carcel
. Then a message box
If it... ;
displays ...
Passes Test succeeded:
<“path”>.
Fails Test failed:<“path”>.
6. Select the Naming tab, then define custom [BResults Group Editor
names for the sample file and the run folder General| Anaiysis| Destination ~ Narming
" . . . - Sample File Kame Format
name. See “Optional: Completing Sample File _ _ )
Exarmple: =app prefiv=_=capillayy nurmber=_=well position=. <et=
Name Format Pane” on page 73 for more Prefic |
detailed information. Name Delmier | <]
Format
7. Click | d close the Resul o =
. (0]78
ic . to save and close the Results e
Group Editor.
File Extension abl
~Run Folder Mame Format
Exarmple: ErdppliedBiosystemsludodatacoll ectionDatai=Instr Type==Instr Mame=1=Run Marme
Frefix: |
Marne Delimiter |_ -
Format
’V|=n0ne> L‘
| Cahcel
*Sample File Destinations
Locations where sample files are placed during extraction:
e Default Destination, default folder naming: E:\\AppliedBiosystemsUDC\DataCollection\data\<instrument type>\
<instrument name>\run folder
e Default Destination, custom folder naming: E:\AppliedBiosystemsUDC\DataCollection\data\top custom folder\
subfolders, etc.
e Custom Destination, default folder naming: Destination\<instrument type>\<instrument name>\run folder
e Custom Destination, custom folder naming: Destination\top customer folder\subfolders, etc.
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Importing and Exporting a Results Group

Note: Importing or exporting of SeqScape software
Results Groups are not supported for transfer between
separate computers.

1. In the tree pane of the Data Collection software,
click £ GA Instruments > @ Results Group.

2. Click Import  to open a File Import dialog box.
3. Navigate to the file you want to import.
Note: Import file type is .xml (XML file).

4. Click Open .

Note: When you import or duplicate a Results
Group, you are asked to type a name for the new
Results Group and for the analysis application

type.
Exporting a Results Group

1. In the tree pane of the Data Collection software,
click £ GA Instruments > @ Results Group.

2. Click the Results Group name to select it.

3. Click Export

A standard File Export dialog box displays with
the chosen Results Group name.

4. Navigate to the location where you want to save
the exported file.

5. Click s=ave

Note: If there is a name conflict with a Results
Group that already exists at the save location, the
Results groups can be duplicated to copy settings
into a similar Results Group without the risk of
user error when copying it manually (see
“Duplicating a Results Group” on page 100).

Duplicating a Results Group

1. Click the Results Group to select it.
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2. Click Duplicate .

Note: When you import or duplicate a Results
Group, you are asked to type a name for the new
Results Group and for the analysis application

type.

Filling Out a SeqScape Software Plate Record

Creating a SeqScape Software Plate

Record
1. Click the Plate Manager icon in the navigation 5 A Ga Instrumerts
ﬂ] Results Group
pane' = Database Manacer
2. Clle Mew... . 1@ Pratocal Manager

-%Module Manager
---uRun History
- (CHDaw i9PTS

The New Plate Dialog dialog box opens.

3. Complete the New Plate dialog box:

a. Type a name for the plate.

b. Type a description for the plate (optional). Bilticr Platc Bl 5 X
. Matne: || -— 3a

c. Select SeqScape_computer name in the —

Application drop-down list. 36
d. Select 96-well or 384-well in the Plate Type

drop_down hSt' Application: INone L.I—— 3c
e. Type a name for the owner. Plate Type: [seowel =1 3d
f. Type a name for the operator. Owner Name: | —— 3e

g. Cllck ol | COperator Mame: I — 3f
The SeqScape Plate Editor opens.

OK | Cancel |
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Completing a SeqScape Software Plate

Record
1. In the Sample Name column of a row, enter a 1 2 3 4 5
sample name, then click the next cell. The value |
100 aUtomaticaHy dlsplay in the Priority COlumn- el Sample Marme | Comment | Priority | Project | Project Template | Specimen

A1

2. In the Comments column, enter any additional ig:

comments or notations for the sample. bt
E01

3. In the Priority column, change the priority value, ol

if desired. A lower number for each 4 or 16 set,
receives a higher run priority. (See the Applied
Biosystems 3130/3130xl Maintenance,
Troubleshooting, and Reference Guide for
changing priority values).

4. In the Project column, select a project from the
drop-down list or create a new project with the
corresponding project template.

Based on the project you select, the project
template is filled in automatically.

5. In the Specimen column, select or create a

specimen.
6. In the Results Group 1 column, select a group 6 7 8
from the drop-down list (see page 98).
Results Group 1 Instrurment Protocal 1 Analysis Protocol 1
7. In the Instrument Protocol 1 column of the row,
select a protocol from the drop-down list (see
page 88).
8. In the Analysis Protocol 1 column of the row,
select a protocol from the drop-down list (see
page 93).
9. To complete the rest of the plate record based on
the samples loaded in your plate, do one of the
following:
* For the same samples and protocols —
Highlight the entire row, then select Edit > Fill Down 4D
Fill Down Special. Copy Chriec
aste tl
Based your plate type (96- or 384-well) and Ele; onls) :I:iF::DeIete
capillary array (16 or 4 capillaries), the Fill Diown Special Al+D
software automatically fills in the Add Samplz Run Alt+A

appropriate well numbers for a single run.
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o
)/ I

* For the same samples and protocols —
Highlight the entire row, then select Edit >
Fill Down.

* For the different samples and protocols —
Complete the entries manually.

10. If you want to do more than one run, then select
Edit > Add Sample Run. Fill Diowin CHi4D
Additional Results Group, Instrument Protocol ;::tz E:::::
and Analysis Protocol columns are added to the Clearrom(s)  Shift+Delete
right end of the plate record. Fill Do Special Al+D

&dd Sample Run Ale+A

Add additional runs by selecting Edit > Add
Sample Run again.

11. Complete the columns for the additional runs.

12. Click _ ok | to save, then close the plate record.

Note: After clicking OK within the Plate Editor,
the completed plate record is stored in the Plate
Manager database.The plate record can be
searched for, edited, exported, or deleted in the
Plate Manager.

For sample preparation and running the instrument,
see Chapter 7, “Running the Instrument.”
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Chapter 6

Notes

Autoanalysis and Fragment Analysis

Preparing the
Instrument

| |
il

|

Performing a
Spatial Calibration

A

EEE—=
mmwhksawisy Performing a
Eﬂ; Spectral Calibration

v

Autoanalysis
and Sequencing
Analysis

1 Software

|

Autoanalysis
and
SeqgScape Software

!

!

Autoanalysis
and

Fragment Analysis

Create protocols
for automation

}

1

Running the
Instrument

Create a
GeneMapper Software
Plate Record

See page 112

See page 123
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GeneMapper Software

GeneMapper
Software v3.7 and
GeneMapper ID
Software v3.2

File-Naming
Convention

Manual Analysis

106

Analyze your fragment analysis samples automatically using autoanalysis or manually.

Note: This chapter is written for both GeneMapper® Software v3.7 or higher and
GeneMapper® ID Software v3.2. Graphic examples are from GeneMapper software
v3.7.

Perform autoanalysis of fragment analysis samples with features of the 3130/3130x!/
Data Collection and GeneMapper software using the same instrument computer that
collected the sample files or on a remote computer.

* Autoanalysis can be performed on the same instrument computer that collected the
sample files or on another computer using the remote analysis feature of
GeneMapper software.

» After autoanalysis, if you wish to edit/review results on another computer, then
transfer the GeneMapper software project, analysis methods, size standards, panel,
and bin set information to the other GeneMapper software database. All
components need to be exported and imported individually.

* When completing the plate record, fill in the instrument protocol and other
information for Data Collection software to complete the run.

* When creating a new Results Group for a set of samples to be autoanalyzed, check
the Do Autoanalysis check box and enter the appropriate GeneMapper Software
user name and password. For remote analysis, define a default location for sample
file storage.

Some alphanumeric characters are not valid for user names or file names. Do not use the
invalid characters below:
spaces

(VAR AR SN

IMPORTANT! An error message is displayed if you use any of these characters. You
must remove the invalid character to continue.

For information on manual analysis, see the GeneMapper Software v3.7 User Guide
(PN 4359413) or GeneMapper ID Software V3.1 User Guide (PN 4338775), or the User
Bulletin titled GeneMapper ID Software v3.2, Subject: New Features and Installation
Procedures for GeneMapper ID Software v3.2 (PN 4352543).
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About Fragment When GeneMapper software is installed on a computer that has 3130/3130x/ genetic
Analysis and Data analyzer Data Collection software, two applications are available through the Results
Collection  Group Editor (see page 115):

* GeneMapper-Generic
* GeneMapper-<Computer Name>

GeneMapper-  Use GeneMapper-Generic to generate .fsa files, without performing autoanalysis. When
Generic  completing the Sample Sheet, fill in basic information for the Data Collection software

to complete the run; all other GeneMapper software related fields are text entries. Text
entries are useful if you are using other software analysis applications or choose to
analyze your samples in GeneMapper software on another computer, but do not have the
same entries in the GeneMapper software database stored on the Data Collection
computer. For example, if you have a customized size standard definition on another
GeneMapper software computer, you can type in that size standard name in the size
standard text field and it will populate that column in your GeneMapper software
project.

GeneMapper- Use GeneMapper-<Computer Name> for autoanalysis. The Size Standard, Analysis
<Computer Method, and Panel columns in the Sample Sheet window read directly from the
Name> GeneMapper software database. Create these components in GeneMapper software prior

to setting up the plate record for a run. New entries cannot be created for these columns
once you are in the plate editor dialog box. If you create a new GeneMapper software
component while the plate record dialog box is open, the columns will not update. The
plate record must be closed and reopened to update the GeneMapper
software components. For more information see, “Creating Protocols for Automated
Fragment Analysis” on page 112.
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About GeneMapper Software Plate Records

A plate record is similar to a sample sheet or an injection list that you may have used
with other ABI PRISM® instruments.

Plate records are data tables in the instrument database that store information about the
plates and the samples such as:

* Plate name, type, and owner

* Position of the sample on the plate (well number)

* Comments about the plate and about individual samples

* Dye set information (in Instrument protocol)

* Name of the run module where run modules specify information about how samples
are run (in Instrument protocol)

When to Create a  Create a plate record for each plate of samples for the following types of runs:

Plate Record Spectral calibrations

* Sequencing Analysis Software
* SeqScape Software analysis
» GeneMapper® software

* Mixed (sequencing and fragment analysis samples - see the Applied Biosystems
3130/3130xl Genetic Analyzers Maintenance, Troubleshooting, and Reference
Guide for creating a mixed plate record)

For runs to begin, you must create a plate record for and link it to a plate loaded on the
instrument. However, you can create plate records for new plates while a run is in
progress.

Files needed to create a GeneMapper software plate record:

. See
Parameters Description Page
Instrument Contains everything needed to run the instrument. 112
Protocol
Results Group Defines the file type, the file name, autoanalysis, and file save 115
locations that are linked to sample injections.

IMPORTANT! For data collection and auto-analysis to be successful, each run of
samples must have an Instrument Protocol, a Results Group and files created in
GeneMapper software assigned within a plate record.
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Elements of a GeneMapper software plate record

Plate Manager

Plate Record

Data Collection GeneMapper software
software files: 1 definitions:
! ! — Size standard
Results Group Instrument Protocol
Results Group || Instrument —— Analysis method
Name Protocol Name
Analysis software | | Runtype — Bin set
| and autoanalysis (Regular)
|| File storage || Run module — Panel
location
File and run folder || Dye set — SNP Set
— name preferences
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[ Genemapper late editor | )| ]| |

File  Edit

&z
b

Pliste Marme: | Oper tor: |

Filfste: Sealing) : Qv i |

il Sample Natme | Comtment Priotity Satnple Type Size Standard Panel Analysis Method Shp Set Uszer-Defined 1 Uset-Defined 2 | Uset-Defined 3| Results Groug 1 Instrument Protocal 1

A0 -

B01 j
o1
Dot
EM
Fo1
01
HO1
202
B02
o2

D02 =
A »
Description | Ok Cancel

Defaults to one sample run, to add additional runs see page 125

Blank GeneMapper software plate record

Columns inserted in a plate record for a fragment analysis run

Number and Column Description
1. Sample Name Name of the sample
2. Comment Comments about the sample (optional)
3. Priority A default value of 100 to each sample. Changing the value to a

smaller number causes that set of 16 or 4 samples to run to
before the others in the injection list.

4. Sample Type Use to identify the sample as Sample, Positive Control, Allelic
Ladder or Negative Control.
5. Size Standard ¢ GeneMapper-Generic (optional):
IMPORTANT! For GeneMapper-<Computer Manually enter size standards in the text field
Name> ONLY: e GeneMapper-<Computer Name>:
Create the Size Standard, Panel, and Analysis Select a saved size standard from the drop-down list
Method in GeneMapper software before creating a
new plate
6. Panel e GeneMapper-Generic (optional):
IMPORTANT! For GeneMapper-<Computer Manually enter panels in the text field
Name> ONLY: e GeneMapper-<Computer Name>:
Create the Size Standard, Panel, and Analysis Select a saved panel from the drop-down list
Method in GeneMapper software before creating a
new plate
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Number and Column

7. Analysis Method

IMPORTANT! For GeneMapper <Computer
Name> ONLY:

Create the Size Standard, Panel, and Analysis
Method in GeneMapper software before creating a

Description

GeneMapper-Generic (optional):

Manually enter analysis methods in the text field
GeneMapper-<Computer Name>:

Select a saved analysis method from the drop-down list

The SNP set, created in the GeneMapper software,
links a SNP name to a marker name.

new plate

8. SNP Set ¢ GeneMapper-Generic (optional):
IMPORTANT! For GeneMapper <Computer Manually enter SNP set in the text field
Name> ONLY: o

GeneMapper-<Computer Name>

9. Three User-defined columns

Optional text entries

10. Results Group

Options:

New: Opens the Results Group Editor dialog box

Edit: Opens the Results Group Editor dialog box for the
Results Group listed in the cell

None: Sets the cell to have no selected Results Group
Select one of the available Results groups from the list

Note: You must select a Results Group for each sample
entered in the Sample Name column.

See “Results Group for Fragment Analysis” on page 115.

11. Instrument Protocol

Applied Biosystems 3130/3130x/ Genetic Analyzers Getting Started Guide

Options:

New: Opens the Protocol Editor dialog box.

Edit: Opens the Protocol Editor dialog box for the
Instrument Protocol listed in the cell.

None: Sets the cell to have no selected protocol.
List of Instrument Protocols: In alpha-numeric order.

Note: You must select an Instrument Protocol for each
sample entered in the Sample Name column.

See “Results Group for Fragment Analysis” on page 115.
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Creating Protocols for Automated Fragment Analysis

If the appropriate fragment analysis protocols and
results group have been created, proceed to “Creating
a GeneMapper Software Plate Record” on page 123.

Instrument Protocol for Fragment Analysis

An instrument protocol contains all the settings
necessary to run the instrument:

¢ Protocol name

* Type of run

¢ Run module

* Dye set

Creating an Instrument Protocol

1. In the tree pane of the Data Collection software,
click £ GA Instruments > | ga3130x/ or
ga3130 > w Protocol Manager.

2. In the Instrument Protocols section, click
Mew.. to open the Protocol Editor.

. Foundation Data Collection Yersion 3.0 - Mo User is logged in

Flle View Help

= b oA Instruments

= Elgastaox

Results Group
=) Databasze Managsr

[E]Plats Managsr

iy Protacol Manager]

4
B G nstruments = ga3130xl = Protocol Manager

Instrumert Protocols

[ Madule Manager
= CHRun Histary
EHEPT wigwer ]
EEvent Log e
& Instrumert Frotocel
BB Spatial Calibration Wiewer
= Capillary iewer
BB caprarray viswer
[ spectral Calibration Wiewer
FFReestraction
[El= [
= [EHnstrumert Status <

Man

Create
instrument

EHEPT chart

gvem Log w
B Spatial Run Scheduler
= RN Schedulsr
EPiats View RELE
RN View
B capillaries iewer
BB caprarray viswer

Create analysis o B e o
protocols here

Find Protocol

&l spectral viewsr Hame

™ anual Contral
[Z)service Log

Application

= & Ga Instruments

= B gastanx

Results Group
=9 Database Manager

ATesnerts = @31 30: = Protocol Manager

InstesZnt Protocols

[EPiate Manager
Moduls Managsr
= CHRun History
EEPT Wigwer
Event Log
Y Instrument Protocol

[l Spatial Calibration ‘iews
=Capillary igsver
-Cap.l’Array Wigswver

Rl =pectral Calibration Wiewer

Find Protocol

Mame Run hiodule
d atialFill_1 3 patialFill_1

F305patialMoFill_1 31305patialboFill_1
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3. Complete the Protocol Editor: Protocol Editor x|

a. Type a name for the protocol. Narte: | —— 3a

b. Type a description for the protocol pesermen
(optional). T %

c. Select Regular in the Type drop-down list.

Type: [REGULAR: ~—T— 3¢
RunModule:  [Fragmentansiysis22_POP_1 -
DysSet [gs =l e T 3e
— 3f

OK | Cancel |

d. Using the table below, select the run module
for your run. To customize a run module,
see the Applied Biosystems 3130/3130xl
Genetic Analyzers Maintenance,
Troubleshooting, and Reference Guide on
modifying a module.

Capillary Array

Application or Kit Length Run Module
(cm)

SNaPshot® Multiplex System 22 ' SNP22_POP4_1

36 ' SNP36_POP4_1
e LMSv25 22 FragmentAnalysis22_POP4._1
. ggt' \'/’15'5“"@ Mouse Mapping 36 FragmentAnalysis36_POP4_1
e Custom oligos FragmentAnalysis36_POP7_1
e Stockmarks 50 FragmentAnalysis50_POP4._1
e AFLP® ' FragmentAnalysis50_POP6_1

' FragmentAnalysis50_POP7_1

e AmpF(STR® COfiler® 36 HIDFragmentAnalysis36_POP4_1
e AmpF(STR Profiler Plus®
¢ AmpF(STR SGM Plus®

e AmpF{STR Profiler Plus ID
e AmpF(STR SEfiler™

e AmMpF(STR Yfiler™

e Other 4-Dye AmpF{STR

e AmpF{STR Identifiler

e Other 5-Dye AmpF{STR
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e. Using the table below, select the correct Dye
Set for your run.

Matrix Standard

Application or Kit Dye Set Set

Custom oligos D DS-30

e ABI PRISM Mouse Mapping Set v1.0 D DS-31
e Custom oligos

e AmpF{STR COfiler F DS-32
e AmpF{STR Profiler Plus

e AmpF{STR SGM Plus

e AmpF{STR Profiler Plus ID

¢ Other 4-Dye AmpF{STR

e AFLP

e Stockmarks -Canine and Bovine

ABI PrISM SNaPshot Multiplex System E5 DS-02

e ABI PRrISM Linkage Mapping Set v2.5 G5 DS-33
e Custom Oligos

e AmpF{STR Identifiler™
e AmpF{(STR SkEfiler

o AmpF{STR Yfiler

e Other 5-Dye AmpF{STR
e Stockmarks-Equine

f. Click ok

Importing an Instrument Protocol

Instrument Protocols

1. Click jpport  in the Instrument Protocols pane
of the Protocol Editor window to display the
standard File Import dialog box.

Find

Mame Run hMaodule Dye Set

e, Edit... | Delete  ( Import ’ Export |

2. Navigate to the location of the .xml file you want
to import.

3. Select the .xml file and click Open.
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Exporting an Instrument Protocol

1. In the Instrument Protocols pane, highlight the
protocol you want to export.

2. Click Export  to display the standard File
Export dialog box.

3. Browse to the desired folder location.

4. Click s=ave

Results Group for Fragment Analysis

A Results Group is a component within Data
Collection that organizes samples and certain user
settings under a single name. It is called a Results
Group because it is used to name, sort, and deliver
samples that result from a run.

Creating a Results Group for Autoanalysis

1. In the tree pane of the Data Collection software, G4 Instruments » Resuits Group
click £ GA Instruments > @ Results Group. Find Results Group
2. Click New.. to open the Results Group Editor e

Wil’ldOW. Gh_Results_Group
MJD_Results_G

T ———P  Hew.. hl Edit... | Delete Duplicate
E=)Databass Manager
=0 lga3130
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3. Complete the General tab:

a. Type a unique Results Group Name. The
name can be used in naming and sorting

sample files.

b. Optional: Type a Results Group Owner. The

owner name can be used in naming and
sorting sample files.

c. Optional: Type a Results Group Comment.

4. Select the Analysis tab, then:

a. Click Analysis Type and then select one of

the following:

.Results Group Editor |

General' Analysisl Destinationl Namingl

116

If You Select ... Then ...

None Only raw data files are
generated.

GeneMapper- Autoanalysis is not

Generic enabled and only .fsa files
are generated.

GeneMapper- Autoanalysis of completed

<Computer runs is enabled.

Name> Steps b, ¢, and d below
apply only to
GeneMapper-<Computer
Name> (not GeneMapper-
Generic).

Reszults Group MName: 3a
Rezults Group Owner: | 3b
Reszults Group Comment:| 3c
Ok | Cancel |
.Results Group Editor |
General Analysis' Destination | Maming
Analysis Type
’]<N0ne> } 4a
Login ID | 4c
Password | 4d
Analysis Action
I~ Do Autaanalyeis [T Results Graup EntrEarmpeted 4b

Arralyze o |

OK | Cancel |
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b. Select an option in the Analysis Actions
section using the table below.

Use with Setting from Automated

If You Select ... Then ... Processing Tab (page 118)
Do Autoanalysis Samples are analyzed after each run of When every run completes
16 or 4 samples.
Do Autoanalysis and Samples are analyzed after all pending Only when the result group is complete
Results Entry Group samples using the same results group
Complete have been run.

c. Type the Login ID.
d. Type the login password.

Note: The login ID and password relate to the
GeneMapper software UserName and Password.
These items can only be created through the
GeneMapper software Options Users tab.
Autoanalysis will fail if the incorrect username
and password are entered.

5. Select the Destination tab, then use the default r————— K
deStlnatIOIl or deflne a new locatlon fOI‘ data General | Analysis .ijég”.ﬁaﬁ.ﬂﬁ.ﬂ Maming | Automated Processing
storage.
Tousea... Then ...
default location* skip to step 6. ~ Use Custom Lacalion 5a
. Root Destination: |[E\AppliedBiosystemsiudeidatacollectiomData
CUStom Iocatlon Complete Steps a_b' Mote: the final destination folder is Root Destingtion + Run Folder Name Setting.
. 5b
Use for remote analysis 5c
using GeneMapper v3.7
OK Cancel

*Sample File Destinations

Locations where sample files are placed during extraction:

¢ Default Destination, default folder naming: E:\\AppliedBiosystemsUDC\DataCollection\data\<instrument type>\
<instrument name>\run folder

¢ Default Destination, custom folder naming: E:\AppliedBiosystemsUDC\DataCollection\data\top custom folder\
subfolders, etc.

e Custom Destination, default folder naming: Destination\<instrument type>\<instrument name>\run folder
e Custom Destination, custom folder naming: Destination\top customer folder\subfolders, etc.
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L

a. Click Use Custom Location, then click
Browse.. to navigate to a different save
location.

b. Click Test |to test the Location path
name connection:

Chapter 6 Autoanalysis and Fragment Analysis

Then a message box

ifit.. displays ...

Test succeeded:
<“path”>.

Passes

Fails Test failed:<“path”>.

6. Select the Naming tab to customize sample file
and run folder names.

Note: The default sample file naming for
fragment analysis is:
frag_<capillary number>_<wellposition>.fsa

Note: Sample name, run folder name, and path
name, combined, can total no more than 250
characters.

For defining the elements of the Naming tab, see
page 119.

7. Select the Automated Processing tab.

In “Autoanalysis is performed” select when you
want your samples autoanalyzed using the table
below.

Sample File Name Format —

IR esults Group Editor [

Generaﬂ Analysis | Destination  Maming | Automated Processing
Sample File Mame Format
Example A12_Sample3fsa
Filename is greater than 9 characters
Prefix |

Mame Delimiter |_ hd

Forrat

|WE|| Position j |Samp|e MHame j \<nnne= j
By

File Extension 1523 _—
Run Folder Mame Format —
Example E:\AppliedBiosystemsiudeidatacollectiomDataiRun_Examplelnstrumentyame_2000-0.

Minimurm number of characters: 73

Prefix |
Mame Delimiter |_ hd

Forrat

Run Name |~ |Dale of Run j \<nnne= j

Ok Cancel

Run Folder Name Format pane |

Autoanalysis is performed : Select an )
autoanalysis
(+ Orly when the resutts group iz complete option

" \hen every run completes

If You Select ...

Then ...

Use with Settings from Analysis Tab
(page 117)

Only when the result group
is complete

When every run completes

Samples are analyzed after all pending
samples using the same results group
have been run.

Samples are analyzed after each run of
16 or 4 samples.

8. Click ok | to save the Results Group.

118

Do Autoanalysis and Results Entry
Group Complete

Do Autoanalysis
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Completing the Sample File Name Format Pane

1. Type a prefix for the file name in the Prefix box. Sample File Mame Formet
Anything that you type here is shown in the Example:  MJD_ i
Example line. T
Prefix: MJD
2. Click the Name Delimiter list choose the Sample File Mame Forrmat
symbol that will separate the Format elements in Example: MJD$007 $2002-04-21 §hir Holmes§|
the file name (see step 3 below). Only one T 7‘ / /
delimiter symbol may be chosen. Prefie |
Mame Delimiter |$__'
Format

Canpillary ... :L ft7 | [ownerma. =] |
Ny
|

Suffi _
a

3. Click the Format list and then select the ~Sample File Name Format
components that you want in the sample name. Example: MJD_007 <None>
N@berofcharacters:mto
. Prefix: IMJ)
Note: All the samples from a single run can be
. Marne Delimiterl__a
placed in the same run or results folder; the name ot 5
of every sample from a single run should be [Capmaw Number\\ Bll<none>
different. Most of the Format options will not be =none= 2
. =]
different between samples; select at least one of E::;L‘fsiﬁopc’;aﬁ -
the options to make the sample names unique | |capiltary array Serid) Number |
within a run. Capillary Nurmber
Date
Instrument Mame
I@wnerName ) -
If a unique identifier is not included in the name, Sample File Name Format
a Warning message displays.Select from the Example: BasecallerProtocol.saz.abi
elements to make a unique sample ﬁle name. . ;NVAL'DDT:ME: Filename does not have a unigue identifier in it.
Examples are: '
p . Mame Delimiter |_ =
— Well position Farmat
. Analysis Protocol Name 7| |=none=
— Capillary number
Suffix:
— Run sequence number
Plate Quadrant File Extension 3b1

Warning message

Note: Some identifiers, such as well position,
capillary number and plate quadrant are not
unique in multiple sample instances. Plate
Quadrant is not a unique identifier for a 96-well
plate.
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As you select the elements for the file name, they
are placed in the Example line. An additional
element drop-down menu displays allowing you
the option of selecting an additional element.

~Sample Flln Karma Farmgt

Example M.JD O07_2007904-21_hir mes_Safpled =k =
fMnber of cha/acters:29 to K

Prefis @
Marne D lirmiter |_

Faormat Y
’LCamHarv Nu)_l(Dale ;lQOwnerName)_leSamme Name)j nones

[ |

Suffix |

File Extension <Mone=

LWTIET PTG

Flate Mame __
Palyrmer Marre
Fun Marme -
The names of the Format elements eventually
truncate, but the Example field remains visible
(up to 72 characters).
—Sample File Mame Format
Example: MJD_007_TheFhiladelphiaProject_BasecallerProtocol.zaz_DummyCapSerMum-1234.
Mumber of characters:a3 to
Prefix: IMJD
Mame Delimiter I_ 'l

Format
“o... =R == e = o = n.. =l o =l r.. =l =iy =l <. =]

4. Click the Suffix box (optional) and type the
suffix for the file name.

The File Extension field displays the file
extension generated from the Analysis Type
specified on the Analysis tab (see page 116). For
example, Sequencing Analysis produces sample
files with an .ab1 extension.

Run Folder/Sub-Folder Name Format Pane

Follow the same steps described above for the Sample
File Name Format pane (see page 119) to change the
sub-folder name within the run folder.
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Importing and Exporting a Results Group

Importing or exporting of GeneMapper software
Results Groups are not supported for transfer between
separate computers.

Importing a Results Group

1. In the tree pane of the Data Collection software,
click £ GA Instruments > @ Results Group.

2. Click Import
A standard File Import dialog box displays.
3. Navigate to the file you want to import.
Note: Import file type is .xml (XML file).
4. Click Open

Note: When you import or duplicate a Results
Group, you are asked to type a name for the new
Results Group and for the analysis application

type.
Exporting a Results Group

1. In the tree pane of the Data Collection software,
click £ GA Instruments > @ Results Group.

2. Click the Results Group name to select it.

3. Click Export

A standard file export dialog box displays with
the chosen Results Group name.

4. Navigate to the location where you want to save
the exported file.

5. Click sawe

Note: If there is a name conflict with a Results
Group that already exists at the save location, the
Results groups can be duplicated in order to copy
settings into a similar Results Group without the
risk of user error when copying it manually (see
“Duplicating a Results Group” on page 122).
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Duplicating a Results Group

1. Click the Results Group.

2. Click Duplicate .

Note: When you import or duplicate a Results
Group, you are asked to type a name for the new
Results Group and for the analysis application

type.
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Creating the Plate Record for Autoanalysis

1. In the tree pane of the Data Collection software,
click £ GA Instruments > | ga3130x/ or
ga3130 > i Plate Manager.

2. Click pnew.. to open New Plate Dialog.

3. Complete the information in the New Plate
Dialog:

a.
b.

C.

Type a name for the plate.
Type a description for the plate (optional).

Select your GeneMapper application in the
Application drop-down list.

. Select 96-well or 384-well in the Plate Type

drop-down list.
Type a name for the owner.

Type a name for the operator.

Click ok |

The GeneMapper software Plate Editor
opens.

Chapter 6 Autoanalysis and Fragment Analysis

Creating a GeneMapper Software Plate Record

E---AGA Instrumetits

[ ﬂ] Results Group

""" =) Database Manager

=Bl ga130
EH plste Mananer
%I Protocal Manager
E& Module Manager
"'“Run History
(P Dav idPTS

.New Plate Dialog

ame: ||

Description:

Application: INone

Plate Type: |95 el | =

Crener hlame: I

Operator Mame: I

OK | Cancel |
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Completing a GeneMapper Software Plate
Record for Autoanalysis

1. In the Sample Name column of a row, enter a 1 2 3 4 5
sample name, then click the next cell. The value | | | |
100 aUtomaticaHy dlsplay il’l the Priority COlumn' el Sample Mame | Commert Priority Sample Type Size Standard

A
2. In the Comment column, enter any additional =

comments or notations for the sample. EE:

EO1

3. In the Priority column, change the priority value, Fo1

if desired.

4. In the Sample Type column, select a sample type
from the drop-down list.

5. In the Size Standard column, select a size
standard from the drop-down list.

6. In the Panel column, select a panel from the 6 7 8

9
drop-down list. | |

. Panel Analysis Method | Snp Set Uzer-Defined 1 Uzer-Defined 2
7. In the Analysis Method column, select a method

from the drop-down list.
8. In the Snp Set column, select a SNP set from the
drop-down lis if applicable, otherwise select

None.

9. Enter text for User-Defined columns 1 to 3.

10. In the Results Group 1 column, create a new 9 10 11
Results Group or select a group from the drop-
down list (see page 115). User-Defined 3 | Results Group 1 | Instrument Protacal 1

11. In the Instrument Protocol 1 column, create a
new instrument protocol or select a protocol from
the drop-down list (see page 112).
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Creating a GeneMapper Software Plate Record

12. To complete the plate record:

* For the same samples and protocols —
Highlight the entire row, then select Edit > Fill Down Ch4D
Fill Down Special. Copy Chri+C
aske tl
Based on your plate type (96- or 384-well) o ons  eesoete
and capillary array (16 or 4 capillaries), the Fill Dowin Special Alt+D

software automatically fills in the Add Sample Run_ Alt+A
appropriate well numbers for a single run.

* For the same samples and protocols —
Highlight the entire row, then select Edit >
Fill Down.

* For the different samples and protocols —
Complete the entries manually.

13. To do more than one run, select Edit > Add
Sample Run. Fill Down 4D
.- Copy Chrl+C
Additional Results Group, Instrument Protocol Paste Chiay
and Analysis Protocol columns are added to the Clear row(s)  Shift+Delete
right end of the plate record. Fil Dawin Special Al+D

Add Sample Run - Alk+a

Add additional runs by selecting Edit > Add
Sample Run again.

14. Complete the columns for the additional runs.

15. Click _ ok | to save, then close the plate record.

IMPORTANT! After clicking OK in the Plate
Editor, the plate record is stored in the Plate
Manager database and can now be located,
edited, exported, or deleted.
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Chapter 7 Running the Instrument
h Preparing Samples and Plate Assemblies

Preparing Samples and Plate Assemblies

Review Table

Generalized sample preparation and plate assembly
procedures are discussed in Chapter 3, “Performing a
Spectral Calibration,” on page 27.

Topic... See

Sample Preparation “Preparing the Calibration Standard” on page 31 and “Loading
Samples” on page 32 to review handling samples.

Follow your individual kit protocol to prepare sample load
volume:

10 to 30 pL for a 96-well plate
5to 15 pL for a 384-well plate

Sealing plates and plate assembly “Seal the plate:” on page 33.
Placing plate assemblies in the instrument “Placing the Plate Assembly into the Instrument” on page 39.
Searching for plate records to link to a plate “Running the Spectral Calibration Plate” on page 40.

Linking and Unlinking a Plate

Link a plate on the autosampler to your newly created
plate record before running the plate.

Select the desired plate record, then click the plate

position indicator corresponding to the plate position A Istmerts » 933120 » DsVdPTé » R Scheser
in the instrument. The plate position (A or B) displays P s teing [rese e

. . Type of Search.  |[Barcode ¥

in the link column. " -

Scan or Type Plate ID

Search | Stop | Fited A1l I™ Append Resutts

Note: The 3130 genetic analyzer has only one plate
position (B) to link a plate record.

Link | Plate Narme Application

Seql i
SpectralRun_»3_50cm  Spectral Calibration processed  §,
bap1 SeguencingAnalysis  pending [

The plate position indicator changes from yellow to bap? Sequencingénaeis penting
green when linked and the green run button -
becomes active.
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Unlinking a Plate Record

1. Click the plate record that you want to unlink.

2. Click

Linlink

Viewing the Run Schedule

For more information on run scheduling and sample
injection order, see “Plate Mapping” on page 161.

To verify that runs are scheduled correctly:

1. In the tree pane of the Data Collection software,
click £ GA Instruments > | ga3130x/ or
2a3130 > 3 instrument name > & Run
Scheduler > = Run View.

Select a row for any run. The corresponding
wells to be injected for that run are highlighted in
the plate diagram.

Search | Stop

Chapter 7 Running the Instrument
Linking and Unlinking a Plate

| Find 21

[ append Results

Link | Flate Name

| Application

Status [E

Sega_1

d

alRun_vw3_50cm

SeguencingAnalysis

processed

bapl SeguencingAnalysis  pending ¢
hap2 SeguencingAnalysis  pending ¢
q »
Urlink
edto Bay 0 Mo Current

mFoundation Data Collection Yersion 3.0
File Wiew Instrument Service Tools ‘Wizards Help

- Mo User is logged in

[ B B 8 I | £

G4 Instruments

ﬂ] Results Group

Diatabase Manager

B gaz30w
[E]Plate Manager

- P DavidPT4
@Ins{rumem Status

iSpaﬁaI Run Scheduler
Run Scheduler
B Piate view
Run
i ECapillaries Wiewver

GA Instruments = ga3130x = DavidPT4 = Run Scheduler = Run Yiew

Run RunlD Run Type Maodule Status | /3
1 |Run_David PFT4_20.. |Regular |StdSeqs0_POPGE_1  [Validated :l

2 |Run_David PT4_20.. [Regular |StdSeqS0_POFPE_1  |Walidated

3 Walid 15
4

5 _ _20.. _ A- Segh_2

6 |Run_David PT4_20.. |Regular |StdSegS0_POPE_1  |Validated | @ E oD oC
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Chapter 7 Running the Instrument
Running the Instrument

Running the Instrument

Starting the Run

1. Verify that the active spectral calibration matches
your dye set and capillary array length for all
scheduled runs.

To change the active spectral calibration, see
“Activating a Spectral Calibration” on page 47.

To create a new spectral calibration, see

“Creating a Spectral Instrument Protocol” on
page 35.

2. Click the green button in the toolbar.

(> E B » u |

3. The Processing Plates dialog box opens, then Process Pl 4 x|

click ok |

@ You are about ko skart processing plates. ..
Zancel |

The software automatically performs a run
validation:

 If the validation passes, the run starts

 If any of the validation test fails, the run

130

does not start. Check the event log for
information.
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Running the Instrument F

Starting the Autoanalysis Manager for
SeqScape and/or GeneMapper Software

Use the Autoanalysis Manager (AAM) software with
SeqScape® and/or GeneMapper® software to
automatically analyze the data.

1. Select Start > Programs > Applied Biosystems
> Autoanalysis Manager > Autoanalysis
Manager 3.0.

Note: Autoanalysis Manager does not start
automatically. Open Autoanalysis Manager to
receive messages from the data collection
software for autoanalysis in SeqScape and/or
GeneMapper software.

The Autoanalysis Manager window opens.

{# Autoanalysis Manager 3.0 |

File Edit Help

Jok Analysiz Crder Application # of Samples Artival Date Completed Date Status Status Messa

2. Quit the SeqScape and/or GeneMapper software.

No other interaction with the AAM software is
needed until the runs finish. See “Using
Autoanalysis Manager Software” on page 155 on
how to use the Autoanalysis Manager.
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- Running the Instrument

Basic Run Module Automated module steps when the run starts

Steps

DNA Sequencing
Run Times

132

Module Steps

Approximate Time

Turn Oven On

N/A

Wait for oven to equilibrate
Initialize autosampler

1 min 40 sec

Fill Array 3-4 min
PreRun 3 min

Inject samples 10 to 30 sec
Start separation 10 min
Ramp voltage

Collect Data Variable

Run ends: Until next run starts
Leave oven on

Laser to idle

Total time prior to separation:

e QOven unheated: ~25 min

e QOven at set temperature: ~6.5 min

To customize a run module, see the Applied Biosystems 3130/3130xl Genetic Analyzers

Maintenance, Troubleshooting and Reference Guide.

Note: The PostBatch Utility, which runs automatically, turns off both the oven and the

laser at end of a batch of runs.

Approximate run times of common DNA sequencing analysis runs

Type of Run Run Module Run Time (min)

Ultra rapid UltraSeq36_POP4 40

UltraSeq36_POP7 35

Rapid RapidSeq36_POP6 60
RapidSeq36_POP7

Fast FastSeq50_POP7 60

Standard StdSeg50_POP4 100

StdSeq50_POP6 150

StdSeqg50_POP7 120

Long read LongSeq80_POP4 210

LongSeq80_POP7 170
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Controlling the Run h

Fragment Approximate run times of common fragment analysis runs
Analysis Run

Times Type of Run Run Modules RIJ(rrL'iI'ri‘Te
High Throughput, Small Size FragmentAnalysis22_POP4 20
Fragment Analysis SNP22 POP4 20
Standard Fragment Analysis FragmentAnalysis36_POP4 45
HIDFragmentAnalysis36_POP4 45
SNP36_POP4 30
FragmentAnalysis36_POP7 35
FragmentAnalysis50_POP4 65
FragmentAnalysis50_POP6 90
FragmentAnalysis50_POP7 50

For the latest size standard modules (for example, run modules for the LIZ 1200 system),
go to http://www.appliedbiosystems.com, then click the link for Support, then Software
Downloads, then GeneScan"" Size Standards, then Run Modules.

Controlling the Run

Using the Toolbar Use the toolbar at the top of the data collection software window to control the run.

> H | B 1|

Click ... Description
F' | Starts the run
Start Run
Stops the current run, and all other
l scheduled runs
Stop

Completes the current run, then stops
_| all other scheduled runs

Stop After Current Run
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| Set Up for Continuous Operation

Click ... Description
Stops the current run, then starts the
'H' other scheduled runs

Skip to Next Run

| Pauses the current run?

Pause Run

a Pausing the instrument for too long, especially after sample injection, will adversely
affect data quality.

Set Up for Continuous Operation

Overview  Use the continuous run feature to create and link a plate during a run. You can:

* Run one or more plates
* Remove the plate(s) once samples have run

* Link and run additional plates
When using the continuous run feature:

* Only mount or unmount plates when the instrument is paused.

* Create the plate record before pausing the instrument to make linking more
efficient, reducing long pauses.

* Link new plates after a run has resumed.

Adding or During a run, you can mount and unmount plates while the instrument is paused. The
Replacing a Plate plate record can be created, then linked after the run has been resumed.

During a Run If the plate is in use, see “Adding, Replacing, or Removing a Plate During a Run” on

page 135.

IMPORTANT! Pausing the instrument for too long, especially after sample injection, will
affect data quality.
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Set Up for Continuous Operation

Adding, Replacing, or Removing a Plate
During a Run

Replace a completed plate or add a new plate to an
unused plate bay (3130x/ genetic analyzer only).

1. Prepare your plate and create the plate record.

2. Click Q (Pause).

In the Pause dlalog box, read the pause warning, @ Run quality will be deqgraded by pausing after sample
. injection!
then click ak  to pause the run.

To minimize degradation, allow current run to complete
electrophoresis before pausing,
Press OF ko pause the instrument during current run,

Cancel |

The Resume run dialog box opens when the run — E x|

is paused.
& Instrument Paused Press OK to resume

IMPORTANT! Do not click OK to resume the
run. Temporarily ignore the dialog box.

3. Remove the old plate, if applicable.

a. Press the Tray button to bring the
autosampler forward.

b. Open the instrument door.

c. Remove the old plate.
Mount the new plate.
Close the door.

Click OK in the Resume Run dialog box.

N o a &

In the Completed Run dialog box, click = gk to P—— x|
continue if the samples have been injected, or
click cancel to abort the run and return the
instrument to an idle state.

Zurrent run can only continue iF samples have been injected.
Press OF if samples have been injected or Cancel to Abort,

i Zancel |

IMPORTANT! If you click OK, the instrument
will continue running the current run regardless
of whether the samples have actually been
injected or not. If the samples have not been
injected, the samples will be injected from the
new plate.
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| Set Up for Continuous Operation

8. Search for the plate record, then link the new
plate.

The new plate runs after the current plate
completes all scheduled injections.

Note: If you unmount the currently running
plate prior to the first frame of data being
collected but after sample injection (clicked OK
to continue), the plate status changes to
processed even though the run is actually
continuing.
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Set Up for Continuous Operation

Viewing Data During a Run

Run Scheduler > In the tree pane of the Data Collection software, click
Plate View & GA Instruments > | ga3130x/ or ga3130 > & instrument name > ™ Run
Scheduler > &= Plate View.

Note: The #1 Run Scheduler and ® Plate View windows display the same
information.

m Foundation Data Collection Version 3.0 - Mo User is logged in
File Wiew Instrument Service Tools ‘Wizards  Help
EHEPIN
= G4 Inst rit:
A Instrumerts P G lInstruments > ga 31304 > iDev > Run Scheduler = Plate Yiew
ﬂ] Results Group

= Database Manager

= Find Plates Matching These Criteria
= B ga330x

EEPlate Manager Type of Search:
%I Protocal Manager
Iiﬁr‘\ﬂodule Manager Scan or Type Plate 1D
CHRun History
= ChiDev | |

[Einstrument Status -
| spatial Fun Schedul [[] Append Resutts

= ERun Scheduler

Link | Plate Marme Application Status
Egiﬁ:r?ezli\i:wer SEQs=ite2d SeguencingAnalysis  pending-no samples defi
-Capwray iewer SpectralZ_run3 Spectral Calibration pending-na samples defi
R spectral Wiewer SpectralZrun2 Spectral Calibration  pending-no samples defi
éfr?Manual Cortral Spectral_Z_Run  Spectral Calibration pending-na samples defi
[Edservice Log opt-6 SeqScape pending-no samples defi
rahin Genelapper pending-na samples defi A E:
Seqguen pending
site23 SegScape pending-na samples defi
testrun20 SegScape pending-na samples defi
< 1] | >
< 1l | ¥
System Status P |Plate A 96 well mounted Mo Current Run
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Set Up for Continuous Operation

Run Scheduler > In the tree pane of the Data Collection software, click
Run View & GA Instruments > £ ga3130x!/ or ga3130 > J instrument name > ™ Run
Scheduler > i Run View to monitor the status of the scheduled runs.

‘oundation Data Collection Yersion 3.0 - NoUser is logged in 10l =|
File Wiew Instrument Service Tools ‘Wizards Help

> B B » I | A

G4 Instruments

ﬂ] Results Group
Diatabase Manager
ga3z0u

[E]Plate Manager
%I Protocal Manager
Iiﬁr‘\ﬂodule Manager

4
B GA Instruments = ga3130xd = DavidPT4 = Run Scheduler = Run Yiew

14 1

Run RunlD Run Type Maodule Status |
Run_David FT4_20... |Regular |StdSeqs0_POPE_1  |[Validated :l
Run_David FT4_20... |Regular |StdSeqs0_POPE_1  |[Validated
Run_David FT4_20... |Regular |StdSeqs0_POPE_1  |[Validated
ar B_1 v d
Run_David FT4_20... |Regular |StdSeqs0_POPE_1  |[Validated A- Segh_2 E
|Run_David PT4_20... [Regular [StdSeq50_POPE_1  [validated | @ E D oCoE o

- P DavidPT4
E---l:]lnstrument Status

EEPT Chart
Event Log
Spatial Run Scheduler
Run Scheduler

Capillaries Wiewer _

-Cap.fArray Wiewver
----- nSpedraI Wiewver P
----- éTrTManual Cortrol 1=
----- Service Log

| Site 2 | Site 4 |

| Site 1 | Site 3 |

Systemn Status P IPIate Seqd_2 haz been linked to Bay 0 I Mo Current Run

Note: For default load maps, see Appendix A, “Plate Mapping.”

Notes
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Instrument Status

Open the Event Log to monitor ——

system messages

Chapter 7 Running the Instrument
Set Up for Continuous Operation

In the tree pane of the Data Collection software, click
A GA Instruments > £7| ga3130x/ or ga3130 > 2 instrument name > [5% Instrument
Status to monitor the status of the instrument or the current run.

System Status must be
‘Ready’ before a run starts

»

Array and polymer information

mFoundation Data Collection Yersion 3.0 No User is logged in -3l x|
File WView Service Tools ‘Wizards Help
|b|l TR
F|
= A Eﬂ';ﬂr“;"egs Y GAInstruments = ga3130 = 3130-019 » Insfrument Status
esults Group
ED&ﬂabase Marager [~ Status Overvie
=] 3130
b |Plate Manager Instrument I 3130-019 Array Serial Mumber:  capsl
%Pro{ncol Marwmger RunID:  Run_3130-019_2006-09-05_17-46_0122 Array Length: 50 om
aMaciule Marager Plte Name:  seq_1_2 Array Usage: 122
Bl Run History Systgm Status:  Processing Palymer Type:  POPE
= ? ~Sensor es—— | [Sensor Yalu - Evert:
H Instrument Status, _ _ I SL30-10L OO I=Us=08_15— UL SLELUS IEs CIEges o
BIEPT Chart Leser, ™= On EP oltage EP Current = = = = -
: E it _a00 K s Fun 3130-019_2003-09-038_15-29_0171 status has changed to
@S at\av\eRur:Sihedu\ e e Fun_3130-015_2003-09-06_15-28 0172 status has changed to
g -Rzn Scheduler G — @ 123 h22 Fun_3130-015_2003-09-08_15-29_0173 status has changed to
it Vi Frort Doors: == Closed = Rum_3130-019_2003-09-08_15-25_0174 status has changed to
L Run View Cven Door: ™ Clozed Faa Fun_3130-019_2Z003-09-08_15-29_0175 status has changed to
=Capillaries Wigwer Autosampler: == Return £ Fun_3130-019_2003-09-05_15-29_0176 status has changed to
-Cap.l’Array Wiewer 1 ey Pomer— —leser GiEil— P 3130-018_2003-09-038_15-20_0177 =tatus has changed to
nSpectra\ iger 250 A A Fun 3130-019_2003-09-03_15-29_0178 status has changed to
éfr?Manual Cortrol E20.0 Fur_3130-019_2003-09-08_15-29_0179 status has changed to
Service Log 150 RS0 Fomy 3L30-019_2003-09-06_15-29_0180 status has changed to
_m_ﬁ - Fur 3130-019 Z003-09-05 15-29 0131 status has changed to
Eso Fury_3130-019_2003-09-08_15-29_0182 status has changed to
Eon Plate seq_l_3 has been linked to Bay 1
-
Owen Temp—— ‘l | _’lj
FE5.0 HE

| | ol

E36.8
E27.4
E48.0

L suﬁo 50.0

Error

System Status }
I

IPIata se0_1_3 has been linked to Bay 1

System Status changes from green to flashing
red when errors occur, see Event Log.
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Set Up for Continuous Operation

Instrument Condition Sensor States Pane

The color of the indicator provides a quick way to check the status of the item to the left.
See the table below for a definition of each color.

Front Doors

Doors are closed

Doors are open

For... A green box _A t:ed box A ye_IIow box
indicates... indicates... indicates...
Laser Laser is off Laseris on Laser is idle
EP Electrophoresis is off Electrophoresis is on —
Oven Oven is off Ovenis on —

Oven Door

Door is closed

Door is open

Autosampler is homed

Autosampler is forward

Autosampler

Events Box
The Events box lists the:

* Instrument’s recent actions
» Status of each capillary as passed or failed at the end of a spectral calibration

» Calibration data at the end of a spatial calibration

Some of the events listed in the Events box provide information for service engineers.

Errors Box
The Errors box lists errors that have occurred during the current run.

Some of the error messages provide information for service engineers. A “fatal” error
usually requires that you restart the data collection software.
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Set Up for Continuous Operation

Instrument Status In the tree pane of the Data Collection software, click A GA Instruments >
> EPT Chart | ga3130x/ or ga3130 > ¥ instrument name > = Instrument Status > | EPT
Chart. The EPT chart displays real-time electrophoresis (EP) data during a run.

undation Data Collection ¥Yersion 3.0 - NoUser is logged in =] S
File “Wiew Service Tools  Wizards Help
|=|m o b ul& & AR
4
= Ao nstrumerts M G Instruments = gaT30 > 3130-018 = Instrumert Status » EPT Chart
Reszults Group
E‘lDalabase Manager Parameter Color | Show I
0 Jga3130 110
-[EPiate Manager Epoltage (kv) -
...... & Protocal Manager o, EpCurtert (ma) I -
; Iﬁhﬂndule Manager 100 CreenTemp (C) - I
B Run History LazerPower (rid) - Il
E-EP3n-ma . -
- [ER nstrument Status aa = jaiEuiTenEl(E) ~
————
T JI( I CCDTemp (C) |~
- Event Log an rvenPelier Temp (C) - v
BB spatisl Fun Schedul LserCurrent (4) B -
- M Run Scheduler
- Plate View 70
- RN View
=Capillaries Wi
-Capmrray iever €0 J‘
nSpectral Wigner S
{W?Manual Coritral a0 J
Service Loy H
40 I
a0
20
./
10 —
=]
o]
=10
-20
o] 10 20 a0 40 a0
Titne Elapsed (minutes)
[V Show Legend
| | ¥
Syatem Status } IPIaie se0_1_3 has been linked to Bay 1

Notes
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Instrument Status In the tree pane of the Data Collection software, click A GA Instruments >
> Event Log £ ga3130x! or ga3130 > O instrument name > [z Instrument Status > =] Event
Log. The Event log itemizes events such as errors and general information for all data
collection steps.

Clear error messages by clicking Clear Errors. The System Status light flashes red until
all errors are cleared. Take corrective action based on error message.

Note: This view can also be used to monitor spectral calibration results in real time to
verify the capillary-by-capillary processing status.

.Foundation Data Collection Yersion 3.0 - Mo User is logged in - |EI|1|
File Wiew Service Tools ‘Wizards Help
> H B #» 0|
G2 Instruments : GA Instruments = ga3130 = iDev = Instrurment Status = Event Log
ﬂ]Resuns Group
i=dDatabase Manager Event Messages
ga3130
Plate Manager Type Drate Tirne Publisher Description
@y Protocol Manager ) Info 091503 151819 System Status: Postprocessing ;l
-%Module Manager & Infa 0a/15:03 1818149 SpectralRun, Spectral calibration has completed =
- CllRun History @ Error naf 503 181818 iDev Murnber of caps passed in spectral calibration: 0
= EiDey @ mta 0911503 151818 iDev Finished saving spectral calibration data
& Infa 0a/15:03 181816 iDew Saving spectral calibration data
& Infa 09/145/03 151816 iDey Capillary 4 failed calibration due to bad data : Insufficient numbe
Spatial Run Schedul @ Info 0a/15:03 181816 iDew Canpillary 3 failed calibration due to had data . Insufficient numbe
Run Scheduler & Infa 09/15/03 151816 iDe Capillary 2 failed calibration due to bad data : Insufiicient numbs
-Cap"'a”es Viewver @ o 09503 151815 iDev Capillary 1 failed calibration due to bad data © Insufficient numbe
Capihrray Viewer @ mio DBMEO3 151815 iDev Run_iDev_2003-03-15_15-15_0002 status has changed to Exir
nSpedraI et —_ R - e . . X -
éTrTManual Cortrol 4[ | 3
------ Service Log
Error Messages
Type Drate Tirne Publisher Description
@ Error 0a/15:03 181818 iDew Mumber of caps passed in spectral calibration: 0
1| | 3
‘I | _’I ( Clear Errors I >
QSystem Status @ j Syatem Status: Ready | Mo Current Ru

System Status } | <

Clear Errors changes the System status from red to green (ready state).
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Capillaries Viewer In the tree pane of the Data Collection software, click A GA Instruments > £/ ga3130
or ga3130x1 > =3 instrument name > = Capillaries Viewer. Use the Capillary Viewer
to examine the quality of the raw data during a run for several capillaries at once.

Click individual colors to view or hide them

.Fnundatinn Data Collection Yersion 3.0 No User is logged in eS|

File Wiew Service Tools MWizards Help

 E— Select check boxes
B TS | [E B

of capillaries to
= A GA Instruments display
ﬂ] Resutts Group

i) Database Manager 1 5 10 15
=Bl gas130x Selecteapillatiestodisplay @ # M F O C C C O DO CCCCCC
[E]Piste Manager —
@) Protocol Manager =
E todule Maracer
- CBlRun History
= iy
[E nstrument Status
Bl spatisl Run Schedul B
B8 Fun Scheduler ]
Intensity vs Sean Murnber
Bl Caprarray Viewer
ﬂSpedral Wigwer
WManual Cortral
(S service Log

4 ;
B GA Instrumerts = ga3130x = iDev = Capilary Viewer

+

+

BO00
Intensity vs Scan Nurmber

Raw,
multicomponented
data

BO00
Intensity vs Scan Nurmber

BO00
Intensity vs Scan Nurmber

w | ol | s —=

|Systam Status } ‘Collectmg data, " l B3, 1:13:23 retmalning

Check Boxes

Select the check boxes of the capillaries to view their electropherograms. The capillaries
are displayed in the order in which the boxes are checked. The more boxes that are
selected, the slower the refresh window rate.

Raw Data An electropherogram is a graph of relative dye concentration against time, plotted for
each dye. The displayed raw data has been corrected for spectral overlap
(multicomponented).

How to Zoom
To zoom in and out:

1. Select a rectangular area over the area of interest by holding down the mouse
button. Release the mouse button to zoom in.

2. Click & to return to full view.
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Cap/Array Viewer In the tree pane of the Data Collection software, click £ GA Instruments > £| ga3130
or ga3130x/ > 3 instrument name > B8 Cap/Array Viewer. Use the window during a
run to examine the quality of your data, which is displayed as color data for the entire
capillary array. You can view all the capillaries (vertical axis) as a function of time/scan
numbers (horizontal axis).

Click individual colors to view or hide them

.Fnundatiun Data Collection Yersion 3.0 - No User is logged in & ﬂ

File Wiew Service Tools ‘Wizards Hs\p,—|
I TR | [ B

= AGA Instruments
ﬂl Results Group

4
M GAInstruments = ga3130 = DavidPT3 = Array Viewer

=) Database Manager ADT 20
=8 ga3130 O
EEPiste Manager U
B Protocol hanager -20
E Module Manager 40
- CllRun History a0
= CIDavidPT3 -
- [E]instrument Status -20 RaW data
B =pstisl Run Schedul S Y display for
= MR Schedler ATRTONT selected
i Piate View S .
) Run e -140 140 Caplllary (4)
= Capillaries Viewer H12 3520 3640 3560 3HB0 3600 3R20  3F40  3FRO 3GBO 3TO0 370 3T40
Cs ver Intensity vs Scan Mumber
ﬂSpedra\ Vigwver -

é"ﬁ‘Manua\ Control Status for Run_DasidPT3_2003-06-26_12-22_0003

=dservice Log
Plate Mame: G5 _Sg[zctral Instrument Protocol: G5

Sample Name: G5 Analysis Protocol: none k

Capillary humber: 4

el Position: D01

1
A
Capillary
order —— Electrophero-

gram
displays

4

. ﬂ Plate ID:  Scan: Capillary : I
|System Status } |Cm|ecling data.." . %, 0016:39 remaining

0 » End
How to Zoom
To zoom in and out:

1. Select a rectangular area over the area of interest by holding down the mouse
button. Release the mouse button to zoom in.

2. Click & to return to full view.
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Working with Data in The Run History View

Run History Components

Elements of the
Run History Utility

collecting runs.

Use the Run History utility only with completed runs stored in the local 3130/3130x!
genetic analyzer Data Collection database. It does not provide real-time viewing of

In the left tree pane, click the icon next to the function to launch it.

Elements Within the Run History Utility

Element

o
o
3

EPT Viewer

-

Displays the...

Electrophoresis data of the run, such as voltage, current,
and oven temperature profiles.

Event Log

Event messages associated with the run.

Instrument
Protocol

Instrument protocol and run module settings used for the
run.

Spatial
Calibration
Viewer

Spatial calibration associated with the run.

Capillaries
Viewer

Cap/Array
Viewer

Individual electropherogram for each sample in the run.

Array view of the run.

Spectral
Viewer

Spectral calibration used for the run.

Reextraction

SEENE N

Extraction and analysis status for all samples in the run.
See “Viewing Autoextraction Results” on page 147 for
more details.

Note: If Cleanup Database has been used, you cannot view processed data in Run History.
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Viewing Data from a Completed Run in the Data Collection
Software

View data using two formats within the 3130/3130x!
genetic analyzer Data Collection software under the
Run History icon:

* In the Cap/Array Viewer window (in much the
same way that you might view the gel file output
from an ABI PrRISM® slab gel instrument).

* In the Capillary Viewer window, capillary-by-
capillary.

Viewing Data from a Completed Run

1. In the tree pane of the Data Collection software, e e Sean or Type Plate 10
. - 3 Im}mm
click £ GA Instruments > 7| ga3130x/ or T T viewer
. ElEvent Log
ga3130 > @ Run History to select the run you % nstruman Prcloso! seann_| | [ ]
. ‘Spal\a\ Calibration Viewer
want to view. Eg:s;n\:gx;wer Run Name Plate ID Plats t
R Spectral Calibration Viewe Run_Huahine, 9_3 D53 IPate
UE|Reextraction Run_Hushine_2002-10-18_20-37_7 DS33InstallPlate Ds33l
= ?%ﬁ:gfmgm St Run_Huahine_2002-10-18_20-37_8 DE3nstallPlate D33
: - EHEPT Chart Run_Huahine_3002-10-18_20-37_8 DS33InstallPlate Dg33l
2' Search for your run by either Barcode or - EvemL:n Run_Huahine_2002-10-18_20-37_10  DS33InstallFlate DE33l
Advanced search. Eﬁﬂi“iﬁﬁuiﬁ,ﬁ“”‘” Run_Huahine_2002-10-33_23-03_1 D533 DSa3i
B Capillary Viswsr Run_Huahine_2002-10-24_02-32_2 JaimeTest Jaime
=A"EVV\EWW Run_Huahine_2002-10-25_02-08_2 Yerification_Plate Verific
Spectral ¥
3 After ChOOSiIlg the run. click the run hiStOI‘y ﬁm‘;iz;c;‘:“"r’;’ Run_Huahine_2002-10-25_04-50_3 LREFlate LR&FI
- 4 = 5emice Log

elements, such as Cap/Array Viewer or the
Capillary Viewer from the left tree pane to look
at the run data.
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Viewing Autoextraction Results

Overview

Sample File
Destinations

Effects of
Changes Made in
the Reextraction
Panel

After a run is completed, extraction and analysis is performed automatically, using the
settings in the Plate Editor and the Results Group. View the results of extraction and
analysis in the Reextraction Panel. Reextract samples with the same settings, or with
different Analysis Protocols or Results Groups. This process can be useful for

many reasons:

* The destination location may not have been available during extraction.

* Some samples may have failed analysis and a different Analysis Protocol might be
more successful.

* Samples might be saved in different locations, or with no analysis at all to
save space.

* Sample names may need to be edited.

Locate the Results Group’s Naming Tab and check the Destination Tab and Run Folder
Name Format to find the sample file destination.

Changes made in the Reextraction Panel to a Results Group, Analysis protocol, sample
names, or Comments, also change in the original plate record. The original plate
information is overwritten.

Applied Biosystems 3130/3130x/ Genetic Analyzers Getting Started Guide 147




Chapter 7 Running the Instrument

h Viewing Autoextraction Results

Selecting and Queuing Samples for
Extraction

Queue individual samples for reextraction to
experiment with different Analysis Protocols for
samples that have failed initial extraction.

1.
2.

148

Click ﬂ (Run History).

Enter the plate name for a plate that has been
completed, or click Search. Plates that have runs
still pending cannot be reextracted. All the runs
from that plate appear in the window.

Select a run from the list.

...... W Madule Manager Scan ar Type Plate ID

Efe ]
Pobe EHEPT vigwer
-E]Event Log

-I@y Instrument Protacal

D333InstallPlate

Search | | Find All I

[l Spatial Calibration Viewsd

[ Capillary Viewer

- [ Array Viewer
--nSpectraI Calibration Yiewe
- TEReesxtraction

- EPHuahine

=24 Instrument Status
~[EPT Chart

- [E]Event Lag

Click (Reextraction) in the left tree pane to
display the Reextraction window.

Click the check boxes in the Extract column to
select the samples to be reextracted.

Click Extract to start the reextraction.

Run Mame

Run_Huahine_2002-10-15_04-09_3
Run_Huahine_2002-10-18_20-37_7
Run_Huahine_2002-10-18_20-37_8
Run_Huahine_2002-10-18_20-37_9
Run_Huahine_2002-10-18_20-37_10

Note: Reextracted sample files are saved in the
original folder that data was extracted to unless
this destination was changed through the Results
Group.

Flate IO
3InstallPlate
D333InstallPlate
D333InstallPlate
D333InstallPlate
D333InstallPlate

Flate Mame

D333InstallPlate
D333InstallPlate
D333InstallPlate
D333InstallPlate

Type

GeneMappe
GeneMappe
GeneMappe
GeneMappe
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Elements of the Reextraction Window

All the samples are displayed with the results of
extraction and analysis.

Note: Sort the columns of the re-extraction panel by
holding the shift key and then clicking on a column
header.

Reextraction Window for Sequencing Analysis

Use check boxes to
select samples to

be reextracted Selectarun

Chapter 7 Running the Instrument
Viewing Autoextraction Results

Results of extraction and analysis

oundation Data Collection ¥ersion 3.0 - Administrator user is logged in O 5[
File Wiew Edit Help
B Ao nstruments Y G stuments » 5313041 = Fun Hitory = Reestraction
|]: Resufts Group
- i) Database Manager -
- 074 B -
= E,|g63130x | Selept & run to view: |Run_Devid PTS_2003-07-08_14- 15_0004_'
-~ [EPiate Manager L
. % Protocol Manager Extract = Cap | well | Exdraction Resi, Resutts Group Analysis Protocol Arnalysis Resutt Score Satnple Marme o]
Mol Marager 3 et 3130POPE_BDTv3-HE-De | 31.048977 s
=l EBIRun History [ seda F130POPE_BDT3-KE-De | 307 s
EPT Higswer [ seqa HIDPOPE_BOTvI HEDe, 30370401 s
Ewent Lo
Ry ,nslwmeri Fratocol F seda 3130POPE_BDTv3-HE-De | 31.201584 s
.. Bl Spetial Callbration v [ serga 3130POPE_BDTv3-KE-De ,| 30.77367 s
B Capillaries Viewer = sega 3130POPE_EDTv3-HE-De 30.596704 s
.
Bl Capitrray Viswer [ e H130POPE_BOTv3-HE-De 043462 s
- [l Spectral Calioration
Resstraction 1= sega 3130POPE_BDTv3-KE-De ,| 30161597 s
5 (D DavidPTS [~ sega 3130POPE_EDTv3-HE-De 30.6584116 s
(= [E mstrument Status [ et 3130POPE_BDTv3-HE-De | 30.689853 s
i EPT Chart [ et 3130POPE_BOTvA-KEDe 31 220845 s
= |Event Lo
[ et Sgche il [ sega 3130POPE_EDTv3-HE-De 30.625536 s
- Bl Run Schecller [ et 3130POPE_BDTv3-HE-De | 30.507116 s
- EPlate View [ e 3130POPE_EDTY3-KE-De , | 30.35501 E
IR iew [ seqa HIDPOPE_BOTvI HEDe, 15218 s
=Capnlanes Yiewer
B Capitray Viswer [ et 3130POPE_BDTv3-HE-De | 31.374426 s
E‘Spectral Wiewer I LI

éﬂ-ﬁ?Manual Caortrol
Service Log

Extract |<— Click here to start extraction

Check Uncheck

Notes

Use these buttons if several samples
are highlighted
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Reextraction Window for Fragment Analysis

Use check boxes to select
samples to be reextracted Select a run Results of extraction

m&lundatiun Data Collection Yersion 3.0 - Administrator user is logged in i = 5[
File Wiew Edit Help

= ’_GA Instruments
Resufts Group
Database Manager

va

GA& Instruments = ga3130x1 = Run Histary = Reextraction

Selept & run to view: Run_DavidPTS_QUUS—D?—DSJB—18_UUUSL|

“|ga3130%1
- Plate Manager
. % Protocol Manaser Extract Extraction Rest,  Results Group Satnple Marme Cormment Sample Type Size Standatd Pt
[ Module Marager [ o _runkryrun B Sample G3500LIZ [
RN History [ dt_runkryrun s Sample GS500LIE D:
EPT Wieswer = gm_runkryrun H Sample GS500LIZ o
Evert Log
. %‘ Instrument Protocal ~ o _runkyrun 5 Sample GS500LIE D
.. Bl Spetial Callbration v [~ om_runkyrun s Samplz GSS00LIZ [
=Capnlanes Wigwer [ gt _runkeyrun s Sample GE500LIZ D:
- Bl capitrray Viewer [ Gim_runkrrun s Sample GS500LIZ [
Spectral Calibration
n F on_runkryrun E Sample GSS00LIE D
- CIDavidPTS [ am_runbyrun s Samplz GS500LIZ D
= E\nmrumem Status ~ gn_runkryrun = Sample GE500L1L D
i EPT Chart F on_runkryrun E Sample GSS00LIE D
Evert Log 1
iSpaﬁa\ Run Schedul [ gm_runkryrun E Sample GE500LIZ [}
= ) Run Scheduler ~ ot _runkerun = Samplz GE500L1L D
WPiste View [ gt _runkryrun s Sample GE500LIZ D
EiRun view [ gm_runkryrun E Sample GE500LIZ D
=Capnlanes Wiewer o pE—" ERULE ol
- -Cap.iArray Vigwver ~ gm_runiyrun s ample
E‘Spectral Wiewer I LI
éﬂ-ﬁ?Manual Caortrol
Service Log
- M Click here to start extraction - y—
Sl ] ¢

\
Use these buttons if several
samples are highlighted

Notes
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Results Column

Chapter 7 Running the Instrument
Viewing Autoextraction Results .

The results of extraction and analysis are color coded in the Results column. The
following table lists the colors and their values for Sequencing Analysis.

Color Value

Red Extraction or analysis failed
Note: Descriptive messages can be viewed by resizing the Results column to
view all text.

Yellow Warnings for extraction or analysis
Note: Descriptive messages can be viewed by resizing the Results column to
view all text.

Green Successful extraction (with no analysis intended), or successful extraction
and analysis.

The Results column, by default, shows only the beginning of any processing message.
The entire message and the sample file location can be viewed by expanding the cell.
There is a tooltip view for each sample results message.

Tooltip view. Access by placing the cursor over the sample of interest

. Foundation Data Collection Yersion 3.0
File “iew Edit Help

No User is logged in

= AGA Instrumerts
Results Group
= Database Manacer
= Blga31300
[E] Plate Manacer
%I Protocal Manager
Iiﬁr‘\ﬂodule Manacer
= EllRun History
EEPT viewer
Event Log

=Capillary “iewwver
-Cap.fArray “iewwver

|k {[u]y]
= CPDavidpT2

%I Instrument Protocol
B spatial Caliration i

R spectral Calibration

GA Instruments = ga3130x) = Run History = Reextraction

Select & run to view: |Run_DavidPT2_2DD4-1 0-29_19-19_0005 |+

Extract

H=

&

&

&

&

&

&

&

Cap | Well
1 A01
S| (=10}
5] co1
7 (au)]
g E01

11 Fo1
13 01
15 HO1
2 A02

Extraction Resi, Results Group Analysis Protocol Analysis Result Score

Segd-auto 3130POP7_BDTv3-KE-De 29672728
Seqd-auto 3130POP7_BDTv3-KE-De . 5234312
Seqd-auto 3130POP7_BDTv3-KE-De . 52317997
Ert-atn M ANPOPT BOTwI-KE-De 3.0
ile:\E: Y AppliedBiosystemsiudoidatacollectiont datalga3130:0,
avidPTZ\RUn_DavidPTZ_2004-10-29_19-19_0005iseq_005_CO1, 5378798
Segd-auto 3130POP7_BDTv3-KE-De ) <M
Seqd-auto 3130POP7_BDTv3-KE-De . 36.262295
Seqd-auto 3130POP7_BDTv3-KE-De . 54 028168
Seqd-auto 3130POP7_BDTv3-KE-De . 50

Drag the cell’s edge to expand the column
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[@ Foundation Data Collection ¥ersion 3.0

File “iew Edit Help

A3

- Mo User is logged in

= AGA Instrumerts
ﬂ] Results Group
= Database Manacer
= Blga31300
[E] Plate Manacer
%I Protocal Manager
Iiﬁr‘\ﬂodule Manacer
= EllRun History
EEPT viewer
Event Log
@y Instrumert Protocal

=Capillary “iewwver

-Cap.fArray “iewwver

R spectral Calibration

[EE]Resstraction]

= ) DavidPT2
= @Ins{rumem Status

EEPT Chart
Event Log

B spatial Fun Schedul

Quality Column

Notes

B spatial Caliration i

4
GA Instruments = ga3130x) = Run History = Reextraction

Select & run to viewy: [Run_DavidPT2_2004-10-29_19-19_0005

Extract = Cap lysis Protocol Analysis Result

1 JPOPT_BDTw3-KE-De
3 JPOPY_BDTw3-KE-De,
5 JPOPY_BDTw3-KE-De
7 JPOPY_BDTw3-KE-De,
9 JPOPY_BDTw3-KE-De,
11 JPOPT_EDTw3-KE-De

*
13 JPOPT_EDTw3-KE-De |
[w] 15 JPOPT_EDTw3-KE-De |

Expanded column

The Quality column represents the quality values for an entire sequence. Quality Values

are only assigned to analyzed samples when using the KB"" Basecaller.

Colors displayed and their associated value range

Color Quality Value Range
Red <15
Orange >15and <20
Yellow >20 and < 30
Green > 30
Note: For more information on KB Basecaller and Quality Values, see the Applied
Biosystems DNA Sequencing Analysis Software v5.1 User Guide, PN 4346366.

The column is empty (white) if:

* Analysis was not performed
* Analysis failed

» ABI Basecaller was used for analysis. This basecaller does not assign
Quality Values.
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Results Group and Analysis Protocol
Columns

You can edit and make changes for reextraction to the
Results Group and the Analysis Protocol (Analysis
Method in the GeneMapper® software).

Note: Select an entire column in the Reextraction
window by clicking on the column header. For
example, clicking on the Extract column header
selects all samples. Clicking the Uncheck or Check
buttons at the bottom of the window, enables or
disables the check boxes for each sample. The fill-
down command (Ctrl+D) works the same here as in
the Plate Editor for easier information input.

Sorting the Samples

1. Hold down the shift key while clicking on the
column header to sort samples according to the
column properties.

2. Shift-click again to sort them in reverse order.
Sort by:

* Capillary number
*  Well position

* Results

e Quality

¢ Extract column

Note: For example, bring all of the failed
analysis or extraction samples to the top of the
column. Now they can be viewed without having
to scroll down to each sample individually.
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Reextracting Selected Samples

1. Expand the Results column cells for any yellow
or red results to see a description of the warning
or failure.

2. If desired, select a new Results Group, or edit the
current one. Selecting a new Results Group
allows you to turn off autoanalysis, change the
samples and folder naming options, the location
where they are placed, and the owner of the
Results Group.

3. If desired, change the Analysis Protocol to
experiment with different ways of analyzing the
sample, using a different basecaller for example.

4. Check the check box in the Extract column for
the samples you wish to extract again.

5. Click Extract.

Note: Reextraction creates an entirely new
sample file and does not replace the previously
saved sample file. The presence of a previous
sample file has no effect on the creation of a new
sample file. If the same naming options that are
used for reextraction are identical to those used
previously, a number is appended to the
filename. For example, if the first sample is,
“sample 01.ab1” then the second sample would
be, “sample 01 (1).ab1.”
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Using Autoanalysis Manager Software

Use Autoanalysis Manager software with SeqScape and/or GeneMapper software. The
Autoanalysis Manager software is installed by the SeqScape or GeneMapper software
installation CD.

Autoanalysis occurs in the following sequence:

1. When data collection software finishes a run, the Message Service sends the
message “Run Completed.”

2. The Autoanalysis Manager receives the message, and the job is submitted. The job
appears in the General tab.

3. The Autoanalysis Manager polls for jobs every 2 minutes and opens the automated
processing version of SeqScape and/or GeneMapper software to analyze the data.

4. At the end of analysis, the status in the Autoanalysis Manager is updated.

Files Created The data collection software stores the sample files in the location specified in the results
group. The Autoanalysis Manager copies the files into the Data Store for SeqScape or
GeneMapper processing.

To maintain sufficient storage space on your hard drive, delete or transfer unnecessary
sample files to a different network or CD.

Autoanalyzed Note: If your GeneMapper or SeqScape software was opened during autoanalysis, then
Samples close your analysis application and relaunch the Autoanalysis Manager.

Once an internal message from the instrument is received by the Autoanalysis Manager,
it opens the automated processing version of SeqScape and/or GeneMapper software to
autoanalyze the samples. The standard user version of SeqScape and/or GeneMapper
software must be closed in order for autoanalysis to begin.
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Components

The Autoanalysis Manager has two or three tabs:

* General tab
* GeneMapper tab, if GeneMapper v3.7 or GeneMapper ID v3.2 software is installed
* SeqScape tab, if SeqScape software is installed

General Tab  The General tab shows the jobs that have been submitted and their status.

& Autoanalysis Manager 3.0 |:||§|g|
File Edit Help

GeneMapper v3.7 | SeqScape 2.5
Job Queue

Jok Analysiz Crder Application # of Samples Artival Date Completed Date Status Status Message

Command Buttons in the General Tab

Delete Job I [relete Completed Jobs | hdowve Job Up | hoe Job Drovn

Command Button Functions in the General Tab

Button Name Function

Delete Job Deletes an individual job/project from the Autoanalysis Manager
list.

Does not delete sample files, SeqScape or GeneMapper
software project.

Delete Completed Jobs Deletes all completed jobs/projects from the Autoanalysis
Manager list. Only successful jobs are deleted.

Does not delete sample files, SeqScape or GeneMapper
software projects.

Move Job Up The active job/project is always given a queue number of 1. Once
job 1 is finished analyzing, job 2 becomes job 1 and all other
numbers are changed accordingly. Use the Move Up/Down
buttons if you want to rearrange the analysis order.

Move Job Down
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GeneMapper The GeneMapper software tab shows the jobs that have been submitted and their status.
Software Tab

i Autoanalysis Manager 3.0

File Edit Help

SeqScape 2.5
GeneMapper Job Queue

General |}

# Jokb/Project User # of Samples  Arrival Date Completed Date Status Status Mess

Configure Schedule

Command Buttons in the GeneMapper Software Tab

Configure Schedule | Edit Properies | Requeue Job | [Delete Job | [elete Completed Jobs

Command Button Functions in the GeneMapper Software Tab

Button Name Function

Configure Schedule e Next Analysis Time:

Enables you to set a start time for autoanalysis. Before this
time arrives, autoanalysis of projects will not occur.

¢ Periods restricting automated analysis:

Enables you to set times during which autoanalysis will not
occur. Useful if you know that you are going to be reviewing
data during a certain time period and don’t want to be
bothered by the “Runs ready for processing” dialog box. Runs
build up in the queue until the restricting time period is over at
which time the runs will be autoanalyzed.

e Automatic Deletion of Completed Jobs:

Enables you to set the software to automatically delete
successfully completed jobs. Jobs that failed or have not been
analyzed will not be deleted. Only the Autoanalysis Manager
job is deleted, sample files and GeneMapper software projects
are not.

Edit Properties Enables you to change the following settings:

e Job/Project Name
e UserName: GeneMapper software UserName

e Password: Matching password for GeneMapper software
UserName

e Queue position: Enter a new queue position number for the
project
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Button Name Function

Requeue Job e Samples that need to be autoanalyzed have queue numbers
listed in the # column.

e Samples that are already analyzed or failed, have a blank cell
in the # column.

To resubmit a job for autoanalysis, use the Requeue Job
button to assign a queue number to that job.

Delete Job e Deletes an individual job/project from the AutoAnalysis
Manager list.

Does not delete sample files or GeneMapper software project.
Delete Completed Jobs e Deletes all completed jobs/projects from the AutoAnalysis
Manager list. Only successful jobs are deleted.

Does not delete sample files or GeneMapper software
projects.
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SeqScape The SeqScape software tab shows the jobs, project, and status information.

Software Tab

] Autoanalysis Manager 3.0

File Edit Help
Genersl | GeneMapper va 7 || SenScape 2.5
SeqScape Job Queue
Jok Project Artival Date Status Status Message

Command Button Functions in the SeqScape Software Tab

Button Name

Function

Details

Displays the project in the navigation pane

Details for Job "Run_SSIntegration_2002-08-23_16-59_1 - SeqS |
Bl E]HLA-C-3100

B -rn nds and 40904

Resubmit
Edit Properties

Delete

Submits a job for analysis
Edits the name and password (active only if analysis failed)

Deletes a job from the Autoanalysis Manager
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Viewing Analyzed Data

Locating Sample  Analyzed sample files are extracted into a run folder defined in the Naming tab of your
Files Results Group, and placed in a location defined in the Destination tab.

The default location is:

E:\AppliedBiosystems\UDC\Data Collection\Data\ <instrument type>\<instrument
name>\<Run Name>

& bapl_2003-09-03 (=S

JFiIe Edit  Wiew Fawvorites Tools  Help ﬁ

J &iBack - = - | iChsearch Ly Folders £ 4History |E‘ Lr S | £~

J Address I[:I E:\appliedBiosy stemsiUDC\DataCallectiont Data\bapl _2003-09-03 j f? Go

= bad . —7 Marne | Size | Type © | Modified |
"D L W06 _Hoz_19-11-51 253KEB  AB1 File 9}3/2003 7116 PM
= B015_Ho1_19-11-51 Z65KE  AB1 File 932003 7118 PM
bapl_2003-09-03 W14 Goz_19-11-51 252 KB AB1 File 932003 7116 PM
W013_Go1_19-11-51 270KE  AB1 File 932003 7118 PM
Select an item to wiew its Wlo1z_Foz_19-11-51 2F0KE  AB1 File 9)3/2003 7:15 PM
description, 011 _Fo1_19-11-51 269KE  AB1 File 932003 7118 PM
ee ale: Boio Eoz_19-11-51  269KE ABL File S3(2003 7:16 FM

o9 _EF01_19-11-51 270KE  AB1 File 9/3/2003 7:18 PM

[y Docurments
My Mebwark Places 005_D0Z_19-11-51 2F0KE  AB1 File 9)3/2003 7:17 PM
My Computer 007_D01_19-11-51 Z70KE  AB1 File 9)5/2003 7:17 PM
006_C02_19-11-51 269KE  AB1 File 9)3/2003 7:17 PM
005_C01_19-11-51 Z69KE  AB1 File 9)5/2003 7:17 PM
¥o04_poz_19-11-51 2F0KE  AB1 File 9)3/2003 7:17 PM
005 _po1_19-11-51 Z70KE  AB1 File 9)5/2003 7:17 PM
Wooz_aoz_19-11-51 2F0KE  AB1 File 9)3/2003 7:17 PM
W001_a01_19-11-51 Z69KE  AB1 File 9)5/2003 7:17 PM
|16 chiect(s) 4,16 ME S vy Computer 4

Locating Sample Files

Locate the reextracted data in the location defined by the Results Group or the default
destination location.

Viewing Sample  Use the Sequencing Analysis, SeqScape, or the GeneMapper Software to view re-
Files extracted sample electropherogram data, both raw, and analyzed.

Sample file type File extension
Sequencing, SeqScape .ab1
Fragment analysis fsa
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Plate Mapping

Injection Scheduling

Samples are scheduled for injection based on their position in a 96-or 384-well plate and
the capillary number. Study the appropriate plate mapping patterns described in “96-
Well Plate Mapping” or “384-Well Plate Mapping” to arrange your samples according to
your preferred injection priority.

The injection schedule system is based on the:

* Order of the linked plates (3130x/ instrument only). See page 128 for linking plate
information.

» Sample priority value in the plate record.
If all priorities are set to 100 (default), then runs are scheduled as outlined below. See the

Applied Biosystems 3130/3130xl Genetic Analyzers Maintenance, Troubleshooting, and
Reference Guide on “Run Priority Scheduling”.

Capillary Array Map

The capillary numbers in the capillary array are shown in the layout below. The capillary
array layout is the same for both 96- and 384-well plates.

Capillary Number Layout

14 1
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Appendix A
96-Well Plate Mapping

96-Well Plate Mapping

3130x/ Genetic
Analyzer

3130 Genetic
Analyzer

162

For a 96-well plate, injections are made from every well in two consecutive rows,
starting with an odd row. A full 96-well plate requires six runs to inject all samples. See
the examples below where samples (grey) and capillary number (number) positions can

affect your number of runs.

Efficient Sample Placement

Inefficient Sample Placement

Inject 48 samples using three runs

POOOOOO®-
BHEDEEE®-
SIEOIOCICICIOE I
BARODEEDE-
POOOOODD-
OIOICIIDIOIOIOE

| Run1

—Run 3

Inject 32 samples using four runs

OICIIOIQIOJOJOK [
(16) (19) (12) (10) (8) (6) () (2)

OICIDIOIOICIOIOL IFA
(16) (14) (12) (10) (8) (6) (4) (2) »

PEOO0O®0| .
(18) (G4) (12) (10) (8) (6) (&) (2) >

CIOINOIGIOIOION

L Run 4

(1) (4) (2) (1) (3) (&) (&) (2) =

For a 96-well plate, injections are made from four consecutive wells in a row. A full plate
of 96 sample requires 24 runs to inject all samples once.

In the following example of a 96-well plate, the gray circles represent samples and the
number in the well indicates capillary number. It takes four runs to inject 16 samples.

v | Sooopewey

RN 10000} DIOJOJOL

QOOOOOO0-
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384-Well Plate Mapping

Appendix A
384-Well Plate Mapping

3130x/ Genetic  For a 384-well plate, injections are made from every other well and every other row. A
Analyzer full plate of 384 samples requires 24 runs to inject all samples once.

The example below is the injection pattern for the first four injections, starting with well

AO01. The light gray circles represent samples and the dark gray circles indicate the

injection pattern.

Run 1 Run 2

o) o)

E TOoOZZITr X T IOTMMOOT> E TOZZITMrXSETIOTMMOO >

g Jececeocececececef J|[@cecececececeoceo-

& Q0000000000000 0O0p 3||/c000000000000000N
O@0e0e0e00000000k 000000000000 0000
0000000000000 000-= 0000000000000 000=
0000000000000 000. 0000000000000 000w
aYatalatatatatalalatatatatatarar AN NANANANANANGN-)

Run 3 Run 4

ol o)

E TOZZIMrXSE T IOTMMOO®> E TOZZITrXE T IOTMMOOT>

2| ©000000000000000- 2 ©000000000000000-

S| JEOOOOOOOBGOB®O 000 s [ecececece000000n
Q0000000000000 00k 0000000000000 00e
0@00000000000000k 0000000000000 00-
0000000000000 00 0w 0000000000000 000w
ANV W NN W W N W N W Wl Wa W VA VNANA W NN W Wl W e W W W Wa WY

3130 Genetic  For a 384-well plate, injections are made from every other well. A full plate of 384
Analyzer sample requires 96 runs to inject all samples once.

The example below is the injection pattern for the first six injections, starting with well

AO01. The light gray circles represent samples and the dark gray circles indicate the

injection pattern.

Run 1 Run 2 Run 3
TOZEZTrX&S T IOTMMOOD > TOZZETrXS T IOTMMOO®W>» TOoOZZIT D XS T IOGTMMOO®>
0ooooo0000@eoceoceoe- ooooooodeoceoceoeo- o boooo0000-~

000000000 OOOOOOON
O0000OOOOOOOOOOOO=
O0000OOO0OO0OOOOOOO=
0000000 OOOOOOOOO
O0OO000O00000O00000000e

000000000 OOOOOOON
00000000000 OOOOOe
000000000 OOOOOOO-
OO0O00O0O0O0OOOOOOOOOO
OO0O00O000OO0O0OO0O0OOOO0O.

000000000 OOOOOOON
OO0O000O0O0OO0OOOOOO00O
000000000 OOOOOOO-
OO0O000OO0OO0OOOOOOO
OO0O0000OO0OO0O0OOOO0O00O.

Run 4 Run 5 Run 6

TOZZITCrX<S T IOTMMOO®T>» TOZEZITMrX&ETIOGTMMOO®D>» TOZZTrXe~-I@OTMMOOT>
000000000~ 0000000000000 0OO0-~ 0000000000000 OO0O-~

0000000000000 00ON 0000000000 eCeOdr ocoooooodeceoceoeon

000000000 OOOOOOO
000000000 OOOOOOO-
000000000 OOOOOOO
000000000 OOOOOOO.

OO0OO0O00O0O0OOOOOOOOOe
O00O00O0O0OOOOOOOOO-
000000000 OOOOOOO0
0000000 OOOOOOOOO.
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Appendix A
384-Well Plate Mapping
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options, SeqScape software 87 table, dye set and standard 29
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analyzing GeneMapper Software data 160 bold text, when to use ix
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function 11 making 16

Applied Biosystems buffer fill-line 12
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customer feedback on documentation x

Information Development department  x buffer valve pin, illustration of 12
Technical Support  xi
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capillaries viewer 143
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capillary array viewing analyzed sequencing data 160

function 11 viewing complete run 146
illustration of 12 Data Collection software
installing or replacing 13 starting 9
capillary array knob and tip, illustration of 12 data collection software, starting 9
capillary array length destinations 147
polymer type, table 36 detection cell block and heater
cathode buffer reservoir, filling 17 function 11
CAUTION documentation
description  xiv GeneMapper Software User Guide (PN) 106
example xv related X
Change Polymer Type Wizard, using 15 double-tapered ferrule, illustration of 12
characters dye primer chemistry, information table 67
acceptable 54, 83, 106 dye set
CheCl.i valve fragment analysis 30, 114
diagram of 12 table, sequencing 29
chemical safety  xviii Dye Terminator chemistry, files 66
chemical safety guidelines xix DyeSet/Primer files 66, 67
chemical waste listof 64,94
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safety xx E

safety guidelines xx

chemical waste disposal, guidelines xx E dye set, sequencing kit table 61

electrical hazard symbol  xvi

computer

assigning a unique name 9 electrical safety  xxi

starting 7 electrical shock hazards xxi
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conventions electrode, illustration of 12

bold text ix
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in this guide  ix L
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menu commands  ix EMC standards  xxiii
Notes ix Australian  xxiii
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conventions, safety xiv European  xxiii

creating EPT chart 141
analysis protocol for autoanalysis 62, 93 ergonomic safety  xxii
GeneMapper Software plate record for errors box 140

autoanalysis 123 .
SeqScape Software plate record 101 European EMC standards xxm
Sequencing Analysis plate record for European safety standards ~ xxiii
autoanalysis 77 event log 142
customer feedback, on Applied Biosystems icon, displays 145
documents x events, box 140

D F

DANGER file extension 160
descrqitlon X1v file naming, invalid characters 54

dat example  xv fill down special, function 38

ata

how to zoom 143 f%ll line, anode buffer reservoir 19
viewing 137 filter set
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fragment analysis 5
find all plate search 40

fragment analysis
data analysis 160
filter set 5
kit types 5
passing profiles, spectral calibration 51
run modules 113
run, average time 133

function 11

G

GeneMapper Software
computer name 107
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generic 107
instrument protocol 108
plate records 108
results group 108

GeneMapper Software tab 157

GeneMapper™ Software and GeneMapper™ ID

Software 106
general hazard symbol  xvi

guidelines
chemical safety xix
chemical waste disposal xx
chemical waste safety xx
waste disposal  xx

H

hard drive space, automatic checking 132
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accompanying safety alert words xiv
components  Xiv
described xiv
in documents  xiv
on instruments  Xiv, Xvi
See also hazard symbols
See also safety symbols
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general xvi
hot surface xvi
in documents xv
laser hazard xvi
moving parts  Xxvi
on instruments  xvi
See also hazard icons
See also safety symbols
hazards
chemical waste xx
electrical shock xxi
laser xxi
moving parts  xxi
moving/lifting instrument  xvii

physical xxi
repetitive motion  xxii

illustration of 12

IMPORTANT
description xiv
example xv

IMPORTANTS!, description ix

Information Development department, contacting x

Install Array Wizard
using 13
installation category  xxi
instrument
condition, status 140
diagram of interior 11
documentation x
EPT status 141
layout 2
operation 130
setup 12
starting the system 8
instrument operational safety, instructions for
instrument protocol
creating 35
creating for SeqScape software 88
creating, for fragment analysis 109, 112
general description 55
icon, displays 145
options, SeqScape software 87
options,s equencing 58
instrument status 139
interconnect tube 12
invalid characters in names 54, 83, 106

italic text, when to use ix

K

KB basecalling run modules 66

L

labels, instrument safety  xvi

laser hazard xxi
symbol  xvi
warnings  xxii
laser safety xxi
laser classification xxi
requirements  xxii

Launching Data Collection software 9
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length of read, definition 3

linking a plate 128
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LOR definition 3 P

lower polymer block 11 pausing arun 133

lower polymer block, illustration of 12 PDP motor cover. illustration of 12

Luer fitting, illustration of 12 physical hazard safety  xxi
physical hazards  xxi
M piston, illustration of 12

manual analysis, fragment analysis documentation 106 plate assembly

manual analysis, Seqscape software documentation 83 diagram 34
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matrix standard plate editor, filling in 37
fragment analysis 30 plate manager, access 37
matrix standards plate record
fragment analysis 114 creating 37
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sequencing 29 autoanalysis 123
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ixed plat 4 55 creating for Sequencing Analysis autoanalysis 77
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modules elements, sequencing analysis 56
fragment analysis 4,5 linking and unlinking 128
KB basecalling 66 mixed 55
sequencing 3 search 40
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mounting pin, illustration of 12 plates
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moving parts changing to new type 15
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referring to  xix, xx
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oven
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Replenish Polymer Wizard

using 15
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filling 17
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fragment analysis 4
results column, reextraction 151

Results Group
creating for sequencing analysis 70
creating, fragment analysis 115
creating, SeqScape software 98
editor, GeneMapper 107
general description 55
importing and exporting 100
options 57
options, SeqScape software 165
run
fragment analysis 133
requires plate record 55, 84, 108
sensor states 140
sequencing, average time 132
starting 130
starting, stopping, skipping, pausing
viewing data 137
run history utility 145

run modules
automated steps, description 132
selecting for fragment analysis 113
selecting spectral 36

run schedule, viewing 129

run scheduler

spatial 22
verifying schedule 129
run time

fragment analysis 4
spectral calibration 41

running buffer, making and storing 16

S

safety

before operating the instrument xvii

chemical xviii
chemical waste xx

conventions  Xiv
electrical xxi
ergonomic  xxii
instrument  xvii
instrument operation  xviii
laser xxi
moving and lifting instrument  xvii
moving parts  xxi
physical hazard xxi
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workstation  xxii
safety alert words
accompanying hazard icons xiv
CAUTIONS  xiv
DANGERS xiv
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IMPORTANTS xiv
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Canadian  xxiii
European xxiii
U.S. xxiii
safety symbols
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type 160
samples
autoanalyzing 155
loading 32
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SeqScape software tab 159

SeqScape Software v2.5
autoanalysis 82
plate editor 84
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user guide P/N 82
sequencing
automated, creating protocols 59
automation, required files 55
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plate editor 55
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spectral run modules 36
viewing analyzed data 160
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supported kits 28
service console, using 9
set (activate) spectral calibration 47
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software, starting 9
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viewer 145
when required 22
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performing a 37
preparing standards for 31
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starting
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stopping arun 133
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hazard xvi
hot surface xvi
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summary 3
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training, information on  xi
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unlinking a plate 129
Update Cap Array Info
using 13
US safety standards  xxiii
user attention words, described  ix
utility, run history 145

\'

viewer
cap/array 144
capillaries 143
icons and display information 145
spectral 145

W

WARNING, description xiv
waste disposal, guidelines xx
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illustration of 12

wizard
Replenish Polymer Wizard, using 15
Update Cap Array Info, using 13

workstation safety  xxii
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